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Preface 
This User’s Guide is intended to provide detailed information on the functionality of the model 
and acts as an extension and elaboration of the on-line help. The section on References provides 
an extensive listing of documents that may be of further assistance to the user in the use of 
EDMS and the preparation of an Environmental Impact Statement (EIS).  

This user manual provides instructions for installing and using EDMS version 5.1.1. The manual 
describes how to enter data, how to obtain various forms of output, and includes an example that 
exercises many commonly-used features of the software. The chapters are organized in the 
following manner: 

• Chapter 1 provides a brief history of the evolution of EDMS, instructions for installing 
the software, a note to users of EDMS from outside of the United States, a high level 
overview of the model architecture, and a summary of the features and limitations of 
EDMS. 

• Chapter 2 gives a summary of the types of data accepted by EDMS for generating an 
emissions inventory. 

• Chapter 3 gives information about weather data and the airport layout.. 

• Chapter 4 is similar to chapter 2 and provides a description of the data used to estimate 
concentrations. 

• Chapter 5 describes the functionality offered by the EDMS utilities, including: 
operational profiles, user-created aircraft, ground support equipment and auxiliary power 
units. 

• Chapter 6 in contrast to the previous chapters gives specific step-by-step instructions for 
interacting with each of the EDMS screens. It is anticipated that most users will read 
chapters 2 through 5 to familiarize themselves with EDMS and then will use chapter 6 as 
a reference when working with the model. 

• Appendix A contains an example study to allow new users to learn the basics of 
performing an emissions and dispersion analysis with EDMS. The example uses 
fictitious data and should not be the basis for any regulatory action. 

• Appendix B describes that import and export formats used by EDMS 5. Advanced users 
can use the import and export utility to bypass most of the EDMS user interface. 

• Appendix C provides photographs of the GSE Reference Models used in EDMS 5 to 
allow for a more accurate selection of GSE for a study. 

• Appendix D provides a matrix of speciated organic gases (OG) by source type. 

As a companion to this user manual, the EDMS Technical Manual provides detailed descriptions 
of the algorithms and data used by EDMS 5. In addition, the answers to Frequently Asked 
Questions and contact information for receiving additional support are posted to the EDMS web 
site. A link to the EDMS web site can be found at 
www.faa.gov/about/office_org/headquarters_offices/aep/models/. 
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1 BACKGROUND INFORMATION  

1.1 History 
EDMS is a combined emissions and dispersion model for assessing air quality at civilian airports 
and military air bases. The model was developed by the Federal Aviation Administration (FAA) 
in cooperation with the United States Air Force (USAF). The model is used to produce an 
inventory of emissions generated by sources on and around the airport or air base, and to 
calculate pollutant concentrations in these environments. A timeline of development history of 
EDMS is given in Figure 1-1. 

Figure 1-1: EDMS History. 

 

In the early 1970s, the FAA and the USAF recognized the need to analyze and document air 
quality conditions at and around airports and air bases. Each agency independently developed 
computer programs to address this need. The USAF developed the Air Quality Assessment 
Model and the FAA developed the Airport Vicinity Air Pollution Model (AVAP). These models 
were used to perform limited air quality assessments in the late 1970s. Recognizing the 
inefficiency of maintaining two non-EPA approved models, the agencies agreed to cooperate in 
developing a single system that would have regulatory, operational and economic benefits. The 
result was the EDMS development effort jointly supported by both agencies and leading to a 
model listed among the EPA’s preferred guideline models. 

Emissions modeling in the FAA began with the early Simplex A modeling efforts using the HP-
97 calculator. The Simplex A algorithms included calculations for aircraft takeoff plume 
dispersion. In the 1980s, the model was moved to the Apple II computer and the Simplex A 
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algorithm was expanded to include dispersion calculations for roadways, parking lots, and power 
plant sources. The revised and enhanced Simplex A model became known as the Graphical Input 
Microcomputer Model (GIMM). GIMM was ported to a PC and further enhanced by 
improvements in processing speed and refinement of the emissions inventory calculations. This 
enhanced version of GIMM became known as EDMS. In 1997 EDMS was reengineered for 
Microsoft Windows and included the algorithms from the Environmental Protection Agency 
(EPA) dispersion models PAL2 and CALINE3. With the release of version 3.0 in 1997, EDMS 
became the FAA-preferred model for air quality assessment at the airport and air bases. In 2001 
EDMS 4.0 was released which marked the transition to EPA’s next generation dispersion model 
AERMOD as the main dispersion engine behind EDMS, and the introduction of aircraft 
performance data to allow EDMS to estimate the contribution to concentrations from aircraft up 
to 1,000 feet above the ground. 

In 2004, the FAA re-engineered EDMS once again to take advantage of new data & algorithm 
developments and released the software as EDMS Version 4.2. This version of EDMS allowed 
users to select the version of EPA’s MOBILE model (5a, 5b, or 6.2) to use for on-road vehicle 
emissions estimation. An interface to EPA’s AERMAP terrain processing module was also 
provided for the first time in this release. AERMOD version 02222 was bundled with the EDMS 
software and was the most current version of AERMOD available as of September 30, 2004. 
Incremental releases of EDMS 4.3 in 2005, EDMS 4.4 in 2006, and EDMS 4.5 also in 2006 
provided updates to the system data, and updates of EPA models. In particular, EDMS 4.4 
contained an upgrade of AERMOD and AERMET to version 04300, which was the first version 
of AERMOD promulgated by the EPA. 

Also in 2004, the FAA embarked on development of its next generation of airport analysis tools, 
known as the Aviation Environmental Design Tool (AEDT). The development of this toolset is a 
6-year effort that will result in the ability to model noise and emissions interdependencies. AEDT 
is being developed in phases and leverages the investment made in EDMS and the Integrated 
Noise Model (INM). The first phase of development is complete, which represents a 2 year 
effort, and harmonizes the underlying system data from both of those models as well as the 
aircraft performance calculation methods. 

EDMS 5 has been given a new architecture and includes over 150,000 new lines of code to 
support additional enhancements to its capabilities and the evolution toward AEDT. A study can 
now contain multiple scenarios, multiple airports and span multiple years, with emissions or 
dispersion being run for all at once. The First Order Approximation (FOA) version 3.0 / 3.0a has 
been incorporated for estimating PM emissions from jet aircraft. Aircraft fleet data have been 
harmonized with INM, and a common dynamic flight performance module exists in both tools as 
well, that accounts for aircraft weight and meteorological conditions. EDMS 5 represents the 
state of the art for airport emissions modeling and an important step toward the development of 
AEDT. 

1.2 EDMS Requirements and Installation Procedures 

1.2.1 Hardware Requirements 
The EDMS software runs on a PC with the following minimum hardware requirements: 

• Intel Pentium 4 processor or compatible operating at 1.3 GHz or greater 
• 512 MB RAM (1 GB recommended for dispersion analyses) 
• 2 GB free disk space minimum, 10 GB free disk space recommended 
• CD-ROM drive 
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• Mouse or other pointing device 

1.2.2 Operating System Requirements 

The EDMS software is a 32-bit Windows native application, compatible with the following 
operating systems: 

• Microsoft Windows 2000, XP or Vista 

1.2.3 Installation Procedures 
The EDMS software, data files, and example studies are provided on CD-ROM. To install the 
EDMS software and components: 

• Insert the EDMS CD into your CD-ROM drive. 
• Run the program Setup.exe on the CD. 

The EDMS setup program will then guide you through the installation process. You will have the 
option of installing the EDMS 5 software files complete with bitmaps, sounds and fonts or 
installing the software files only. A complete installation (software, bitmaps, sounds and fonts) 
requires about 700 megabytes of hard drive space. The typical installation (software alone) 
requires about 60 megabytes of hard drive space. When the installation setup is complete, an 
EDMS folder will be created with icons to launch the model, the on-line help and the un-installer 
program for removing EDMS from the system. 

1.2.4 A Note for EDMS Users Outside of the United States of America 
In order to run dispersion, surface weather data is required in one of the following formats: 

• TD-3280 
• TD-3505 
• CD-144 
• HUSWO 
• SCRAM 
• SAMSON 

Surface weather data must be converted to one of those formats to be used in EDMS. 

In addition, an early morning upper-air sounding is required in either TD-6201 or FSL format. 
Typically, these soundings occur at 00:00 GMT and 12:00 GMT, which does not provide a 
sounding at the necessary time for much of the globe. If an appropriate sounding is not available 
for your location, the Lakes Environmental Upper Air Estimator (available from 
www.weblakes.com) may be appropriate. Specific guidance regarding the AERMET data 
requirements are provided in the AERMET User’s Guide, available from 
www.epa.gov/scram001/7thconf/aermod/aermetugb.pdf. 

1.3 System Architecture 

1.3.1 Components and Modules 
In offering functionality for performing both an emissions inventory and dispersion modeling, 
EDMS consists of several layers of interaction as depicted in Figure 2-1. This figure is a high 
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level representation of the interaction between different components within the framework of a 
single integrated environment. 

The back-end for both the emissions inventory and dispersion modeling is the database 
comprising tables for system data and user-created sources. The front-end is the graphical user 
interface (GUI). The user interacts with the model and the database through the GUI. At the GUI 
level, the user performs data entry (with parameter validation), executes commands, and receives 
visual feedback of both data entered and results generated. The middle portion between the GUI 
and the data tables is the core of the EDMS application, and contains the set of classes and 
functions that represent each emissions source and dispersion object and its associated 
properties. This middle layer allows for study and system data to be retrieved from disc and 
stored in memory while the study is open to enable the user to make changes without those 
changes immediately altering the original study on disc. 

This architecture is typical of current-day multi-tiered applications and allows for modularity of 
components by separating the database-related functions from the core business logic from the 
graphical user interface. Providing modularity will prove to be an important benefit as EDMS 
continues its transition into the AEDT environment in the future. 

External interfaces to EDMS are shown with a dashed border in Figure 1-2. These programs 
include: AERMAP (v.06341), AERMET (v.06341), AERMOD (v.07026), and MOBILE (v.6.2), 
all of which are maintained by the EPA. For all of these programs, inputs are collected through 
the GUI, passed to the business layer, and sent to the external program for processing. Once the 
run is complete, the results and associated messages are interpreted by EDMS and displayed to 
the user. 
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Figure 1-2: EDMS System Architecture. 
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In addition, EDMS contains an Aircraft Performance Module and Aircraft Emissions Module 
that are common to components in AEDT. 

The emissions processor uses a combination of EPA models and best available models from 
other sources such as CAEP for calculating aircraft emissions, on-road and off-road vehicles 
emissions, and stationary source emissions. On-road vehicle emissions are calculated by the 
version of EPA’s MOBILE model selected. The dispersion-modeling module generates input for 
the EPA-developed dispersion model, AERMOD. EDMS offers the flexibility of allowing the 
user to perform an emissions inventory only or in additional also perform dispersion modeling. 

The view modules permit the user to view output, receptor concentrations and system data stored 
in the database. They also allow the user to view a graphical representation of the various sources 
in the database. EDMS contains a reporting component for generating emissions inventory 
results formatted for the printer. Dispersion results and reports are generated by AERMOD. 

In addition, the model incorporates utilities for importing and exporting some types of data, and 
allows the user to add customized aircraft types and ground support equipment to the system 
database. A detailed description of the algorithms and data used by EDMS can be found in the 
EDMS Technical Manual. 
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1.3.2 EDMS Modeling Options 
EDMS performs two primary functions: generating emissions inventories and performing 
dispersion analyses. Performing a dispersion analysis requires first generating the emissions 
inventory for the same set of user inputs. 

1.3.2.1 Enabling Dispersion 
The first option is whether to enable dispersion. Enabling dispersion forces the selection of 
several other options in order to provide greater precision and greatly increases the amount of 
time needed to generate the emissions inventory, and thus should not be selected unless needed. 

1.3.2.2 Enabling Speciated Organic Gas (OG) Emissions 
The second option is whether to Enable Speciated Organic Gas (OG) Emissions. Enabling 
speciated organic gas emissions causes EDMS to calculate speciated organic gas emissions for 
all sources except aircraft main engine startup. This option calculates an emission inventory only, 
and thus speciated organic gas emissions cannot be dispersed at this time with EDMS. 

1.3.2.3 Aircraft Times in Mode Basis 
“Times in mode” refers to the amount of time an aircraft spends in different portions of a 
landing-takeoff cycle (LTO). In EDMS an LTO cycle is divided into six phases: approach, taxi 
in, startup, taxi out, takeoff and climb out. The airborne modes consist of the following portions 
of the LTO cycle: approach, takeoff and climb out. The landing roll portion of the approach 
segment is incorporated into the taxi in time. There are two options for determining the times in 
mode for the aircraft being modeled: Performance Based and ICAO/USEPA Default. 
Performance based modeling uses the specific airframe and engine characteristics along with 
weather data to model each flight dynamically. ICAO/USEPA defaults are standardized values 
read from a table. 

Performance based modeling is required when dispersion is enabled. 

1.3.2.4 Aircraft Taxi Time Modeling 
The two options for determining taxi times are User-specified taxi times for each aircraft and 
Delay and Sequence Modeling. For user-specified taxi times, the user can define defaults for taxi 
in and taxi out times that apply to each aircraft added to the study. These taxi times can then be 
changed for each aircraft if necessary. Delay and Sequence modeling takes into account the 
aircraft operational schedule demands, active runway configurations, and delays associated with 
airport capacity to model the ground movement of the aircraft and determine specific taxi times 
for each aircraft operation. 

Sequence modeling is required when dispersion is enabled. 

1.3.2.5 Aircraft Schedule Options 
If the user has a schedule file, which contains the scheduled pushback and landing times for 
every aircraft, it can be used by EDMS as the basis for sequence modeling, and also to determine 
the number of operations for each aircraft type. If no schedule file is available, EDMS can 
generate a “pseudo-schedule” from the annual operations and operational profiles, and use that as 
the basis for sequence modeling when that is selected. 
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1.3.2.6 Weather 
The options for weather are Use Annual Averages and Use Hourly Meteorological Data. 
Regardless of that choice, the user can also set the mixing height to anything from 1,000 to 
10,000 feet. The mixing height provides a vertical cutoff for EDMS’s modeling of aircraft 
emissions. Hourly meteorological data must be processed through AERMET. 

Hourly weather data is required for dispersion. 

1.3.3 Structure of an EDMS Study 
There are three independent aspects of an EDMS study: the scenarios, the airports and the years. 
Each study must have at least one scenario, one airport and one year defined. These are arranged 
in a hierarchical manner to facilitate the design, programming and maintenance of EDMS. 
Within the study the scenarios are given the highest rank, followed by the airports and finally the 
years. 

As shown in Figure 1-3, in the upper-left pane of the study window is a tree showing the 
structure of the study. By clicking on a name or the preceding icon, the user can select what is 
currently active: the whole study, a particular scenario, a scenario-airport combination, or a 
scenario-airport-year combination. Selecting a lower-level item implicitly means that the higher-
level items to which it pertains are also selected. For example, selecting a particular year would 
give access to the items associated to the airport, scenario and study above it in the tree, as well 
as all application level functionality. Right-clicking on a name will bring up a menu with some 
options germane to that item. 
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Figure 1-3: Main Window, Study Tree. 

  

1.3.3.1 Application Level 
User-created Aircraft, User-created GSE and User-created APUs are defined at the application 
level, that is, they can be created without having a study open, and once defined they are 
available to any study created under that installation of EDMS. This essentially permits the user 
to add custom extensions to the corresponding system tables. 

1.3.3.2 Study Level 
When the whole study is selected, then the user has access to features and data that apply to the 
whole study. Accessible features include the options under the File menu, Update Emissions 
Inventory under the Emissions menu, Run AERMOD under the Dispersion menu, all options 
under the View menu except the Airport option, all options under the Utilities menu except 
Operational Profiles, the Window menu and Help menu. Update Emissions Inventory and Run 
AERMOD are run for all scenarios-airport-year combinations where the data have changed since 
they were last run. Study properties are stored at this level. 

1.3.3.3 Scenario Level 
This level consists mainly of settings for modeling options such as the choices for the times in 
mode and taxi times. Users can create several scenarios, representing different modeling options 
for comparison. 

There is no data at this level except the scenario properties, which were already accessible via 
the Study Properties � Scenarios � Scenario Properties dialog chain at the study level, and 
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hence the available options are the same as on the Study Level. The right-click menu for the 
scenario name in the study tree provides another path to the same functionality. The scenario and 
airport are largely independent of each other within the study and only when both are selected 
does more functionality become available. 

1.3.3.4 Airport Level 
Only information entered on the Airport Properties dialog is tied to the particular airport, and 
applies across all scenarios for that airport in the study. All other data at this level are associated 
with the scenario and airport combination. The items that can be defined at this level include 
weather, gates, taxiways, runways, taxipaths, runway configurations, and the emissions sources 
that are included. The operational information for each source is not associated with this level, 
since it can change from year to year. All airport layout definitions such as runways apply to only 
the specific scenario and airport combination. To model variations in airport layout, the user can 
create multiple scenarios with one airport, or have multiple instances of the same airport under a 
single scenario, with a separate layout for each scenario-airport combination. 

At the airport level more menu options are available; however there are instances where some 
portion of a dialog is disabled, because the information is specific to a particular year, primarily 
operational usage data. The menu items accessible at this level include the Airport menu, the 
Airport option under the View menu, and the Operational Profiles option of the Utilities menu. 

1.3.3.5 Year Level 
This level is the lowest and most detailed level, and contains information that varies for each 
year. Operational usage data (such as number of operations and the duration of each operation) 
for emissions sources is associated with this level, so it can only be entered when a particular 
year is selected. At the year level there are no restrictions on menus or dialog due to the selected 
level. 

1.3.4 Working with an EDMS Study 
When setting up a study, it is usual for the user to first choose the study properties, and then 
define the airports to be used followed by the scenarios. However, if comparing different, but 
similar, airport layouts, say for instance because of a contemplated runway addition or extension, 
the user could first define all the airport features in the baseline scenario, and then use the 
duplicate scenario option (available by right-clicking the scenario name in the study tree), which 
will copy all of the already defined airport features, emissions sources and scenario options into a 
new scenario. 

Study properties such as Unit System apply to the whole study. For example, selecting Metric 
units will cause all fields on all dialogs and views to display and/or accept metric units. 

Under the scenario properties, System Aircraft Times in Mode Basis and Taxi Time Modeling 
Options alter the method used to compute those parameters within that scenario. 

The selection of certain options within the study can also affect the availability of options in 
other parts of EDMS. The most significant of these restrictions are the enabling of dispersion and 
the selection of sequence modeling vs. using default taxi times, which are discussed below. 
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1.3.4.1 Dispersion Related Restrictions 
Dispersion is enabled or disabled by checking or unchecking, respectively, the Enable 
Dispersion Modeling checkbox on the Study Properties dialog. 

In order to perform dispersion modeling, EDMS has to know both when and where any 
emissions took place. This requires that performance-based aircraft modeling (for airborne 
movement) and sequence modeling (for taxiing) be used. So if dispersion is enabled, then on the 
Scenario Properties dialog, under System Aircraft Times in Mode Basis, Performance Based will 
be required while the ICAO/USEPA Default Times in Mode will be disabled, and under Taxi 
Time Modeling Options, Sequence Modeling will be required, while the User-specified taxi times 
for each aircraft option will be disabled. Consequently, requirements related to sequence 
modeling (described in the next section) will always be in effect when dispersion is enabled. 

Buildings are not considered to have emissions, but can affect airflow for dispersion. So the 
Buildings option under the Airport menu is disabled when dispersion is not enabled. The 
Dispersion menu and the Concentrations option under the View menu are also available only 
when dispersion is enabled. 

Dispersion also requires the use of hourly meteorological data. The Weather wizard, activated 
under the Airport menu, has options of Use Annual Averages and Use Hourly Meteorological 
Data. Use Annual Averages is disabled when dispersion is enabled. 

1.3.4.2 Sequence Modeling Requirements 
Sequence modeling is one of the Taxi Time Modeling Options on the Scenario Properties dialog, 
and is required for dispersion, but can also be used for emissions inventories if a detailed 
modeling of taxi emissions is desired. To use sequence modeling, the user must define the gates, 
taxiways, runways, taxipaths, and runway configurations for the airport. Default taxi times are 
not used with sequence modeling and that menu item is not available under the Airport menu. 

If instead, User-specified taxi times for each aircraft has been selected, the airport features are 
not needed and the associated menu items under the Airport menu will be grayed out, but Default 
Taxi Times will be enabled. 

1.3.5 EDMS Screen Layout 
As shown in Figure 1-3, the main study window is divided into four panes. 

1. The upper-left pane holds an interactive tree which depicts the study structure of scenarios, 
airports and years (described above) of the currently open study. Selecting a node in this tree 
updates the other three panes. The selected node also determines which dataset the dialog 
screens are currently editing. Right-clicking a node provides pertinent menu options. 

2. The lower-left pane displays which scenario, airport and year are currently selected. These 
correspond to the node currently selected in the upper-left pane. 

3. The upper-right pane lists the contents of the tree node selected in the upper-left pane. 
Double-clicking on a scenario, airport or year updates the currently selected node in the 
upper-left pane. 

4. The lower-right pane lists the properties of the tree node selected in the upper-left pane. The 
information shown cannot be edited directly in the pane as it is displayed for user-reference 
only. 
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1.3.6 Functional Flow - Emissions 
Overall, the fundamental usage of EDMS is to first perform an emissions inventory, after which 
the user can chose to continue to model the dispersion of the emitted pollutants calculated. As 
shown in Figure 1-4, to perform an emissions inventory the user would follow the following 
steps: 

1. Set up the study by adding scenarios and airports, and choose which modeling options to 
use. 

2. Define all emissions sources, including operational usage. 

3. Define the airport layout if sequence modeling was selected. 

4. Select a weather option: annual average or hourly (requires running AERMET). 

5. Select Update Emissions Inventory. 

Figure 1-4: EDMS Functional Flow 
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The simplest way to generate an emissions inventory and obtain a course estimate of the total 
annual emissions is to perform the first two steps, and use the ICAO/EPA default times in mode 
along with the default operational profiles, and the annual average weather from the EDMS 
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airports database. Doing so would only consider the total number of operations for the entire year 
without regard to when those operations occurred. 

If a more precise modeling of the aircraft taxi times using the Sequencing module is desired 
(required if dispersion will be performed), then the user must define the airport gates, taxiways, 
runways, taxipaths (how the taxiways and runways are used) and configurations (weather-
dependent runway usage). The resulting emissions values can be viewed by selecting Emissions 
Inventory on the View menu. These results can be printed by selecting Print under the File menu 
while viewing the emissions inventory. 

1.3.7 Functional Flow - Dispersion 
To run a dispersion analysis, the user must first generate an emissions inventory while dispersion 
is enabled. Because of this, the methodology used for generating the emissions inventory is also 
the same one used to calculate the emissions for dispersion purposes. This inventory will take 
many times longer than the same one without dispersion enabled, because EDMS must generate 
(.HRE) files which contain all of the emissions broken into hourly bins by source and the (.SRC) 
files that define all the sources. Also, enabling dispersion forces the selection of Performance 
Based times in mode, Sequence Modeling and hourly meteorological data. 

In addition, to run dispersion the user must define receptors, which are points at which the 
concentration of pollutants will be computed. 

Next, the user can optionally run AERMAP, which will adjust the elevations of all emissions 
sources and receptors to the terrain data supplied. This will override any user-defined elevations 
that had been entered. 

Next, the user must specify the AERMOD run options and generate the AERMOD input (.INP) 
files. 

And finally, the user runs AERMOD within the EDMS GUI to generate the concentrations at the 
receptors. 

The resulting concentrations can be viewed by selecting Concentrations under the View menu. 
These results can be printed by selecting Print under the File menu while viewing the 
concentrations. 

1.3.8 Features and Limitations  
EDMS incorporates both EPA-approved emissions inventory methodologies and dispersion 
models to ensure that analyses performed with the application conform to EPA guidelines. Since 
EDMS is primarily used in the process of complying with EPA air quality requirements (e.g. 
through an environmental impact statement) it is imperative that the application uses the most 
current data available. For this reason, it is the FAA’s intention for the database to contain a 
comprehensive list of aircraft engines, ground support equipment, aerospace ground equipment, 
auxiliary power units, vehicular, and stationary source emission factor data. However, there may 
be cases where the database does not contain a specific data element (e.g. a newly available 
emission factor). In these cases, EDMS tries to make allowances for the user to enter their own 
data and will perform parameter validation where possible. The pollutants currently included in 
the emissions inventory are CO2, CO, THC, NMHC, VOC, TOG, NOx, SOx, PM-2.5, PM-10, 
and 394 speciated organic gases. CO2 is calculated only for aircraft, and THC is calculated only 
for aircraft and APUs. Aircraft PM emissions are only available for aircraft with ICAO certified 
engines. From the 394 speciated organic gases, 45 of them are considered to be Hazardous Air 
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Pollutants (HAPs), while the other 349 are non-toxic compounds. Please refer to Appendix D for 
a more detailed list of the speciated organic gases by source. 

EDMS performs dispersion analysis by generating input to EPA’s AERMOD dispersion model, 
and provides an interface to the complex terrain module of AERMOD. To use this function, the 
user can run AERMAP (the AERMOD terrain pre-processor) as a part of EDMS. The pollutants 
currently included in EDMS for dispersion analysis are CO, THC, NMHC, VOC, TOG, NOx, 
SOx, PM-2.5 and PM-10. Concentrations of the included pollutants are generated for comparison 
with all the Primary NAAQS and most of the Secondary NAAQS. 

 

 

 



 

 2-1

2 EMISSIONS CALCULATIONS 
An emissions inventory is a summary of the total annual emissions of the modeled pollutants for 
the sources defined in a study. Depending on the purpose of the study, the emissions inventory 
may be an end in itself or an intermediate step towards performing a dispersion analysis. 

2.1 Emission Inventory Pollutants 
EDMS calculates emissions of the following pollutants: 

1. CO2 (carbon dioxide) for aircraft only, 
2. CO (carbon monoxide), 
3. THC  (total hydrocarbons) for aircraft and APUs only, 
4. NMHC  (non-methane hydrocarbons), 
5. VOC (volatile organic compounds), 
6. TOG (total organic compounds), 
7. NOx (nitrogen oxides), 
8. SOx (sulfur oxides), 
9. PM-10 (particulate matter, 10 microns) 
10. PM-2.5 (particulate matter, 2.5 microns), and  
11. 394 Speciated Organic Gases 

a. 45 Hazardous Air Pollutants (HAPs) 
b. 349 non-toxic compounds 

 
Note: Aircraft PM emissions are only estimated for aircraft with ICAO certified engines using 
the FOA3/FOA3a methodology. 

2.1.1 OG Speciation Profiles 
Speciation profiles (in the form of mass fractions of TOG) are used to estimate quantities of 
individual OGs based on estimates of the amount of mass OG. With respect to gas-phase OG, 
speciation profiles provide estimates of the quantity of an individual OG based on mass 
emissions of total HC (THC), non-methane HC (NMHC), total organic gases (TOG), and volatile 
organic compounds (VOC). Each of these “groups” of OG are discussed briefly below: 

• THC – Organic compounds that comprise the OG species in exhaust, as measured by a flame 
ionization detector (FID) per the International Civil Aviation Organization’s (ICAO’s) 
Annex 16.1 Notably, a FID does not measure all of the mass of oxygenated OGs. THC 
emissions are presented in terms of methane equivalency. 

• NMHC - The most common OG is methane, a greenhouse gas that is sometimes excluded 
from the analysis of other VOCs. NMHC emissions are presented in terms of its own mass 
(NMHC as NMHC). 

• TOG – As defined by CARB, TOGs are compounds of carbon, excluding carbon monoxide, 
carbon dioxide, carbonic acid, metallic carbides or carbonates, and ammonium carbonate. 
TOG includes all organic gas compounds emitted to the atmosphere, including the low 

                                                      
1 ICAO’s Annex 16 addresses protection of the environment from the effect of aircraft noise and aircraft 
engine emissions. 
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reactivity compounds (e.g., methane, ethane, various chlorinated fluorocarbons, acetone, 
perchloroethylene, volatile methyl siloxanes, and oxygenated OGs). TOG emissions are 
presented in terms of its own mass (TOG as TOG). 

• VOC – Defined as any compound of carbon that participates in atmospheric photochemical 
reactions, which is exhaust TOG corrected to exclude the mass of methane, ethane, and 
acetone and to fully account for the mass of formaldehyde and acetaldehyde [U.S. EPA 
2007].2 VOC also excludes carbon monoxide, carbon dioxide, carbonic acid, metallic 
carbides or carbonates, and ammonium carbonate. VOC emissions are presented in terms of 
its own mass (VOC as VOC).  

2.1.2 Speciated Organic Gases 
EDMS calculates emissions for 394 speciated organic gases. From the 394 speciated organic 
gases (OG), 45 are considered to be Hazardous Air Pollutants (HAPs) while the other 349 are 
non-toxic compounds. 

2.1.2.1 Background Information 
In 2003, the FAA Office of Environment and Energy (AEE) undertook an assessment of what 
was already known about speciated OG at airports, in general, and aircraft-related speciated OG. 

This initial body of work (referred to as the FAA Resource Document for HAPs) focused on 
HAPs and was prepared in response to the rising interest by various federal, state and local 
governmental agencies and the general public in connection with the emerging topic of these 
pollutants. The need for a more unified approach and technical guidelines for evaluating 
speciated OG emissions for airport-related sources was among the FAA’s recommendations from 
this effort.  

2.1.2.2 Additional FAA Guidelines and Other Resources 
Documents, guidelines and resources developed by the FAA also give further support to the 
assessment of airport air quality issues and may be applicable to evaluations of airport-related 
speciated gas-phase OG. These documents include the FAA’s Airport Environmental Handbook, 
Air Quality Procedures for Civilian Airports and Air Force Bases (and it’s Addendum). 
Abstracts of these materials are provided below. 

� FAA Resource Document for HAPs [FAA, 2003]. This document provides a compilation of 
what was known about airport- and aircraft-related HAPs from the public materials that were 
available in the year 20031. Presented both as a narrative summary and assembled in an 
annotated bibliography, these materials cover a broad range of information related to this 
subject. Topics include HAP emission types and sources, agency regulations, air monitoring 
data and other supporting information.  
 

� NEPA Implementing Instructions for Airport Actions (FAA Order 5050.4B) and 
Environmental Impacts: Policies and Procedures (FAA Order 1050.1E, Change 1) [FAA, 
2006]. These two documents provide guidelines for the preparation of Environmental 
Assessments (EA), Environmental Impact Statements (EIS) and other similar reviews for 
airport projects or actions required under NEPA. Under the topic of air quality, these 

                                                      
2 Per the EPA definition of VOC at http://www.epa.gov/ttn/naaqs/ozone/ozonetech/def_voc.htm  
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guidelines address the criteria air pollutants and the federal CAA General Conformity Rule. 
The topic of HAPs is briefly addressed in Order 1050.1E and 5050.4B). 

 

• Air Quality Procedures for Civilian Airports and Air Force Bases and its Addendum [FAA, 
1997 and 2004]. Referred to as the “Air Quality Handbook”, this document provides 
guidance on conducting air quality impact assessments for airport projects and actions 
required under NEPA and the federal CAA. Contains comprehensive and detailed 
methodologies on preparing emission inventories and conducting dispersion modeling of 
airport-related criteria pollutants. Although HAPs are not specifically addressed, the 
technical guidance and procedures provided are applicable to the assessment of OG and PM: 
the two primary classes of HAPs.  
 

• Aircraft and Airport-Related Hazardous Air Pollutants: Research Needs and Analysis, 
[Transportation Research Board, 2008]. Provides guidance on the most important projects to 
the airport community for ACRP consideration in the area of HAPs. This report examines the 
state of the latest research on aviation related HAP emissions and identified knowledge gaps 
that existing research has not yet bridged. 

 

• Recommended Best Practice For Quantifying Speciated Organic Gas Emissions from 
Aircraft Equipped with Turbofan, Turbojet, and Turboprop Engines, [FAA and EPA, May, 
2009]. This Recommended Best Practice was produced through an inter-agency partnership 
and provides an approach to, and technical support for, the quantification of organic gases 
from this source. 

 

• Guidance For Quantifying Speciated Organic Gas Emissions From Airport Sources, [FAA, 
September, 2009]. This document provides an approach to, and technical guidance for, 
preparing speciated OG/HAP emission inventories in support of environmental documents 
prepared by, or on behalf of, the FAA under the National Environmental Policy Act (NEPA). 

2.1.2.3 Considerations and Limitations Associated With the Evaluation of Airport-
Related Speciated Organic Gases 
� There are no Federal regulatory guidelines that specifically address any individual OG 

from airports - By definition, neither airports, in general (nor aircraft) are subject to the 
regulations of Section 112 (Hazardous Air Pollutants) of the CAA. Moreover, there are no 
regulatory guidelines on either the federal or state levels that identify when, or under what 
conditions, the evaluation of speciated OG (and in particular HAPs) from these sources is 
required nor do they define the type and extent of the analysis. 

 

� Emission inventory results are estimates and are not directly comparable to regulatory 
standards or other acceptable criteria. – For disclosure and/or comparative purposes, an 
emission inventory provides a useful estimate of the quantity of a specific OG. However, 
by itself, the results of an emission inventory are not comparable to any enforceable 
measures of acceptability. 

2.1.2.4 EPA-Identified HAPs and Toxic Compounds 
Originally, under Section 112 (Hazardous Air Pollutants) of the federal CAA, the EPA classified 
188 air pollutants as HAPs. The EPA later modified the list to identify only 187 HAPs (in 2005, 
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the EPA removed methyl ethyl ketone from the list). The OG species on the EPA’s list include a 
wide variety of compounds for which there are no NAAQS.  

The EPA also maintains a database of information regarding the human health effects that could 
result from exposure to various substances. The Integrated Risk Information System (IRIS) 
contains both descriptive and quantitative information regarding the cancer and non-cancer 
effects of certain compounds.  

A list of the airport-related OG species that EPA identifies as HAPs and/or those included in the 
IRIS database is provided in Appendix D. This list also identifies the airport-related source(s) 
from which each OG species is emitted. 

2.2 Data Input Overview 
The Study Properties window allows the user to specify whether the current study will be used to 
generate only an emissions inventory (Enable Dispersion Modeling not checked), or an 
emissions inventory and a dispersion analysis (Enable Dispersion Modeling checked). If 
dispersion is not enabled, then only the inputs required for conducting an emissions inventory 
will be editable on each of the windows, but more modeling options will be available since there 
are fewer restrictions. On this same window is a function to generate emissions for speciated 
OGs (Enable Speciated Organic Gas (OG) Emissions checked). 

To enter data for a specific type of source (e.g. aircraft, stationary sources, etc.), click on the 
scenario, airport, and year combination on the study tree view and select the appropriate source 
type from the Emissions menu. The menu options are described in more detail in (Chapter 6). 

The parameter values for individual records are displayed by selecting the record in the In Study 
list box. These values may then be modified. Changes made to a record are remembered while 
accessing a different record, but changes are not applied unless the Apply button is pressed. 
Exiting a window without pressing Apply will result in all changes being discarded. Parameter 
validation is built into the interface, so in the event of an invalid entry, a pop-up window will be 
displayed that indicates the range of acceptable values.  

Two similar parameters found in all of the emissions sources windows are Yearly and Peak 
Quarter Hour activity. For most emissions inventory cases, the analyst would obtain annual 
activity numbers. However, if the activity at the peak quarter hour is the only known variable 
then the user would create a set of operational profiles, under the File menu, that accurately 
represent the distribution of this activity over an entire year. Upon entering the value for Peak 
Quarter Hour and choosing the appropriate Quarter Hourly, Daily, and Monthly operational 
profiles, EDMS automatically computes a corresponding Yearly value. The following sections 
describe the emissions inputs required for aircraft activity, ground support equipment (GSE) 
populations, vehicles on roadways, vehicles in parking facilities, stationary sources, and training 
fires. 

2.3 Aircraft Activity 
Aircraft activity is specified by adding records in the Aircraft Operations and Assignments 
window found under the Emissions menu heading. To specify aircraft to be included in the study, 
choose an aircraft type and engine type from the Available Aircraft/Engine tree and Add it to the 
In Study list box. 
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EDMS models aircraft activity with 6 modes of operation corresponding to the following 
portions of a Landing-Takeoff (LTO) cycle. These modes of operation only apply to the aircraft 
main engines; APU emissions are calculated and presented separately. 

1. Approach: The airborne segment of an aircraft’s arrival extending from the start of 
the flight profile (or the mixing height, whichever is lower) to 
touchdown on the runway. 

2. Taxi In: The landing ground roll segment (from touchdown to the runway exit) of 
an arriving aircraft, including reverse thrust, and the taxiing from the 
runway exit to a gate.  

3. Startup: Aircraft main engine startup occurs at the gate. This methodology is only 
applied to aircraft with ICAO certified engines. All other aircraft will 
not have startup emissions. Aircraft main engine startup produces only 
THC, VOC, NMHC, and TOG emissions. A detailed speciated organic 
gases profile does not exist for main engine startup emissions. 

4. Taxi Out: The taxiing from the gate to a runway end. 

5. Takeoff: The portion from the start of the ground roll on the runway, through 
wheels off, and the airborne portion of the ascent up to cutback during 
which the aircraft operates at maximum thrust. 

6. Climb Out: The portion from engine cutback to the end of the flight profile (or the 
mixing height, whichever is lower). 

Each aircraft activity is expressed as either an Arrival, a Departure, an LTO cycle, or a Touch 
and Go (TGO), and each type consists of different modes of operation. An Arrival consists of the 
Approach and Taxi In modes. A Departure consists of the Startup, Taxi Out, Takeoff, and Climb 
out modes. An LTO cycle consists of an Arrival and a Departure, and therefore consists of one of 
each of the six modes of operation. A TGO consists of the Approach mode, followed 
immediately by the Takeoff and Climb out modes. TGO operations are generally performed for 
training purposes, usually occur at military bases or smaller civilian airports, and generally have 
a flight profile that starts and ends at a much lower altitude than a regular LTO cycle. 

EDMS offers two ways of calculating the amount of emissions released in the airborne segments 
and approach ground roll: 

1. Using the International Civil Aviation Organization (ICAO) and Environmental 
Protection Agency (EPA) Times in Mode (TIM) found in a table, or 

2. Using the aircraft performance module, which dynamically models the flight of the 
aircraft, based a flight profile using the methodology presented in the Society of 
Automotive Engineers (SAE) Aerospace Information Report (AIR) 1845. 

The user selects the methodology, in the Scenario Properties window, to be applied to all aircraft 
in the system database. 

NOTE:  The dynamic aircraft performance-based modeling option should always be 
used in airport analyses conducted for FAA approval unless prior authorization 
is obtained from the FAA’s Office of Environment and Energy. 

The ICAO/EPA TIMs are based on broad aircraft categories and provide more generalized times 
spent in each of four modes: Approach, Idle, Takeoff, and Climb Out. The emissions determined 
from these four ICAO modes are allocated to the various EDMS modes of operation as follows: 
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the ICAO Approach, Takeoff, and Climb Out modes are allocated to the EDMS Approach, 
Takeoff, and Climb Out modes of operation, respectively, while the ICAO Idle mode is broken 
down into the EDMS Taxi In and Taxi Out modes of operation. The ICAO TIMs have no flight 
profiles associated with them, and they only determine the amount of time that an aircraft spends 
in each mode, not its position. Because there is no spatial information on the release of emissions 
when using the ICAO TIMs, this modeling option is not allowed when dispersion is enabled. 
Instead, use of the performance-based methodology is required when dispersion is enabled. 

The dynamic aircraft performance module provides more precise and accurate modeling of 
aircraft performance by taking into account the aircraft type, engine, weight, approach angle to 
be flown (for arrivals), elevation and weather (atmospherics). Using hourly meteorological 
weather data, variations in the thrust used (and emissions released) for the same aircraft can be 
observed at different times of the day and at different airports due to the changing weather 
conditions. When user-created aircraft are added to a study, the user can enter aircraft-specific 
times for the takeoff, climb out, approach and landing idle modes or assign a flight profile from a 
similar aircraft in the system table. 

For the EDMS Taxi In and Taxi Out modes of operation, the taxi times can either be user-
specified or generated by the sequencing model. The latter is required when dispersion is 
enabled. 

Mixing heights less than 1,000 feet are not allowed in EDMS. The default approach and climb 
out times in mode of both system aircraft using ICAO/EPA TIMs and user-created aircraft are 
based on a mixing height of 3,000 feet but are adjusted to reflect the user-specified local mixing 
height. When the mixing height in the Weather window is modified, the times-in-mode for all 
aircraft are automatically adjusted. 

Aircraft engines are the actual source of emissions for aircraft. EDMS treats each aircraft as a 
combination of a specific aircraft type and engine type. For each aircraft type there may be 
several different engine types available for use and emission factors may vary from engine to 
engine. Consequently, different aircraft may generate identical emissions because they are 
equipped with identical engines, or older aircraft may be outfitted with technologically newer 
engines and generate fewer emissions. Default engines (displayed in bold) represent an actual 
engine type which is the most common or the most widely used engine type for that particular 
aircraft type in the United States, Europe or worldwide fleet based on recent data extracted from 
the BACK aviation database. More information on the data used to determine the default engines 
is available from www.backaviation.com. 

In each of the modes, the engines operate at correspondingly different power settings. The power 
settings determine the rate at which fuel is burned which, in turn, determines the quantity and 
nature of emissions released into the atmosphere. 

For most engines the emission factor data was obtained from the ICAO Aircraft Engine Exhaust 
Databank, a publicly available database that can be downloaded from www.qinetiq.com. The 
data from QinetiQ is supplemented by engine emissions data provided directly from the 
manufacturer and, for older aircraft, data contained in EPA’s AP-42, Part II, Section 1. 

2.3.1 Aircraft Operations & Schedule 
Operational information for aircraft can be entered in one of two ways: (a) by specifying the 
number of annual operations or peak quarter-hour operations for each aircraft, along with 
operational profiles showing the relative activity by quarter-hour, day-of-the-week and month, or 
(b) by specifying a schedule of operations. In the first method, peak quarter-hour operations are 
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converted into a pseudo-schedule using the selected operational profiles. From that point on, both 
methods are essentially the same.  

2.3.2 Taxi Times and Sequence Modeling 
In the Scenario Properties window, there are two options for determining the amount of time an 
aircraft spends taxiing: User-specified taxi times for each aircraft and Sequence Modeling. With 
user-specified taxi times, the user can define defaults for taxi in and taxi out times that apply to 
each aircraft added to the study. These taxi times can then be changed for each aircraft as 
desired. However, because these user-specified taxi times do not have any information on the 
location at which the taxiing occurs, this modeling option is not allowed when dispersion is 
enabled. Instead, the Sequence modeling option is required in order to provide the spatial taxiing 
information. 

Sequence modeling in affect performs a simulation to dynamically determine the taxi times, and 
is required for dispersion, but can also be used for emissions inventories. To use sequence 
modeling, the user must define the gates, taxiways, runways, taxipaths, and runway 
configurations for the airport. 

The Sequence module determines the active runway configuration that is used at each hour of the 
year based on meteorological information and the user-specified activation parameters in order to 
determine the associated airport capacity at each hour of the year. This airport capacity 
information along with demand information from the aircraft operational profiles or schedule are 
provided to the WWLMINET delay model to determine the airport throughput. EDMS then 
adjusts the estimated gate push-back time (for departures) and estimated touchdown time (for 
arrivals) into actual times that are possibly delayed. 

The Sequencing module models the movement of aircraft along the taxiways (as prescribed by 
the taxipaths) between runways and gates for both arriving and departing aircraft. In addition, 
modeling of taxi queuing is then done for departing flights, but not arriving aircraft, which are 
assumed to have unimpeded taxi in to their gate. The departure aircraft are sequenced in the 
proper order to provide the duration that each aircraft spends on each taxiway segment. The 
aircraft form queues along the taxiways that feed into the corresponding runway-ends. This 
detailed modeling of the usage of individual taxiway segments during taxi in and taxi out 
provides a more realistic modeling of airside operations for both emissions inventory and 
dispersion purposes. 

2.4 Ground Support Equipment (GSE) and Auxiliary Power Units (APUs) 
Emissions are generated by ground support vehicles and auxiliary power units (APUs) while the 
aircraft is parked at the gate. The following sections cover Ground Support Equipment (GSE) 
and auxiliary power units (APUs). GSE can be modeled both by assignment to an aircraft and by 
population. GSE that are assigned to an aircraft will have their operations depend on the activity 
of that aircraft. GSE that are modeled as a population operate independently from aircraft 
activity. Since APUs are onboard aircraft, they are always modeled based on an aircraft’s 
activity. 

GSE emission factors used by EDMS are derived from EPA’s NONROAD2005 model and are 
based on the following variables: fuel, brake horsepower and load factor. In addition, a 
deterioration factor is applied based on the age of the engine. GSE emission factors are given in 
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grams per horsepower-hour. EDMS allows users to select the EPA-derived national fleet average 
age for a particular vehicle type, or to specify the exact age of an individual piece of equipment. 

2.4.1 GSE Assigned to Aircraft 
Upon arrival at a gate, aircraft are met by GSE to unload baggage and service the lavatory and 
cabin. While an aircraft is parked at a gate, mobile generators and air conditioning units may be 
in operation to provide electricity and conditioned air. Prior to aircraft departure, GSE are 
present to load baggage, food and fuel. When an aircraft departs from a gate, a tug may be used 
to push or tow the aircraft away from the gate and to the taxiway. Figure 2-1 depicts aircraft and 
GSE activity at the gate. 

Figure 2-1. Aircraft with GSE. 

 

GSE that are assigned to an aircraft are given times (minutes per arrival, minutes per departure) 
based upon the type of service. For example, a fuel truck servicing a large commercial aircraft 
will have a different operating time than the same fuel truck servicing a commuter aircraft. Tugs 
are generally used to move commercial aircraft away from the gates, but are typically not used by 
general aviation (GA) aircraft. 

As system aircraft are added to the study, default GSE assignments are made for each newly 
added aircraft. Default assumptions are used in EDMS, but the user also has the flexibility to add 
and remove GSE to and from aircraft and modify the operating times as well as other parameters 
for assigned GSE. These default assignments are based upon several categories of aircraft types 
(e.g., wide body jets, cargo planes, commuter aircraft, general aviation, military jets, military 
transports, business jets, etc.). 

If site-specific information is available for GSE (assignments and operational times), it is 
recommended that this data be used in place of the default values. If the aircraft type is removed 
from the study, all the GSE assigned to it will also be removed from the study. To modify the 
assignment and/or the operating times of these sources; select the GSE & Gate Assignment tab on 
the Aircraft Operations & Assignments window. 

GSE emissions generated per LTO cycle (or arrival or departure) are the product of the emission 
factor, horsepower, load factor and operating time. For annual emissions this result is multiplied 
by the number of yearly LTO cycles (or arrivals and departures) for the aircraft to which the 
equipment is assigned. GSE emissions are not calculated for TGO operations. 
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2.4.2 GSE Populations 
For a population of GSE, the annual GSE emissions are the product of the emission factor for the 
given pollutant, horsepower, load factor, annual usage and population. The analyst can either 
select "Use default age distribution", which will cause GSE to be modeled with the national 
average GSE emission factors that were developed by the U.S. EPA using NONROAD2005, or 
can select "Specify a specific age", which will apply the NONROAD2005 emission factors for a 
specific vehicle. In the latter case, the fuel, the horsepower and the year of manufacture 
determine the zero-hour emission factor and the age and GSE type determine the deterioration to 
be applied. 

2.4.3 Auxiliary Power Units (APU) 
Auxiliary power units (APUs) are most often on-board generators that provide electrical power 
to the aircraft while its engines are shut down. Some pilots start the on-board APU while taxiing 
to the gate but, for the most part, it is started when the aircraft reaches the gate. The on-board 
APU is, in effect, a small jet engine and the calculations for the emissions generated by it are 
similar to that of an aircraft engine operating in one power setting only. The methodology for 
calculating emissions from APUs is adapted from the U.S. EPA's Procedures for Emission 
Inventory Preparation, Volume IV, Chapter 5, which can be found at 
www.epa.gov/otaq/invntory.htm. Like GSE, APU emissions generated per LTO cycle are the 
product of the emission factor and operating time, multiplied by the number of applicable aircraft 
LTO cycles. APU emissions for arrivals and departures are computed in a like manner, when 
those are treated separately. For the purpose of emissions calculations, APUs are assigned to the 
same category as GSE. External APUs used by an aircraft fall into the category of ground 
support equipment. In the absence of an APU or applicable GSE, a combination of 400 Hz 
electric power and preconditioned air (PCA) can be supplied to the aircraft using a fixed system 
at each gate to allow for normal operation. Fixed systems usually generate little or no emissions 
at the airport and are not included in EDMS. APU emissions are not calculated for TGO 
operations. 

2.5 On-Road Vehicles 
Motor vehicle activity on roadways is specified in the Roadways window under the Emissions 
menu heading. The Traffic Volume (Yearly or Per Peak Quarter Hour) refers to the number of 
vehicle traversals (one-way trips) on the roadway. The average speed (in mph) of vehicles 
traveling on the roadway (Average Speed) is one of the parameters necessary to determine a 
MOBILE 6.2 emission factor (grams/vehicle-mile) for the movement of the vehicles. The other 
three parameters are Manufactured Year, elevation (Height), and the average daily high and low 
temperatures, which come from the airport’s weather data. Additionally, MOBILE 6.2 allows the 
user to choose between the default fleet mix and one of the 16 vehicle types. Selection of a 
specific vehicle type will cause EDMS to assume that the roadway is used only by vehicles of the 
specified type. 

The Roadway Length field is used exclusively for emissions inventory purposes to determine the 
total amounts of pollutants generated by vehicles traveling the length of the roadway on their 
way to and from the airport. Specify the total distance (in units set on the Study Properties 
window) a vehicle would be expected to travel along the selected roadway. For a dispersion 
analysis, the Roadway Length is computed from the coordinates of the points that define the 
roadway, and is not editable. Access to the roadway emission factors for the active record both 
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for viewing and editing purposes are on the lower right corner of the window. The total 
emissions for a roadway are the product of the emission factors (given in grams per vehicle-
mile), the annual Traffic Volume, and the Roadway Length. 

Important: Unlike EDMS 4.x, EDMS 5 does NOT assume that vehicles travel “round-trip” (i.e. 
does not assume that each vehicle traverses a roadway once in each direction). So to indicate the 
round-trip passage of 100,000 vehicles, a yearly Traffic Volume of 200,000 should be entered. 

Vehicular emission factors contained in EDMS are obtained from the EPA's MOBILE 6.2. To 
accommodate changing and/or varying regulations or the need for a more detailed analysis, the 
user has the option of entering their own vehicular emission factor data. Frequently, the user 
would obtain this emission factor data by running MOBILE with customized input. 

Once the user has provided EDMS with the analysis year, temperature, elevation, vehicle speed 
and class, MOBILE will run using the default settings. The control flag settings used by EDMS 
for MOBILE 6.2 are summarized in (Table 2-1). The EDMS Technical Manual contains 
additional information about how EDMS models on-road vehicle emissions along with 
instructions on viewing the MOBILE input file generated by EDMS and the output received from 
MOBILE in return. Users should run MOBILE outside of EDMS, if they find that these defaults 
are not appropriate for their airport. 

Table 2-1: MOBILE 6.2 Control Flag Settings. 
Control Flag Value(s) 

Gasoline fuel Reid Vapor Pressure (RVP) Adjusted to fit within the 7 to 9 psi range that 
is being used to model the default summer 
months. 

Diesel Sulfur 500 ppm for study years prior to 2006 

46 ppm for study years 2006 through 2009 

11 ppm for study years 2010 and later 

Minimum daily temperature Average ambient temperature from the study setup 
screen – 10.35°F 

Maximum daily temperature Average ambient temperature from the study setup 
screen + 10.35°F 

Calendar year Study year from the study setup screen 

Evaluation month 7 (July) 

Roadway type Arterial 

Altitude “1” if the airport elevation is less than 5,000 feet 
above sea level 

“2” otherwise 

No Refueling  

Air Toxics E200: 50 

E300: 85 

GAS AROMATIC%: 25 

GAS OLEFIN%: 15 
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GAS BENZENE%: 1.5 

OXYGENATE: 

MTBE 0.00 0.0 

ETBE 0.00 0.0  

ETOH 10.0 1.0 

TAME 0.00 0.0 

 

2.6 On-Road Vehicles in Parking Facilities 
Motor vehicle activity in parking facilities is specified in the Parking Facilities window (under 
the Emissions menu heading). The Number of Vehicles (Yearly or Per Peak Quarter Hour) refers 
to the distinct number of individual vehicles using the parking facility. An entry and an exit of 
the parking facility with any idling and vehicle movement together, count as one operation. The 
average speed of vehicles traveling in the parking facility (Speed) is one of the parameters 
necessary to determine the emission factors for the movement of the vehicles using MOBILE 6.2. 
The three remaining parameters are, Manufactured Year, Elevation, and the average daily high 
and low temperatures, which come from the airport’s weather data. MOBILE 6.2 does however 
allow the user to choose between the default fleet mix and one of the 16 vehicle types. Selection 
of a specific vehicle type will cause EDMS to assume that the parking facility is used only by 
vehicles of the specified type.  

Note: In order to define a custom fleet mix of on-road vehicles, users must either run MOBILE 
outside of EDMS and import the resultant emission factors, or make a copy of the parking 
facility or roadway for each of the vehicle types. 

Idle emission factors (grams/vehicle) are computed by extracting emission factors, as above, with 
a vehicle speed of 2.5 mph and multiplying these factors by the Idle Time. The input for the idle 
time is an estimate of the average time a vehicle spends idling between entry and exit. The input 
for Distance Traveled is an estimate for the average distance a vehicle travels between entry and 
exit. This field is used to modify the moving emission factors (grams/vehicle-mile). The moving 
emission factors and the idle emission factors are combined to produce a parking facility 
emission factor (grams/vehicle). 

2.7 Stationary Sources 
The EDMS database contains emission factors for several categories of stationary sources. Each 
broad category is further broken down into several specific types. The ten categories currently 
included are Boiler/Space Heaters, Emergency Generators, Incinerators, Aircraft Engine 
Testing, Fuel Tanks, Surface Coating/Painting, Deicing Area, Solvent Degreasers, Sand/Salt 
Piles and Other.  

Users can specify the category specific (and in some cases type specific) emissions parameter 
values or use the default emissions parameter values. The specific methodologies for computing 
stationary source emission factors are presented in Appendix H of Air Quality Procedures for 
Civilian Airports and Air Force Bases (the Air Quality Handbook). The general methodology for 
calculating emissions from these sources considers the amount of fuel or substance consumed.  
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The Stationary Sources window under the Emissions menu heading is used to specify stationary 
source activity. After the selection of a Category, the first type is automatically selected from 
Type drop down menu and the Emission Parameters list is populated with the appropriate 
parameters, including the emission factors. Typically the user will then select a Type that best 
matches the source that they wish to include in the study. The Category and Type fields are keys 
to retrieve default data from the database.  

Based upon the nature of the fuel, the substance consumed, or throughput, emission factors are 
displayed either as Kg/Metric Ton, Kg/Kiloliter, Kg/Thousand Cubic Meters, Kg/Hour or 
Kg/Test Cycle. Emission factors and parameters may be modified if the user obtains site-specific 
data, but there is no validity checking performed to verify that the modified emission factors are 
actually valid for the selected Category and Type.  

The Yearly and Per Peak Quarter Hour values specify the amount of time, fuel or substance 
consumed or throughput, and these are specified in Metric Tons, Kiloliters, Thousands of Cubic 
Meters, Hours or Test Cycles as appropriate. EDMS gives the user the flexibility to identify 
generic stationary sources. For miscellaneous stationary sources, the user has the option of 
choosing the Other category and entering their own emission factors in their choice of units. For 
such sources, the user is required to provide user-specified emission factors. 

2.8 Training Fires 
Training fire activity is specified by selecting the Training Fires window under the Emissions 
menu heading. Emission factor data for five fuels (JP-4, JP-5, JP-8, Tekflame and Propane) are 
stored in the EDMS database and may be selected from the Fuel drop down list. Training fire 
emission factors are specified in the system table FUEL_EF.dbf in kilograms of pollutant per 
gallon of fuel used; and hence, the training fire activity values are always entered in Gallons of 
Fuel Used. Training fire emission factors may be modified in the lower portion of the window 
under Emission Factors, however there they are displayed in grams of pollutant per gallon of 
fuel. 

The Training Fire dialog shows only five emission factors, rather than eight. The emissions from 
VOC are used for to calculate NMHC, and TOG in the emissions inventory, and the PM10 
emissions are used for both PM-10 and PM-2.5. 

2.9 Emissions Inventory Output 
The following sections describe the components of the emissions inventory, and the outputs 
available to the user. EDMS allows the analyst to view the emissions inventory on the window in 
an interactive manner, to print a formal emissions inventory report, or export the emissions 
inventory to a semicolon delimited text file. EDMS generates an emissions inventory for the 
following pollutants: CO2, CO, THC, NMHC, VOC, TOG, NOx, SOx, PM-2.5, PM-10, and 394 
speciated organic gases. CO2 is calculated only for aircraft, and THC is calculated only for 
aircraft and APUs. Aircraft PM emissions are only available for aircraft with ICAO certified 
engines. From the 394 speciated organic gases 45 of them are considered to be Hazardous Air 
Pollutants (HAPs), while the rest 349 are non-toxic compounds. Please refer to Appendix D for a 
more detailed list of the speciated organic gases by source. The total fuel consumption is also 
calculated and displayed for the Aircraft by Mode and Aircraft Summary. 
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2.9.1 Emissions Inventory 
An emissions inventory is a summary of the total pollutants generated by all active sources in the 
study. Using EDMS to perform an emissions inventory requires the user to identify the emission 
sources, the annual activity for each of these sources and, in the case of user-defined sources, the 
emission factors. EDMS then calculates the total annual pollutant emissions for each of the 
identified sources and presents it in both a summarized report and a detailed report.  

Important: To view speciated organic gases in the emissions inventory, the Enable Speciated 
Organic Gas (OG) Emissions checkbox in the Study Properties dialog must be checked. 

2.9.2 View Emissions Inventory 
The View Emissions Inventory window is displayed by selecting the appropriate option under the 
View menu heading. The initial display is the Summary, which shows total pollutant emissions by 
source category in tons, short tons, lbs, or kilograms per year as specified in the Study Setup. The 
units can be changed by selecting the desired unit from the Units drop down box. In addition, the 
analyst can view emissions for specific scenario, airport, and years by selecting the desired 
scenario-airport combination and the desired year from the Scenario-airport and Year drop-down 
boxes. 

The source categories are: Aircraft (broken down by mode of operation), APU, GSE, Stationary 
Sources (including Training Fires), Vehicular sources (both Roadways and Parking Facilities), 
and the total of all categories. The analyst may also view total pollutant emissions by each source 
type by clicking on the appropriate buttons at the top of the view window.  

The Aircraft by Mode display lists the total pollutants by the contributions of aircraft type in each 
mode of operation. The possible modes are Approach, Taxi In, Startup, Taxi Out, Take Off and 
Climb Out. APU and Assigned GSE emissions may be viewed by pressing the Aircraft/APU 
button. The aircraft’s Total emissions are the sum of all six modes due to the aircraft's activity. 
The Assigned GSE and APU totals are displayed separately. The GSE Population display shows 
the emissions for each item in the GSE population. The Vehicular Sources display lists the total 
emissions for each roadway and parking facility included in the study while the Stationary 
Sources display lists the total emissions for each stationary source or training fire specified in the 
study.  

2.9.3 Export Emissions Inventory 
To export the emissions inventory click the Export button in the Emissions Inventory window. 
EDMS will export the Scenario-Airport emissions inventory for the displayed source category, 
year and units selected, into a semicolon delimited text file. This process can be repeated to 
export the emissions for all source categories. 

2.9.4 Print Emissions Report(s) 
To print official reports of the emissions inventory choose Print from the File menu while the 
emissions view is selected. Aside from a difference in formatting, EDMS titles, and study 
information, the contents of the emissions inventory reports are exactly the same as described in 
View Emissions Inventory. Note: Due to the number of pollutants, this command will not print 
out the speciated OG’s in an EDMS report, it only prints out the 10 main pollutants. To print the 
OGs the file should be exported and formatted to print outside of EDMS. 
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3 AIRPORT LAYOUT 
The Airport Layout defines the physical “fixed” infrastructure components of the airport around 
and through which the airport sources operate. The airside network components include the 
runways, gates, and taxiways, and are optional for performing an emissions inventory, but are 
recommended if a precise calculation of inventory is desired, and are required for dispersion. 
Buildings have no affect on emissions, but affect the dispersion of point sources. 

In EDMS, users also have the ability to graphically view the layout of the airport, and interact 
directly with the graphical airport view to place, move, and modify various sources. 

3.1 Weather Data 
The meteorological data settings can be found under the Weather option under the Airport main 
menu, and is specific to each scenario-airport combination. There are two settings available: 1) 
annual average weather values, and 2) hourly weather values. If dispersion is not enabled, then 
the user has the option of using either the annual averages or supplying his/her own hourly 
weather files for the emissions inventory. Hourly weather data supports the aircraft performance 
module and airport runway configurations to provide greater precision when performing an 
emissions inventory, but if it is not available, the airport’s annual average values will be used for 
all activities. If dispersion is enabled, then hourly weather data is required in order to provide the 
precision necessary for detailed emissions and support the AERMOD dispersion module. 

The following weather parameters are used by EDMS: 

1. Mixing Height 

2. Temperature (ambient, daily high, daily low) 

3. Relative humidity 

4. Wind direction 

5. Wind speed 

6. Sea level pressure 

7. Cloud ceiling height 

8. Horizontal visibility 

If hourly weather data is used, the user must supply surface data for each hour, as well as twice-
daily upper-air observations, one of which must be an early morning sounding. Historical 
weather data are available for free from the EPA internet site (www.epa.gov) and other locations, 
such as www.webmet.com. Additionally, recent weather data are available from the National 
Climactic Data Center (NCDC) internet site (www.ncdc.noaa.gov) for a fee. The surface and 
upper-air observations are processed with the meteorological preprocessor, AERMET. The 
AERMET Wizard, initiated from the Weather dialog, steps the user through loading the two types 
of weather data and then merges them into a format that AERMOD can use. Three files are 
output from the AERMET Wizard: 

1. The AERMOD surface file (.SFC) 

2. The AERMOD profile file (.PFL) 
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3. The intermediate AERMET surface observation file (.MET) 

The surface file and the profile file are used directly by AERMOD, and contain only the 
meteorological parameters needed for dispersion purposes. The third file, the AERMET surface 
observation file, is an intermediate output file by AERMET and retains all of the meteorological 
parameters originally contained in the user-supplied surface data file, which is used by EDMS 
directly to drive the aircraft performance and runway configurations. 

Weather data must be provided in one of the formats listed in (Table 3-1); this may require 
converting the weather data into one of the formats listed. If weather for a specific location is not 
available, an appropriate substitution should be used. 

Table 3-1. Acceptable Weather Data Formats 

File Format Use Description Source 

TD-3280 Surface National Climactic Data 
Center (NCDC). 

www.ncdc.noaa.gov 

TD-3505 Surface National Climactic Data 
Center (NCDC). 

www.ncdc.noaa.gov 

CD144 Surface National Climactic Data 
Center (NCDC). 

www.ncdc.noaa.gov 

HUSWO Surface National Climactic Data 
Center (NCDC). 

www.ncdc.noaa.gov 

SCRAM Surface Environmental Protection 
Agency. 

www.epa.gov 

SAMSON Surface National Climactic Data 
Center (NCDC). 

www.ncdc.noaa.gov 

TD-6201 Upper-Air National Climactic Data 
Center (NCDC). 

www.ncdc.noaa.gov 

Radiosonde Data of North 
America – FSL format 

Upper-Air National Climactic Data 
Center (NCDC). 

www.ncdc.noaa.gov 
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3.2 Airside Network Layout 
The physical components that comprise the airside network include the runways, the gates, and 
the taxiways that link the two. In addition, taxipaths indicate the path through the taxiway 
network which an aircraft will take to go between a runway and gate, and runway configurations 
indicate the runways that will be active at a particular time of day based on weather conditions. 

These elements are necessary in order to model the delay and sequencing of aircraft as they 
depart, and determine the amount of time each aircraft spends on each portion of the tarmac in 
order to more precisely allocate the emissions to those areas for dispersion purposes. These 
components are optional when only an emissions inventory is needed, but are required for 
dispersion, and are discussed further below. 

3.2.1 Runways 
Aircraft runways are defined using the Runways dialog found under the Airport menu heading. 
Runways are named based on their magnetic orientation. For example, runway 9-27 is a runway 
oriented east-west, with runway 9 defining aircraft moving west to east, and runway 27 defining 
aircraft moving east to west. The Runways dialog allows the user to create runways with distinct 
endpoints. This, in turn, allows the user to distinguish the direction of traffic on the runway when 
defining taxipaths on the Taxipaths dialog and runway usage percentages on the Configurations 
dialog. 

3.2.2 Taxiways 
Aircraft taxiways are defined through the Taxiways dialog found under the Airport menu 
heading. The coordinates of the taxiway identify a series of area sources for the placement of 
aircraft movement while the aircraft is taxiing to and from a gate or a runway. The default taxi 
speed for an aircraft in EDMS is 15 knots (27.78 kph, 17.26 mph). 

3.2.3 Gates 
A gate is a physical point of arrival and departure for an aircraft. The location of the gate can 
affect the overall annual emissions inventory by changing the distance (and the associated 
emissions) needing to be traversed between the gate and the runway. Gate locations are also used 
to determine the placement of the dispersion sources for GSEs and APUs. 

3.2.4 Taxipaths 
A taxipath is a series of taxiways connecting a gate to a runway end (for “outbound” taxipaths) 
or a runway exit to a gate (for “inbound” taxipaths). The sequencing model determines the time-
location coordinates of an aircraft as it moves along the taxiways that its assigned taxipath 
comprises. These time-location coordinates are used to assign the aircraft’s emissions to the area 
sources that represent the taxiways. 

3.2.5 Configurations 
Airports operate under different configurations - the pattern of aircraft arrivals and departures on 
specific runways - over the course of a year depending on the weather, capacity, and noise 
abatement issues. Whereas it is impossible to account for all the various factors that might 
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influence the definition of configurations at specific airports, it has been determined that most 
often configurations are defined based on the wind parameters of direction and speed. 

The Configurations dialog (under the Airport menu heading) provides a way for the analyst to 
dynamically assign aircraft to different runways at run-time based upon weather conditions, time 
of day, and aircraft weight category. Each configuration can have associated limits for any or all 
of the following activation parameters: 

1. Wind direction 

2. Wind speed 

3. Hour of the day 

4. Cloud ceiling 

5. Horizontal visibility 

6. Temperature 

The active configuration can be determined based solely on those parameters, or the user can 
specify a distribution of percentage usage for the configurations, and EDMS will conform to that 
distribution, while trying to satisfy the activation parameters of the configurations as well as 
possible. 

3.3 Airside Network Layout 
The physical components that comprise the airside network include the runways, the gates, and 
the taxiways that link the two. In addition, taxipaths indicate the path through the taxiway 
network which an aircraft will take to go between a runway and gate, and runway configurations 
indicate the runways that will be active at a particular time of day based on weather conditions. 

These elements are necessary in order to model the delay and sequencing of aircraft as they 
depart, and determine the amount of time each aircraft spends on each portion of the tarmac in 
order to more precisely allocate the emissions to those areas for dispersion purposes. These 
components are optional when only an emissions inventory is needed, but are required for 
dispersion, and are discussed further below. 

3.3.1 Runways 
Aircraft runways are defined using the Runways dialog found under the Airport menu heading. 
Runways are named based on their magnetic orientation. For example, runway 9-27 is a runway 
oriented east-west, with runway 9 defining aircraft moving west to east, and runway 27 defining 
aircraft moving east to west. The Runways dialog allows the user to create runways with distinct 
endpoints. This, in turn, allows the user to distinguish the direction of traffic on the runway when 
defining taxipaths on the Taxipaths dialog and runway usage percentages on the Configurations 
dialog. 

3.3.2 Taxiways 
Aircraft taxiways are defined through the Taxiways dialog found under the Airport menu 
heading. The coordinates of the taxiway identify a series of area sources for the placement of 
aircraft movement while the aircraft is taxiing to and from a gate or a runway. The default taxi 
speed for an aircraft in EDMS is 15 knots (27.78 kph, 17.26 mph). 
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3.3.3 Gates 
A gate is a physical point of arrival and departure for an aircraft. The location of the gate can 
affect the overall annual emissions inventory by changing the distance (and the associated 
emissions) needing to be traversed between the gate and the runway. Gate locations are also used 
to determine the placement of the dispersion sources for GSEs and APUs. 

3.3.4 Taxipaths 
A taxipath is a series of taxiways connecting a gate to a runway end (for “outbound” taxipaths) 
or a runway exit to a gate (for “inbound” taxipaths). The sequencing model determines the time-
location coordinates of an aircraft as it moves along the taxiways that its assigned taxipath 
comprises. These time-location coordinates are used to assign the aircraft’s emissions to the area 
sources that represent the taxiways. 

3.3.5 Configurations 
Airports operate under different configurations - the pattern of aircraft arrivals and departures on 
specific runways - over the course of a year depending on the weather, capacity, and noise 
abatement issues. Whereas it is impossible to account for all the various factors that might 
influence the definition of configurations at specific airports, it has been determined that most 
often configurations are defined based on the wind parameters of direction and speed. 

The Configurations dialog (under the Airport menu heading) provides a way for the analyst to 
dynamically assign aircraft to different runways at run-time based upon weather conditions, time 
of day, and aircraft weight category. Each configuration can have associated limits for any or all 
of the following activation parameters: 

1. Wind direction 

2. Wind speed 

3. Hour of the day 

4. Cloud ceiling 

5. Horizontal visibility 

6. Temperature 

The active configuration can be determined based solely on those parameters, or the user can 
specify a distribution of percentage usage for the configurations, and EDMS will conform to that 
distribution, while trying to satisfy the activation parameters of the configurations as well as 
possible. 

3.4 Airport View 
The Airport option, under the View menu, provides the user the capability to visualize their 
source and receptor placements in relation to each other. Runways are indicated by a thick gray 
line with a solid blue centerline, taxiways are identified by a thick, gray line, roadways are 
indicated by a solid red line and receptors are indicated by a flag pole. The ability to import an 
airport’s “wallpaper” is also provided. The wallpaper can be any bitmap image, and is typically 
the airport layout diagram or a map of the airport and the surrounding area.  
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The Airport View screen is a non-modal screen and hence the user may continue to add sources 
and receptors in dialogs and view their placement in the display upon closing each dialog. All 
sources can be dragged to their desired destination and modified from the Airport View by 
double-clicking the source and making changes through the sources dialog box. To further aid 
the user in verifying the coordinates and placement of components the position of the crossbar 
cursor, in the coordinate system, is displayed in the status bar at the bottom of the display screen, 
and a Scale is displayed in both the status bar and the legend. A limited zoom capability is also 
provided. (Section 6.6.3) provides detailed information on how to interact with the Airport View. 
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4 DISPERSION CALCULATIONS 
EDMS generates input files for use with EPA’s AERMOD dispersion model, its meteorological 
preprocessor, AERMET, and its terrain preprocessor, AERMAP. AERMOD is a steady-state 
plume model that assumes a Gaussian concentration distribution in both the horizontal and 
vertical directions in the stable boundary layer. In the convective boundary layer, dispersion is 
Gaussian in the horizontal direction, with the vertical direction being modeled by a bi-Gaussian 
probability density function. It is not the intent of this user manual to describe AERMOD or any 
of its associated preprocessors in detail. Detailed information about AERMOD is available from 
user guides and additional information contained on the EPA’s internet site 
(www.epa.gov/scram001/dispersion_prefrec.htm#aermod). The purpose of this manual is to 
describe how EDMS is used to generate input files for AERMOD. The algorithms used by 
EDMS to generate the AERMOD input files are described in the EDMS Technical Manual. 

4.1 Dispersed Pollutants 
EDMS can calculate hourly emissions, and generate AERMOD input files for the following 
pollutants: 

1. CO (carbon monoxide), 
2. THC  (total hydrocarbons) for aircraft and APUs only, 
3. NMHC  (non-methane hydrocarbons), 
4. VOC (volatile organic compounds), 
5. TOG (total organic compounds), 
6. NOx (nitrogen oxides), 
7. SOx (sulfur oxides), 
8. PM-10 (particulate matter, 10 microns), and 
9. PM-2.5 (particulate matter, 2.5 microns). 

 
Note: Aircraft PM emissions are only estimated for aircraft with ICAO certified engines 

4.2 Inputs Required 
The amount of data required to perform a dispersion analysis is significantly greater than the data 
necessary for just an emissions inventory. All of the inputs necessary for the emissions inventory 
are also necessary for dispersion modeling. In addition, some modeling options that are optional 
for just emissions inventory are required when dispersion is enabled, including: 

1. Accurate operational profiles or a schedule (see Chapter 2), 

2. Aircraft performance modeling (see Chapter 2), 

3. Aircraft delay & sequencing modeling (see Chapter 2), 

4. Hourly weather data (see Chapter 3), and 

5. Placement of receptors. 

An emissions inventory must first be generated before dispersion can be performed, since the set 
of emissions that are dispersed is the same as that produced from the annual inventory. 

The dispersion algorithms use the selected operational profiles or aircraft schedule to vary the 
source activity based upon time. It is important that accurate profiles be developed to represent 
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the variation of individual source activity as this can affect the outcome of dispersion 
significantly. Two similar parameters found in all of the emissions source screens are the values 
for Yearly and Peak Quarter Hour activity. The dispersion pre-processing routines use the Peak 
Quarter Hour value in the computation of an emission rate. If the Yearly activity were the only 
known variable then the user would use operational profiles to derive the Peak Quarter Hour 
value. Upon entering the value for Yearly activity and choosing the appropriate Quarter Hourly, 
Daily, and Monthly operational profiles the program will automatically compute the 
corresponding Peak Quarter Hour value. Even if the Peak Quarter Hour value is known, and 
entered directly, accurate operational profiles will still have to be defined and selected for each 
source in the study. AERMOD itself uses hourly time bins. The use of quarter hours is only to 
provide better fidelity from the aircraft sequence modeling. 

Since EDMS is a model specifically developed for use at airports and air bases, there are several 
screens that relate directly to the placement of aircraft and other source activity and movement 
on the airport. Data input includes the creation and specification of runways, taxiways, buildings, 
and gates. These inputs are converted into a collection of appropriate sources for modeling 
dispersion in AERMOD. 

4.2.1 Receptor Locations 
The locations at which concentrations are estimated are known as receptors. EDMS allows the 
placement of receptors in the Cartesian or Polar coordinate system with the ability to also specify 
the height of the receptors. EDMS does not perform any checking on the reasonableness or 
accuracy of the placement of receptors; it is left to the users to verify this for themselves. 

As a general rule, receptors should be located where the maximum total projected concentration 
is likely to occur and where the general public is likely to have access. General guidance is given 
in Volume 9 guidance (EPA, 1978b) for receptor siting:  

• Places of expected maximum concentrations; 

• Places where the general public has access over the time periods specified by the 
NAAQS; and 

• Reasonableness. 

Examples of reasonable receptor sites might be:  

• Sidewalks to which the general public has access on a more-or-less continuous basis; 

• On the property lines of all residences, hospitals, rest homes, schools, playgrounds, and 
the entrances and air intakes to all other buildings; 

• Portions of a nearby parking lot to which pedestrians have continuous access. 

Examples of unreasonable receptor sites might be: 

• Median strips of roadways; 

• On or close to an aircraft runway or taxiway; 

• Within intersections or on crosswalks at intersections; 

• Tunnel approaches; 

• Within tollbooths; and 

• A location far from the breathing height (1.8 m) at which the general public will not have 
access. 
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The Receptors dialog, found under the Dispersion menu heading, allows the user to place 
individual receptors or networks of receptors for concentration estimation. Dispersion 
calculations will include all receptors in the In Study list box. The EPA recommended height for 
receptor placement is breathing height (approximately 1.8 meters or 5.9 feet).  

The Receptor Networks tabs on the Receptors dialog box allow the user to define two-
dimensional grids of individual receptors over a rectangular region (Cartesian) or an annular 
sector (polar) of the airport or study area. Due to the increased computational time required for a 
large number of receptors, the primary use of grids has typically been in screening dispersion 
estimates. 

4.2.2 Elevation 
EDMS sources and airport layout components have an associated elevation field. The elevation 
acts as a base to which the release height for emissions is added to determine the initial vertical 
location of emissions. Running AERMAP supersedes the user-supplied elevations in the 
AERMOD input files with elevations from a Digital Elevation Model formatted file, but does not 
replace the user’s elevation in the study data. 

4.3 Dispersion Modeling Calculation 
The intent of dispersion modeling is to assess the air pollutant concentrations at or near the 
airport or air base resulting from identified emissions sources. These pollutant concentrations are 
calculated to determine whether emissions from the site result in unacceptably high air pollution 
levels downwind by comparison with the National Ambient Air Quality Standards (NAAQS) or 
other relevant air quality standards. To perform dispersion modeling, EDMS requires the 
coordinates (in meters or feet relative to the user-specified origin) of each emissions source, the 
specification of an emissions rate (derived from emission factors) and its variation through time. 
For some sources, the release height, temperature and gas velocity are also required. The 
identification of spatial points in the coordinate system for concentration estimation (receptors), 
and the availability of weather data for individual hours are also required. 

The basic Gaussian equation, a mathematical approximation that simulates the steady-state 
dispersion of pollutants from a continuous point source is given below. 

Equation 4-1: Gaussian Approximation3 

2 2 2

y z y z z

Q 1 y 1 z- H 1 z+ H
C (x, y,z,H) =  exp -      exp -     + exp -    

2 u 2 2 2πσ σ σ σ σ

                       
                

 

where: 

 C = point concentration at receptor, in µg/m3 

 (x,y,z) = ground level coordinates of the receptor relative to the source and wind 
direction, in meters 

                                                      
3 Source: Air Quality Procedures for Civilian Airports and Air Force Bases, FAA/USAF, Washington, DC, 
1997. 
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 H = effective release height of emissions, in meters (m) 

 Q = mass flow of a given pollutant from a source located at the origin, in 
µg/s 

 u = wind speed, in m/s 

 σy = standard deviation of plume concentration distribution in y plane, in m 

 σz = standard deviation of plume concentration distribution in z plane, in m 

 

The results of the AERMOD dispersion calculations are the concentrations, given in micrograms 
per cubic meter (µg/m3), at receptors for each hour. The following describes dispersion data 
inputs and outputs. 

4.3.1 Point, Area and Volume Sources 
Just as the emissions inventory breaks down airport operations into source categories, the same 
applies to dispersion calculations. For dispersion modeling purposes, each source category is 
assigned one of three source type categories: point, area or volume. EDMS uses all three source 
types in AERMOD. 

Stationary sources such as power plants release pollutants into the atmosphere through a point 
source discharge mechanism such as a stack (training fires are also treated as point sources). The 
AERMOD point source module is used to model dispersion for all point sources in EDMS. Point 
source emission rates are generally given in grams per second (gm/sec). 

Area sources are generally defined as an area with a uniform rate of emissions over the entire 
surface. Parking facilities are classified as area sources in the model. Airport parking facilities 
generate emissions due to on-road vehicles operations and vehicle idling. Area source emission 
rates are generally given in grams per second per square meter (gm/sec-m2). In the case of a 
multi-level parking facility, area sources are stacked at a defined increment to characterize the 
structure. 

Aircraft taxiing, aircraft queuing, aircraft accelerating on the runway, and on-road vehicle 
operations are considered to be a series of area sources, since their movement along a path 
approximates a line of continuous emissions. Similarly, aircraft after takeoff and during the 
landing approach are also represented as a series of area sources. The area source was selected, 
as opposed to using a series of volume sources based on recommendations from the American 
Meteorological Society/EPA Regulatory Model Improvement Committee (AERMIC). 

In EDMS the activity at gates are considered to be volume sources when the emissions from 
Startup, GSE and APUs are estimated to originate from a single point of discharge, and area 
sources when multiple points are used to model the gate. The latter case is typically used when a 
terminal or part of a terminal is represented as an EDMS “gate.” 

4.3.2 Aircraft  
Aircraft activity is specified in the Aircraft Operations and Assignments dialog. The additional 
data required for dispersion analysis (other than operational profiles) are assigned in the 
Performance and GSE & Gate Assignment tabs in the Aircraft Operations and Assignments 
dialog. The Taxi Out and Taxi In Times in Mode fields are not used in dispersion calculations; 
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they are used solely for the emissions inventory. This permits users only interested in generating 
an emissions inventory to avoid having to define an airport layout. For dispersion, taxi in and out 
times (and their corresponding locations on the taxiway network) are determined from the delay 
and sequencing module. As discussed in (Chapter 2), aircraft have six modes of operation, and 
each mode is represented by AERMOD area sources as follows: 

1. Approach: A vertical 2-dimensional grid of area sources extending along the runway 
center line starting at 1,000 ft down to the runway end representing the airborne 
approach path. The approach path from the mixing height to 1,000 ft is collapsed into a 
single horizontal row of area sources halfway between 1,000 ft and the mixing height. 

2. Taxi In: The landing ground roll is attributed to the Runway source and the taxi in is 
attributed to the Taxiway sources. 

3. Startup: Aircraft main engine startup occurs at the gate. This methodology is only applied 
to aircraft with ICAO certified engines. All other aircraft will not have startup emissions. 
Aircraft main engine startup produces only THC, VOC, NMHC, and TOG emissions. A 
detailed speciated organic gases profile does not exist for main engine startup emissions. 
The Startup emissions, and assigned GSE and APU are attributed to the Gate source. 

4. Taxi Out: The Taxi Out is attributed to the Taxiways source. 

5. Takeoff: The takeoff ground roll is attributed to the Runway sources, while the airborne 
portion is attributed to a vertical 2-dimensional grid of area sources extending along the 
runway center line starting at the runway end representing the airborne departure path, 
from the runway up to 1,000 ft. The departure path from 1,000 ft to the mixing height is 
collapsed into a single horizontal row of area sources halfway between 1,000 ft and the 
mixing height. 

6. Climb Out: Uses the same vertical two-dimensional grid as the airborne Takeoff 
segments. 

Because the vast majority of the dispersion concentrations are attributed to the emissions 
released by aircraft below 1,000 ft, the approach and departure spaces use a detailed vertical 2-
dimensional grid below 1,000 ft. However, in order to improve the computer run time, aircraft 
sources between 1,000 feet and the mixing height are collapsed into the plane halfway between 
1,000 feet and the mixing height. 

4.3.3 Gates, GSE and APU 
For the purposes of dispersion modeling, the emissions contributions due to aircraft main engine 
startup (contained in the aircraft Gate mode of operation), GSE, and APUs are localized at the 
gate to which the aircraft is assigned. The gate coordinates provide the spatial location in the 
coordinate system from which all these sources are considered to emanate. The dispersion from 
the sources at the gate is represented by a single volume source for each gate if only one point is 
specified to define the gate; otherwise an area source is used to represent the gate. For larger 
airports, many users represent a series of gates or part of a terminal as an individual gate in their 
EDMS study. 

4.3.4 Runways 
Runways determine the location at which aircraft will operate and release emissions during the 
ground roll for takeoff and landing. In addition, each runway end serves as the anchor point for 
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the 2-dimensional vertical profile for the aircraft approach and takeoff grids from which 
emissions will be released for dispersion purposes as the aircraft approaches and takes off. 

4.3.5 Taxiways 
Taxiways determine the ground segments where the aircraft operates at idle thrust and releases 
emissions whilst taxiing between the gates and runways. 

4.3.6 Parking Facilities 
Parking lot and parking garage activity is specified in the Parking Facilities. The additional data 
required for dispersion analysis is found in the Dispersion Parameters box of the Parking 
Facilities dialog. The parking structure must be defined as a series of up to 20 points. The 
parking facility Height is specified to represent the height at which emissions are released. Each 
parking facility may also have up to 20 levels. Facilities with multiple parking levels are modeled 
using stacked area sources. 

4.3.7 Roadways 
Vehicle activity on roadways is specified in the Roadways dialog. The additional data required 
for dispersion analysis is found in the Coordinates box. Aside from the coordinates that define 
the path of the roadway, the height and width of the roadway must also be specified. These 
values correspond to the release height and width of the emissions and not the physical 
dimensions of the roadway. Roadways are modeled as a series of area sources by AERMOD. 

4.3.8 Stationary Sources 
The Stationary Sources dialog offers the capability of specifying the activity of several different 
categories of stationary sources for dispersion analysis. Performing a dispersion analysis requires 
the analyst to specify the dimensions of the stationary source. The additional data required for 
dispersion analysis is category dependent and is found in the lower left corner of the dialog. 
Users can specify the category-specific (and in some cases type-specific) emissions parameter 
values or use the default emissions parameter values. The specific methodologies for computing 
stationary source emission factors and the associated data requirements are presented in 
Appendix H of Air Quality Procedures for Civilian Airports and Air Force Bases (the Air Quality 
Handbook). The general methodology for calculating emissions from these sources considers the 
amount of fuel or substance consumed.  
Users are permitted to select the type of AERMOD source (point, area, or volume) used to model 
each stationary source in the EDMS study to better characterize the sources at their airport. 
Default values are also provided for all source types. 

4.3.9 Training Fires 
Training fire data are used by EDMS in both emissions and dispersion analyses. For emissions 
purposes, calculations are based upon the amount of fuel burned, as well as the Height, 
Temperature, Diameter, and Gas Velocity of each fire. For dispersion analyses, training fire 
emissions are treated as point sources by EDMS. Training fire emissions are located spatially 
within the airport using the (x, y) coordinates. 
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4.3.10 Buildings 
Airport building sources affect the emitted point source plumes by essentially serving as 
obstacles to those sources, and therefore have a significant impact on concentrations resulting 
from stationary source emissions.  

Important: Buildings have no effect on the concentrations estimated from volume and area 
sources such as aircraft, APU, GSE, roadways, and parking facilities. 

4.4 Dispersion Data Output 
Modeling concentrations is a three-step process in EDMS. First, the user must select the 
meteorological data to be used via the AERMET Wizard, which is started from the Weather 
dialog, which is opened from the Airport menu heading. EDMS includes the optional use of 
AERMAP, which is the terrain preprocessor of AERMOD. AERMAP creates source (.SRC) and 
receptor (.REC) files for inclusion in AERMOD dispersion analyses. Next, the user must 
Generate AERMOD Input Files, under the Dispersion menu heading. This step pre-processes the 
emissions for every source for every hour in the weather data. The user also has the opportunity 
to select different averaging periods as well as the desired pollutant at this time. Finally, the 
dispersion calculations may be run by selecting Run AERMOD under the Dispersion menu 
heading. To run AERMOD with the input files generated by EDMS on a different computer, the 
user can refer to the instructions in the EDMS Technical Manual. Step-by-step instructions for 
generating the AERMOD input files are provided in (Section 6.5.3). 

As the dispersion algorithms execute, AERMOD displays its current status on the screen. Once 
AERMOD has finished, the AERMOD window will close and the user will be returned to 
EDMS. After AERMOD has run, EDMS will have created a directory for each scenario within 
the study directory. In each scenario directory there will be a directory for each airport. In each 
airport directory will be a file with the (.OUT) extension for each year and pollutant in the 
scenario-airport combination. These files contain both the list of inputs to AERMOD along with 
the concentrations for that scenario-airport-year-pollutant combination. These results can be 
viewed and printed in any text editor, but TextPad is recommended. Concentration (.CON) files 
can be viewed in the Concentrations View. Instructions for using the view concentrations option 
are provided in (Section 6.6.4). 
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5 UTILITIES 
The EDMS Utilities allow the user to define study elements that can then be used within EDMS 
studies. User-Created objects can have customizable emissions factors, certain customizable 
properties pertinent to the type of object, and default operating data, which can then be used in a 
study in lieu of the system study objects that are provided with EDMS. The study elements that 
can be created are Operational Profiles, User-created Aircraft, User-created GSE and User-
created APUs. 

5.1 Operational Profiles 
Operational profiles are used to vary the operational usage of an emissions source according to 
the month of the year, day of the week, and quarter hour of the day. The profiles are used to more 
accurately gauge the emissions rates, and thus to more accurately model the resulting 
concentrations in dispersion. Operational profiles can also be used with aircraft operations to 
more accurately estimate taxi delay with sequence modeling. 

Each time slice in a profile is assigned a value from 0 to 1, where 0 means no activity occurs and 
1 means that the peak of activity is reached during that time slice. Activity over the profile period 
is allocated to the time slices in proportion to the assigned values. See (Chapter 6) for a more 
detailed explanation of how profiles are used. 

5.2 User-Created Aircraft 
Because new airframes and engines are always under development, the user may need to extend 
the system aircraft tables. The User-Created Aircraft dialog provides the means to do so. 

The User-Created Aircraft dialog is displayed under the Utilities menu heading. In this screen 
the user may specify an aircraft name, the Number of Engines on the airframe, the Engine Bypass 
Ratio, the Default SOx Emissions Index, the Category (size, designation, engine, and usage, 
whether it is an air taxi and its European group designation), the Engine Emissions Data Source 
and the Flight Profile. Also, for each of the modes Taxi Out, Takeoff, Climb Out, Approach and 
Taxi In, the times and emissions-related parameters should be specified. The emissions 
parameters are Fuel Flow, Emission Indices for CO, THC, NOx and PM, and Smoke Number. 
These mode-linked parameters can either be supplied by EDMS, by checking Use System 
Emission Indices and Fuel Flow Rates, or they can be supplied (or modified from the system 
supplied values) by the user. The times-in-mode entered on this screen will be used for emission 
inventory purposes only. 

The Engine Bypass Ratio is the ratio of the mass of air that bypasses the engine core to the mass 
of air that passes through the core. For aircraft with ICAO certified engines, this value is used in 
the FOA 3 / 3a equations to compute PM from smoke numbers. 

The Default SOx EI is the initial value of the SOx EI on the engine emissions tab when a user-
created aircraft is added to a study. 

If a Smoke Number value for a given mode is not available ("N/A") for use in FOA 3 / 3a 
methodology, then the FOA 3 / 3a methodology is not used and the PM EI value is used instead. 
The user can enter a blank or negative number for Smoke Number to cause this. 

For performance modeling purposes, the user must also select a system aircraft-engine 
combination that most closely matches the newly added aircraft in terms of performance and fuel 
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burn characteristics. Selecting this combination will assign the system aircraft’s flight profile 
data to the new aircraft in order to determine time and location for dispersion analysis. 

Data for user-created aircraft are stored with the system tables, rather than the study data, so that 
the user-created aircraft can be available to all studies run on the installation of EDMS used to 
create them. This allows the user-created aircraft to be defined once, and then always be 
available on that user’s computer. If a study containing user-created aircraft is to be shared with 
another user, you must use the export utility to save a copy of the user-created aircraft data along 
with your study data. If the user-created aircraft are not exported from the machine where the 
study was created, they will not be available in the study when it is opened on a new computer. 

5.3 User-Created GSE 
EDMS allows the user to define GSE. The User-Created GSE dialog is displayed under the 
Utilities menu heading. The user can specify emission factors (in grams per horsepower-hour) for 
one or more fuels in the Emission Factors box, at the bottom of the screen. Only emission factors 
for CO, Total HC, NOx, SOx and PM-10 need to be specified because values for NMHC, TOG 
and VOC are derived from Total HC, and PM-2.5 is derived from PM-10. However, these values 
can also be obtained from a system GSE. In the Emission Factor Data Source box, select System 
Tables and the values in the Emission Factors box will automatically update to reflect the 
selected data source. Choose the system GSE and year for which emissions data is desired from 
the drop-down lists. As with the user-created aircraft; the user-created GSE will only be available 
for use in studies performed with the installed copy of EDMS. 

5.4 User-Created APU 
EDMS allows the user to define APUs. The User-Created APU dialog is displayed under the 
Utilities menu heading. For each APU, the user need only specify emission factors for CO, Total 
HC, NOx, SOx and PM-10/2.5, because values for NMHC, TOG and VOC are derived from 
Total HC, and PM-10 and PM-2.5 are the same. However, much like the user-created GSE, these 
values can also be obtained from a system APU. In the Emission Factor Data Source box, select 
System Tables and the values in the Emission Factors box and the default operation time 
parameter will automatically update to reflect the chosen data source. Choose a system APU 
whose emissions data is desired from the drop-down list. As with the user-defined aircraft and 
GSE; user-defined APU will only be available for use in studies performed with the installed 
copy of EDMS. 
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6 USER INTERFACE 
This chapter describes the contents of every menu in EDMS and the options available in each of 
the dialog boxes. EDMS has 8 menus: File, Emissions, Airport, Dispersion, View, Utilities, 
Window, and Help. 

All dialog windows conform to the Microsoft Windows standard, and there are 4 buttons present; 
OK, Cancel, Apply, and Help. The OK button saves any changes and exits the window. The Apply 
button saves any changes without exiting the window. The Cancel button exits the window without 
saving any changes. The Help button brings up the help window. 

6.1 Study Window 
The Main Study window (Figure 6-1) is divided into four panes. The upper-left pane contains a 
tree, which shows the structure of the study and which provides menus (via right-clicking) that 
apply to the study's components. The lower-left pane displays which scenario, airport and year are 
currently selected in the upper-left pane. The upper-right pane gives a more detailed look at the 
contents of the study component currently selected in the upper-left pane; it shows the contents of 
the next node down in the tree. (Figure 6-1) shows the study named Tutorial, which includes a 
scenario named Baseline. The scenario contains only the Hagerstown airport, whose contents are 
displayed in the upper-right pane. Double clicking on any of them will bring up the corresponding 
dialog. The lower-right pane lists the properties of the tree node selected in the upper-left pane. 
The information shown cannot be edited directly in the pane as it is displayed for user-reference 
only. 
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Figure 6-1: Main Study Window 

  

6.1.1 Study Tree 
The top element in the tree is the study. When it is selected, the upper-right pane displays a list of 
the scenarios in the study and their descriptions. Right-clicking brings up a menu with options: 
Study Properties (Figure 6-2), Rename, Add New Scenario, and Add New Airport. Study Properties 
brings up the Study Properties dialog. Rename allows the study to be renamed. Add New Scenario 
opens the Scenario Properties dialog (Figure 6-4) for a new scenario. Add New Airport opens the 
Airport Properties dialog (Figure 6-6) for a new airport. When changes have been made to a study 
and have not been saved, a “*” is placed at the end of the study name in the EDMS upper-left pane. 
Once the study is saved the “*” goes away. 

In the first level down in the tree are the scenarios. When a scenario is selected, the upper-right 
pane displays a list of all the airports and their descriptions. Right-clicking on a scenario brings up 
a menu with options: Scenario Properties, Set as Baseline, Rename, and Duplicate. Scenario 
Properties opens the Scenario Properties dialog (Figure 6-4) for the selected scenario. Set as 
Baseline marks the selected scenario as the baseline scenario for emissions reduction reports. This 
is indicated by the scenario name being shown in bold in the study tree. Rename simply allows the 
selected scenario to be renamed. Duplicate makes a copy of the selected scenario, including all 
emissions sources and their operational usage and all airport features. 

The level below the scenarios holds the airports. When an airport is selected, the upper-right pane 
displays a list of all the years in the study. Right-clicking on an airport brings up a menu with the 
option: Airport Properties, which opens the Airport Properties dialog (Figure 6-6) for the selected 
airport. When changes have been made to a scenario-airport combination which would result in a 
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change of emissions, a “*” is placed at the end of the scenario-airport name in the EDMS upper-left 
pane to indicate that the emissions need to be updated. 

The lowest level is the study years. When a year is selected, the upper-right pane displays a list of 
the emissions sources, airport features, and operational profiles plus counts for how many of each 
are defined for that scenario-airport-year combination. There is no right-click menu for the years. 

6.2 The File Menu 
The File Menu provides the user with the ability to specify study information, create a new study, 
open, close or save an existing study, import or export study data, print the current window, or exit 
EDMS. The contents of the file menu are listed below: 

• Study Properties 

• New 

• Open 

• Close 

• Save 

• Save As 

• Import 

• Export 

• Print 

• Print Preview 

• Print Setup 

• Recent Studies 

• Exit 

6.2.1 Study Properties 
Selecting Study Properties on the File menu brings up the Study Properties window (Figure 6-2) 
and allows the user to setup a study by specifying several important parameters that apply to the 
study as a whole. 

Study Name & Description 

The Study Name and Study Description can be edited simply by clicking in the field and typing. 
The Study Name is what EDMS will use to identify the study for the user. The name of the selected 
study will appear on the title bar on the main EDMS window and at the top of the study tree in the 
left-hand pane. The Study Description is a field for the user to write a small description of the 
study. This description will appear as part of the header when certain study reports are printed. 

Enable Dispersion Modeling 

This checkbox turns on dispersion modeling. If it is not checked, only the input fields and menu 
items related to an emissions inventory will be displayed. When the checkbox is checked, 
dispersion modeling is selected and the input fields and menu items for dispersion calculations will 
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become available. The type of modeling can be changed at any time, and no data will be lost by 
changing study types. 

Enable Speciated Organic Gas (OG) Emissions 

This checkbox turns on speciated organic gas emissions. When the checkbox is checked, EDMS 
will calculate speciated organic gas emissions for all sources except aircraft main engine startup. If 
it is not checked, only the criteria pollutant emissions are calculated. The type of modeling can be 
changed at any time, and no data will be lost by changing study types. 

Unit System 

The measurement system to be used throughout almost all of the windows and dialog boxes in 
EDMS is selected in the Unit System. For example, when Metric is selected, the airport layout units 
are displayed in meters. When English is selected, the airport layout units are displayed in feet. 

Default Emissions Inventory Units 

These radio buttons allow the user to select the default inventory units when emissions are 
displayed. If Metric units are selected, the user may choose among Metric Tons, Kilograms and 
Grams. If English units are selected, the user may choose between Pounds and Short Tons.

Figure 6-2: The Study Properties Window 

 

 

Analysis Years 



 

 6-5

These drop-down lists allow the user to select the desired Analysis Years. The user can specify any 
set of years from 1990 to 2050. If the user sets the first and last years and then sets the No. of 
Years to fewer than is needed to span the range, EDMS will distribute that number of years as 
evenly as possible in the range. The user can also edit the list of years directly, and EDMS will 
adjust the other fields to match. The Analysis Years contribute to the calculation of the vehicle, 
roadway, and parking facility emissions and performance of dispersion analysis. 

Edit Buttons 

The Edit Scenario List button brings up the Scenarios dialog (Figure 6-3), which allows the 
addition, removal and editing of scenarios. The Edit Airport List brings up the Airports dialog 
(Figure 6-5), which allows the addition, removal and editing of airports. 

6.2.1.1 Scenarios 
Pressing the Edit Scenario List button in the Study Properties window (Figure 6-2) brings up the 
Scenarios dialog (Figure 6-3), which allows the addition, removal and editing of scenarios. Every 
study must contain at least one scenario. By default, every new study created contains a scenario 
named Baseline. 

Figure 6-3: Scenarios 

 

 

Adding Scenario Information 

To add a scenario, press the Add New button. The Scenario Properties dialog (Figure 6-4) will 
appear. After the scenario properties have been set and OK has been pressed in that dialog, the new 
scenario will appear in the In Study Scenarios list, already selected and ready for its name to be 
edited.  

Once added, scenarios can remain in the current study, or be moved to a list of available scenarios 
with the Remove button. The last scenario cannot be removed. To move a scenario from the 
Available Scenarios list to the In Study Scenarios list, select the scenario name and press Add. To 
delete a scenario from the Available list permanently, select it and press Delete. To create another 
scenario with the same properties as an existing one, select that one and press Duplicate. A copy 
will appear in the In Study Scenarios list. To edit a scenario, select it and press Edit. The will 
popup the Scenario Properties dialog (Figure 6-4). 
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Double-clicking on a scenario in the Available Scenarios list will move it to the In Study Scenarios 
list. Double-clicking on a scenario in the In Study Scenarios list allows the name of the scenario to 
be edited. Right-clicking on a scenario in either the Available Scenarios or the In Study Scenarios 
list selects that scenario and pops up a menu that matches the buttons between the two lists, except 
that it has the additional option of Select All. 

6.2.1.2 Scenario Properties 
The Scenario Properties window (Figure 6-4) allows the user to edit properties that are scenario 
specific. It can be accessed either by pressing Edit in the Scenarios window (Figure 6-3), or by 
selecting Scenario Properties in the popup menu after right-clicking on a scenario in the upper-left 
pane tree.  

Figure 6-4: Scenario Properties 

 
 

System Aircraft Times in Mode Basis 

If Enable Dispersion Modeling was selected on the Study Properties window and applied, then 
only Performance Based times in mode can be used. 

Performance Based (SAE AIR 1845) 

Selecting this option will invoke a performance modeling module based on the performance 
modeling used in the FAA Integrated Noise Model (INM).  

ICAO/USEPA Defaults 
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This option is only available when dispersion is disabled. These values provide for a quick estimate 
of emissions. 

Taxi Time Modeling Options 

If Enable Dispersion Modeling was selected on the Study Properties window and applied, then 
only Sequence Modeling can be used for taxi times. 

User-specified taxi times for each aircraft 

This option is only available when dispersion is disabled. The Default Taxi Times (Section 6.4.1) 
will be applied to each aircraft, unless changed by the user on the performance tab of the Aircraft 
Operations & Assignments dialog. 

Sequence Modeling 

When this option is selected, Default Taxi Times (Section 6.4.1) under the Airport menu will be 
disabled, since those times would not be used. The sequence modeling can use actual airport 
schedule data or derive a pseudo-schedule from the annual operations and the operation profiles. 
This schedule is then used to model the ground movement of the aircraft, and from that taxi times 
are derived. When used in a dispersion analysis, the model provides time-based position 
information, in order to more accurately estimate the source location of emissions. 

FOA 3.0 Sulfur-to-Sulfate Conversion Ratio 

First Order Approximation (FOA) 3.0 is the CAEP-approved version of FOA for estimating PM 
emissions from jet and turboprop aircraft engines as determined from CAEP Working Group 3. 
The sulfur-to-sulfate conversion ratio represents the portion of the sulfur in the fuel that when 
combusted becomes sulfuric acid. Sulfuric acid is one of the components of the volatile fraction of 
PM. The default value of 2.4% represents the current best estimate of the conversion ratio. This 
value is only applicable to non-U.S. airports because EPA mandates using a conservative sulfur-to-
sulfate conversion ratio of 5.0% for U.S. airports (specifically, those airports in EDMS whose 
country code is “US”). 

6.2.1.3 Airports 
Pressing the Edit Airport List button in the Study Properties window (Figure 6-2) brings up the 
Airports dialog (Figure 6-5), which allows the addition, removal and editing of airports. Every 
study must contain at least one airport.  

Note: Once an airport has been created, it cannot be renamed. 

Adding Airport Information 

To add an airport, press the Add New button. The Airports Properties window (Figure 6-6) will 
appear. After the airport properties have been set and OK has been pressed in that dialog, the new 
airport will appear in the In Study Airports list, already selected. 
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Figure 6-5: Airports 

 
 

Once added, airports can remain in the current study, or be moved to a list of available airports 
with the Remove button. The last airport cannot be removed. To move an airport from the Available 
Airports list to the In Study Airports list, select the airport name and press Add. To permanently 
delete an airport from the Available Airports list, select it and press Delete. To edit an airport, 
select it and press Edit. The will popup the Airport Properties window (Figure 6-6). 

Double-clicking on an airport in the Available Airports list will move it to the In Study Airports 
list. Double-clicking on an airport in the In Study Airports will popup the Airport Properties 
dialog, but the airport name will not be editable. Right-clicking on an airport in either the Available 
Airports or In Study Airports list selects that airport and pops up a menu that matches the buttons 
between the two lists, except that it has the additional option of Select All. 

6.2.1.4 Airport Properties 
The Airport Properties window (Figure 6-6) allows the user to edit airport specific properties. It 
can be accessed either by pressing Edit in the Airports window (Figure 6-5), or by selecting Airport 
Properties in the popup menu after right-clicking on an airport in the upper-left pane tree. 
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Figure 6-6: Airport Properties 

 

The user can select or type the airport code, which causes the airport’s elevation, among other 
things, to be retrieved from the system tables. Airport information is based on the characteristics of 
the specific airport (or projected airport) being modeled. EDMS contains a database of over 30,000 
airports worldwide, identified by the following types of airports codes: 

1. International Air Transport Association (IATA) codes are 3-letter worldwide airport codes 
that are not unique and need to be used in combination with a 2-letter country code. For 
example, the IATA code “CRQ” could refer to an airport either in the United States or 
Brazil. 

2. International Civil Aviation Organization (ICAO) codes are 4-letter worldwide airport 
codes whose first letter refers to the geographic ICAO region in which the airport is 
located. 

3. Federal Aviation Administration (FAA) codes are unique 4-character codes for small 
airports in the United States. 

The user can select an airport from one of the drop-down menus or type an airport code in one of 
the three available airport identifiers. Since IATA airport codes are not unique among the set of 
worldwide airports, there exists a possibility that the specified code may map to more than one 
airport; in which case EDMS will then populate the Country Code drop down menu with all 
countries in which the specified airport code applies. Selecting the desired country from the 
dropdown list will populate the Airport Name, State, Elevation, Latitude and Longitude fields 
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accordingly. If data for the airport being modeled does not exist in the data table, the user is still 
able to manually enter the data on this screen. 

Note: Regardless of whether an IATA, ICAO or FAA code is used to designate the airport, it is 
important to select the appropriate country code from the drop down menu. This is because U.S. 
airports (specifically, those airports whose country code is “US”) use the USEPA-approved FOA 
3.0A methodology for PM emissions, and non-U.S. airports use the CAEP-approved FOA 3.0.  

Note: An airport's identification can only be edited when it is first created; once this window is 
closed, that airport's ID is fixed. To change an airport’s identification after it has been created and 
Applied, the user must create a new airport and delete the old one. 

Description & General Information 

The Country field cannot be edited after the airport is selected, but Description, ICAO Region, 
Region for Aircraft Default Engine and State can be, and a new Image File can be selected at any 
time. The function of Region for Aircraft Default Engine is to determine the default aircraft 
engines, which is the most common engine based on the population of engines for the aircraft 
within the selected region. The default engine is shown in bold in the Aircraft Operations & 
Assignment dialog, but the user is free to select any of the available engines fro each aircraft. 

Origin Coordinates 

There is a choice between Latitude & Longitude and Universal Transverse Mercator (UTM) as the 
means of entering the origin. The origin is the starting point for all of the coordinates used to 
define the locations of airport features and non-aircraft sources. The origin can be edited at any 
time, but it is clearly better to set it before defining any features or sources, so as to avoid having to 
return to edit their coordinates later. 

6.2.2 New  
To create a new study, select New from the File menu. When the New Study dialog box appears, 
browse through the list of directories in the Browse for Folder window to choose the location 
where the new study directory will be created and press OK. Type the name of your study in the 
Save As field and press OK. The user is encouraged to name all of their studies in a standardized 
way. For example, if the airport being modeled is "XYZ" and the first year being modeled is 2005, 
then the first baseline study should be named “XYZ Baseline 2005”, and all successive studies 
should be similarly named. To reduce confusion, all years should be entered as four-digits (e.g., not 
“05”). 

The Airport Properties window (Figure 6-6) will then appear. Enter the desired information and 
press OK. This will bring up the Airports dialog (Figure 6-5). To add another airport in the study 
press Add New, otherwise press OK. The Study Properties window (Figure 6-2) will now appear to 
allow the user make other changes to the study. When all desired changes have been, press OK to 
finish the creation of the new study. The new study is now saved in the previously selected folder. 

Note: EDMS will store all of a study's files in the directory where the study is created. The user-
created tables for user-created Aircraft, GSE & APUs are NOT located here, but rather in the 
system directory with the other system tables, as they can be shared with other studies and are not 
necessarily study specific. 
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6.2.3 Open  
To open an existing study, select Open from the File menu. When the Open Study dialog box 
appears, locate the main study file (the file with the .EDM extension) in the directory or drive in 
which it has been stored. Select the main study file and press Open. To exit the Open Study 
window without opening a study, press Cancel. 

6.2.3.1 EDMS 4.5 Study Conversion 
EDMS 5.1.1 can also convert an EDMS 4.5 study to a 5.1.1 study. Just open the EDMS 4.5 study 
as described above. EDMS will pop up the following dialog:  

Figure 6-7: EDMS 4.5 Study Conversion 

 

 

Select Yes to proceed with the conversion. Select No to abort opening the study. Selecting Yes will 
pop up a browser, so the user can choose where to put the converted study. After selecting the 
location to save the study, the user will be prompted for a name for the converted study. Once the 
new study name has been selected, press OK to complete the study opening/conversion process. 
EDMS will convert the annual average temperature of each airport and set the daily high and low 

temperatures to F°± 35.10 respectively. When the conversion is finished, MOBILE is run so that 
system-generated Emissions Indices can be updated using the weather parameters in the converted 
study. 

Note: When converting an EDMS 4.5 study which includes user-created objects (user created 
aircraft, APUs and/or GSEs) into EDMS 5.1.1, the user will be prompted to provide the installation 
path of EDMS 4.5 in order to obtain the definitions of the user-created objects. 

The first time that EDMS 5.1.1 encounters an EDMS 4.5 study that uses a user-created object that 
is not already defined in EDMS 5.1.1, it will migrate all user-created objects from EDMS 4.5 into 
EDMS 5.1.1, including those that are not actually used in the study being converted. Subsequent 
EDMS 4.5 studies being converted will use the definitions of the user-created objects that were 
migrated to EDMS 5.1.1 previously. 

If the EDMS 4.5 study includes a user-created object with the same name as one already defined in 
EDMS 5.1.1, then the study will use the user-created object that was already defined in EDMS 
5.1.1 (which could possibly have different emissions factors & other values found under the 
Utilities menu than from EDMS 4.5). The inclusion of that user-created object in the study will still 
be converted, but after the conversion it will have the emissions factors of the user-created object 
that is already in EDMS 5.1.1. 

This situation would be problematic only if a user-created object was defined in EDMS 5.1.1 with 
the same name as that in EDMS 4.5, but with different properties, prior to converting EDMS 4.5 
studies. If instead the user did not manually create any user-created objects in EDMS 5.1.1, then 
the user-created objects in EDMS 4.5 will be brought over to EDMS 5.1.1 with the EDMS 4.5 
properties without any problems. 
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Note: EDMS 4.5 does not allow the user to specify a flight profile for user-created helicopters, but 
EDMS 5.1.1 requires user-created helicopters to have a flight profile assigned. If an EDMS4.5 
study is being converted to EDMS 5.1.1 that contains a user-created helicopter, a flight profile will 
automatically be assigned to that helicopter based on an existing helicopter of similar size and 
engine type. 

6.2.3.2 EDMS 5.0.x Study Conversion 
EDMS 5.1.1 can also convert an EDMS 5.0.x study to a 5.1.1 study. Just open the EDMS 5.0.x 
study as described above. EDMS will pop up the following dialog:  

Figure 6-8: EDMS 5.0.x Study Conversion 

  

Select Yes to proceed with the conversion. Select No to abort opening the study. When the 
conversion is finished, MOBILE is run so that system-generated Emissions Indices can be updated 
using the updated default MOBILE parameters. 

Note: Once the study is converted and saved, the study will only work with EDMS 5.1.1, and will 
not work with previous versions of EDMS. 

6.2.3.3 EDMS 5.1 Study Conversion 
EDMS 5.1 studies are compatible with EDMS 5.1.1, so no conversion is required.  

6.2.4 Close 
To close a study, select Close from the File menu.  

If the user tries to close a study that has been changed, but not saved, EDMS will pop up a message 
so the user doesn't accidentally lose his changes. 

Note: Selecting Close only closes the current study, not EDMS. EDMS will continue running. To 
close EDMS, select Exit from the File menu. 

Important: Unlike previous versions of EDMS, closing a study in 5.0 does not automatically save 
the study. This allows the user to make temporary changes to observe their effect, without 
permanently changing the study or having to actively undo the changes. 

6.2.5 Save 
Selecting Save from the File menu, saves all the data and settings needed to recreate the selected 
study in the previously selected directory. 
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6.2.6 Save As 
To save a copy of the current study under another name, select Save As from the File menu. When 
the Save As dialog box appears, type the name to save the study under, choose a directory and/or 
drive, and press Save. 

Note: This does not copy in all of the output files, just the user inputs. In addition, the new copy of 
the .EDM file will be appropriately renamed to correspond to the name of the new directory.  

To exit this window without saving, press Cancel. 

6.2.7  Import & Export 
EDMS provides users with the capability of building sources outside of EDMS and importing them 
into the model. This is done through the Import Utility located under Files from the main menu. 
The import utility is used to read a semicolon-separated text file that contains data for importing. 
The files can be created and edited by Microsoft Excel or any text editor. The user can import the 
contents of the entire file or only selected parameters and tables. The import utility does not 
overwrite any values for any sources in the study and only appends unique records to the study. 
Therefore, records that have the same identifier as existing records in the study will be skipped. If 
the intent is to import new values into the study, old records to be replaced should be deleted 
before running the import utility. 

Users may also be interested in exporting data as a means of backup or to import specific parts of 
one study into another. For these reasons EDMS offers a utility module to export data from the 
current study. The Export dialog is also selected under the Utilities menu heading. The utility 
contains 3 steps which consist of: selecting the items to export by checking the boxes in the tree to 
mark which items in the study are to be exported, naming the export file, and the export report 
window which details the outcome of the export.  
Import 
The import utility is used to read a text file that contains data for importing. It is made up of three 
steps which include: Step 1(Figure 6-9) identifying the file to input, Step 2 (Figure 6-10)selecting 
the sources to input and Step 3 (Figure 6-11) the import report window which details the outcome 
of the import. 

 



 

 6-14

Figure 6-9: Import Step 1    Figure 6-10: Import Step 2 

     

  

Figure 6-11: Import Step 3 

 

 

Format 

The file to be imported should be a semicolon-separated text file with the following format rules: 

1. If the first character of a line is the pound sign, "#", the line is ignored as a comment. 
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2. If the first character of a line is an exclamation point, "!", or bang, EDMS assumes that a 
keyword will immediately follow. 

3. Lines not beginning with "#" or "!" are assumed to be data to be imported (if the last 
keyword was selected for import). 

4. All files to be imported must begin with "!VERSION" followed by the EDMS version on 
the next line (e.g., "5.1.1"). This is the only required keyword for every EDMS import file. 

Step 1 

Specify the file name. Enter the full path name in the box or press the Browse button to specify a 
file to import. Enter a valid path to proceed to the next step. 

Step 2 

Select items to import. Check the boxes in the tree to mark which items in the study are to be 
imported from the text file. Make a valid selection to proceed to the next step. Only selected items 
will be imported into the study.  

Clicking on a "+" or using the right arrow expands a node.  

Clicking on a "-" or using the left arrow collapses a node.  

Clicking Next will initiate the import. 

Step 3 

The report list shows a log of the import progress. Press Finish to exit when finished 

Export 
EDMS allows users to export data from the current study. The export utility contains two steps 
which consist of: naming the export file (Figure 6-12), and Step 2 the export report window which 
details the outcome of the export (Figure 6-13).    

   

Figure 6-12: Export Step 1    Figure 6-13: Export Step 2 
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Step1 

Specify file name. Enter the full path name in the box or press the Browse button to specify a file to 
save to. Enter a valid path to proceed to the next step.  

Clicking Next will initiate the export. 

Step 2 

The report list shows a log of the export progress. Press Finish to exit when finished. 

The exported file can be opened in Microsoft Excel or any text.  

6.2.8 Print 
The Print option is available for the following EDMS windows: View�Airport, View�Emissions 
Inventory, View�Concentrations, and View�System Tables. In the case of the View�Airport 
window, Zoom In, Zoom Out and Zoom Home are additional functions on the View menu. 

With any of the View windows displayed, select File�Print from the pull-down menu. When the 
Print window appears, the user will be able to select the print range, number of copies, and printer 
setup. To print, press OK. To leave this window without printing, press Cancel. 

When printing the Emissions Inventory, the user must first choose to either print all reports or print 
just the selected table. To change the default printer or page setup, select File�Print Setup from 
the pull-down menu. 

6.2.9 Print All Model Inputs 
The ability to Print All Model Inputs is available only when all View windows are closed. 
Selecting File�Print All Model Inputs will enable the user to select the print range, the number of 
copies and the printer setup. To print, press OK. To leave this window without printing, press 
Cancel. 

6.2.10 Print Preview 
The Print Preview option is available from the main menu for the following EDMS windows: 
View�Airport, View�Emissions Inventory, View�System Tables, and View�Concentrations.  

Select File�Print Preview from the pull-down menu. When the preview window appears, the user 
will have a variety of pushbutton viewing options to choose from, including zoom, multi-page 
viewing, and printing. To print the document, press Print. To leave this window without printing, 
press Close. 

6.2.11 Print Setup 
The Print Setup option under the File pull-down menu allows the user to specify a printer other 
than the default printer, and to set other print parameters such as page orientation, paper size and 
source. To specify a non-default printer, use the drop-down list to select the new printer. Use the 
radio buttons to select the paper orientation (portrait or landscape). To change the paper size and 
paper source, use the drop-down list and choose from the list. Additional printer setup features are 
available by pressing the Option button. When the user has completed the print setup operations, 
press OK. To exit the Print Setup window and return to the previously saved setup, press Cancel. 
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6.3 The Emissions Menu 
The Emissions menu provides the user with access to dialog boxes used to specify emission 
sources at the airport. Information about aircraft, parking facilities, roadways, stationary sources, 
and training fires can be entered here. The Emissions menu has the following options: 

• Aircraft  

o Operations Tab 

o Schedule Tab 

o Performance Tab 

o APU Assignment Tab 

o GSE & Gate Assignment Tab 

o Engine Emissions Tab 

• GSE Population 

• Parking Facilities 

• Roadways 

• Stationary Sources 

• Training Fires 

• Update Emissions Inventory 
 

6.3.1 Aircraft Operations & Assignments Window 
The Aircraft Operations & Assignments window (Figure 6-14) allows the user to choose from a list 
of Available Aircraft types and Engine Types to be included in the study. This list includes both 
system aircraft and user-created aircraft. The selected aircraft will be associated to the particular 
scenario-airport combination. Once an aircraft-engine combination has been added and a study year 
selected, the user can specify operations, import a schedule, define performance parameters, assign 
an APU, and provide gate and/or GSE assignments. Viewing the engine emissions per operation 
does not depend on the year. Together, these allow for a high level of precision in specifying 
aircraft-engine and operational configurations for a given airport and year. 

Note: This window is accessible only when an airport or a year is selected from the upper-left pane 
study tree.  
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Figure 6-14: Aircraft Operations & Assignments Window 

 

 

Adding and Removing Aircraft 

To consider aircraft in the study, an aircraft type-engine type combination must be selected. First, 
choose from the list of available aircraft types. To see the list of available engine types for the 
aircraft type, press the “+” to the left of the aircraft type name and icon (or use the right arrow 
key). The engine types listed are those currently utilized with the selected aircraft type. Engine 
names in bold typeface indicate the default engine for the selected aircraft type. The default engine 
for an aircraft type can change, depending on the user-specified Region for Aircraft Default Engine 
on the Airport Properties dialog (Figure 6-6). 

When the desired engine type is highlighted, press the Add button. Alternatively, right-click on the 
engine and select Add from the popup menu that appears. Moreover, right-clicking on an aircraft 
type (not an engine type) that has a default engine and selecting Add automatically adds the aircraft 
with its default engine to the study! Double-clicking on an aircraft will also add the aircraft to the 
study with its default engine. Note, however, that some aircraft do not have any default engines 
defined. In that case, double-clicking will merely open the engine list for the aircraft. 

It is possible to enter the same aircraft-engine combination multiple times in a study so that 
operations of the same aircraft type can be divided among different gates. To distinguish between 
different instances of the same aircraft-engine combination, a unique identification for each 
instance of a combination must be specified. When adding an aircraft-engine combination to a 
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study, the user may rename the instance by providing an identification that is unique for that 
combination of aircraft type and engine type. 

To remove an aircraft type previously added, select the aircraft in the Aircraft/Engine 
Combinations In Study list and press Remove. Alternatively, right-click on an aircraft in the 
Aircraft/Engine Combinations In Study list to bring up a popup menu. The Remove option on the 
popup menu performs the same function. 

Search 

To search for an aircraft, type any part of the aircraft name in the Search textbox. EDMS will 
automatically refresh the list of available aircraft to display only the ones whose names contain the 
text typed in the Search textbox. 

Filtering Aircraft  

Right-clicking with the mouse on the Available Aircraft/Engines tree brings up a popup menu. To 
reduce the number of aircraft type displayed in the list, select Filter by Category from this menu. 
To remove the filter and display all available aircraft types, select Remove Filter from the right-
click popup menu. When all aircraft types are displayed, Remove Filter is disabled. 

Editing User-Created Aircraft 

Right-click on an aircraft type in the Available Aircraft/Engines tree. The Edit option is enabled 
when a user-created aircraft is selected. This option opens the User-Created Aircraft window. 

Renaming the Identification 

To rename the identification of a selected aircraft-engine combination, either press the Rename 
button or double-click the identification. Alternatively, right-click on an aircraft in the in-study list 
to bring up another popup menu. The Rename option on the popup menu performs the same 
function. 

Changing the Assigned Engine 

To change the engine assigned to an aircraft, either double-click the engine name and select a new 
engine that appears in the drop down list or press the Change Eng button. Alternatively, right-click 
on an aircraft in the in-study list to bring up another popup menu. Its Change Engine option 
performs the same function. 

Duplicating an Assigned Aircraft 

To add the exact same aircraft-engine combination again to the study, select the combination to 
copy and press the Duplicate button. More than one aircraft may be selected at a time to duplicate a 
group of aircraft. Alternatively, right-click on an aircraft in the in-study list to bring up another 
popup menu. Its Duplicate option performs the same function. 

Aircraft Categories 

The Category column in the Aircraft/Engine Combinations In Study list shows the four-letter 
category code for each entry. The characters represent, in order, the size, designation, engine type 
and usage of the aircraft/engine combo. 

Size (weight) Small, Large, Heavy 

Designation Civil, Military, General 

Engine Jet, Turboprop, Piston 

Usage Passenger, Cargo/transport, Helicopter, Business, Attack/combat, Other 

 



 

 6-20

The Euro. Cat. column shows the aircraft category codes used in Europe. 

H1 Helicopter Light 

H2 Helicopter Heavy 

JB Jet Business 

JL Jet Large 

JM Jet Medium 

JR Jet Regional 

JS Jet Small 

PP Propeller 

SS Supersonic 

TP Turboprop 

 

6.3.1.1 Operations Tab  
The contents of this tab (Figure 6-14) are only active when a scenario, airport and year are selected. 
Use this tab to assign operations in the selected year to one or more simultaneously selected 
aircraft in the Aircraft/Engine Combinations In Study list. More than one aircraft can be selected 
simultaneously to allow a group of aircraft to be assigned the same operations. 

Use Schedule 

When the Use Schedule checkbox is checked, it means EDMS should use the schedule information 
contained in the file identified on the Schedule tab. Consequently, all other features on the 
Operations tab are disabled, as they are then not needed nor used. If Use Schedule is checked, but 
no schedule file has been selected, then an emissions inventory will show zero emissions for 
aircraft. 

LTOs or Departures & Arrivals 

The user has the option either to Enter LTOs or to Enter Departures & Arrivals Separately. 
Entering departures and arrivals separately will produce a more accurate dispersion analysis if 
there is asymmetry in operation types. 

Under LTOs, the user can choose between Yearly and Peak Quarter-Hour Landing and Takeoff 
(LTO) cycles depending on the available data. 

The emissions inventory relies on the Yearly LTO cycle information. If the number of yearly LTO 
cycles is known, press the Yearly button and enter the value in the adjoining edit box. If yearly 
LTO cycle information is not available, EDMS can derive it based on the peak quarter hour figure 
and the selected operational profiles. 

If the Peak Quarter-Hour LTO cycle value is known, press the Peak Quarter-Hour button and enter 
the value in the adjoining edit box. If peak quarter-hour operations value is not available, EDMS 
can derive it based on the yearly LTO cycles and operational profiles. 

Entering data for departures and arrivals works similarly to how it does for LTOs. 

Touch and Gos (TGOs) 

If Touch and Go (TGO) operations are relevant to the study, enter the value in the Yearly TGOs 
edit box. Taxi, queue and ground support equipment operations are not included for TGO 
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operations. To model the eventually necessary taxi to and from the gate, simply add one LTO cycle 
to the yearly LTOs for each TGO that includes a taxi mode and subtract one TGO from the yearly 
TGOs. 

Operational Profiles 

Operational Profiles can be defined at the Quarter-Hourly, Daily or Monthly levels. These profiles 
are named and defined using the Operational Profiles dialog box under the Utilities menu. The 
"DEFAULT" and all of the user-specified operational profiles appear in the appropriate drop-down 
list for selection. It is important to note that modifications to any one of the quarter-hourly, daily, 
or monthly default settings will affect the operational figures. 

6.3.1.2 Schedule Tab 
To use a schedule file, check the Use Schedule checkbox on the Operations tab (Figure 6-14). In 
addition, to compute ground delays, Sequence Modeling must be selected in Scenario Properties 
(Figure 6-3). 

To browse for a schedule file, press the Browse button on the Schedule tab (Figure 6-18). This will 
popup a file browser titled Select Schedule File for <selected year of study> which will let the user 
browse for a schedule file. After selecting the file and pressing the Open button, the browser closes 
and EDMS automatically performs some validation checks on the selected file. 

First, EDMS looks for dates and times that are not for the selected year. If EDMS finds any such 
out-of-range dates and times, the user is warned by a Schedule dialog (Figure 6-15). 

Figure 6-15: Schedule Dialog 1 

 

 

Pressing Yes forces EDMS to continue validation. Pressing No cancels the operation, and the user 
must browse again for another schedule file. 

Second, EDMS checks the dates and times for chronological order. If EDMS finds any dates and 
times out of chronological order, the user is warned by a Schedule dialog (Figure 6-16). 

Figure 6-16: Schedule Dialog 2 

 

 

Pressing Yes causes EDMS to sort the file which is required preprocessing for EDMS to use a 
schedule file. Pressing No cancels the operation, and the user must start over. 
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Finally, EDMS looks for aircraft-engine-identification combinations that are not in the currently 
selected scenario and airport. If EDMS finds new aircraft to add, the user is prompted by a 
Schedule dialog (Figure 6-17). 

Figure 6-17: Schedule Dialog 3 

 

 

To add all the aircraft-engine-identification combinations in a schedule file to the selected 
scenario-airport combination, select Yes on the Schedule dialog. Each aircraft-engine-identification 
combination will be added once, if it is not already in the study. In either case, the contents of the 
schedule file will then become available for viewing. Since a schedule file can be extremely large, 
EDMS loads only portions of the large file into memory at any time. To simply view the contents 
of the schedule file, select No and later uncheck Use Schedule on the Operations tab. 

Figure 6-18: Schedule Tab 
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The schedule file contains the following fields: Aircraft Type, Engine Type, Identification, Call 
Sign, Airline, Date & Time, Stage Length (nm), Operation Type, Gate, Runway, and Weight (lbs). 
Please see table below for more details on the fields of the schedule file: 

 

Description Units Notes 

Aircraft Type  Required 

Engine Type  Required 

Identification  Required 

Call Sign  Optional 

Airline  Optional 

Date & Time  Required.Format: "YYYY-MM-DD hh:mm:ss" 

Stage Length Nm Optional – helps in determining weight of the aircraft if it is not supplied. 

Operation type  Required. Can be arrival (A), departure (D) or TGO (T) 

Gate  Optional – if not provided, the Gate Assignment (Section 6.3.1.5) is used. 

Runway  Optional – if not provided, the configurations will apply. 

Weight Lbs Optional – initial aircraft weight while conducting the operation. 

 

The fields in the file are separated by semicolons, with one operation per line. As an example, a 
line in the schedule file would be similar to this: 

B737-7-BBJ;3CM033;Commercial;AAL002;American Airlines;2004-01-01 
00:11:53;855;A;Main;9;46219 

The field Aircraft Type refers to the aircraft code (ACCODE). To view all available aircraft codes, 
use the View System Tables window (Section 6.6.6) and select Aircraft from the table drop-down 
menu. The field Engine Type refers to the engine UID. To view all available engine UIDs, use the 
View System Tables window (Section 6.6.6) and select Aircraft Engines Emissions Data from the 
table drop-down menu.  

NOTE:  Not all aircraft-engines combinations are valid. Please look at the Aircraft-
Engines combinations table under the View System Tables window (Section 6.6.6) 
for all valid combinations. Entries with invalid aircraft-engine combinations will 
be skipped. 

The identification field, along with the Aircraft Type and Engine Type is used to distinguish 
between aircraft, and is therefore required. When displaying emissions, EDMS will group the 
operations per Aircraft Type-Engine Type-Identification.  

The Call Sign and Airline fields are optional. They are used only for user reference, and are not 
displayed anywhere else within EDMS. 

The Date & Time field provides the time when an instance of a study aircraft enters the system. 
This is the push-back time for departures or the estimated touch-down time for arrivals. The user is 
required to specify time in the format: “YYYY-MM-DD hh:mm:ss”.  

NOTE:  The records in the schedule must be ordered chronologically. All records which 
are not ordered chronologically will be skipped. 
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The Stage Length field is used to determine (along with the Operation type field) the aircraft’s 
weight (if it is not provided) based on INM definitions. 

The Operation Type field takes the value of D, A or T, for departure, arrival or touch-and-go, 
respectively. 

The Gate and Runway fields are used for assigning a gate and a runway to an aircraft. Gates and 
runways are required for dispersion analyses. If a gate is not provided in the schedule, then the 
Gate Assignment (Section 6.3.1.5) of that aircraft is used. When a runway is not provided in the 
schedule, then the airport Configurations (Section 6.4.7) apply. 

Finally, the Weight of the aircraft must be defined. If both the Stage Length and Weight fields are 
supplied, Weight takes precedence. If neither of the two fields are defined, EDMS uses the aircraft 
default weight. 

The schedule also provides a quick way to add aircraft-engine-identification combinations based on 
historical information to a study for year for which a schedule is not available. Check Use 
Schedule; browse for the schedule file; add the aircraft; then uncheck Use Schedule. The General 
Conformity Rule simply displays the threshold level for Non-Attainment Areas (NAAs), and the 
threshold level for Maintenance Areas (MAs). 

Note: Notes and problems that occur during the processing of the schedule are saved in a file 
named “RUN_LOG_EMIS.txt” located in the EDMS directory, and are denoted by an “SC” value 
in the column next to the date and time. 

6.3.1.3 Performance Tab 
Through this tab (Figure 6-19) the user can assign flight profiles and average taxi times to one or 
more simultaneously selected aircraft. More than one aircraft can be selected simultaneously to 
allow a group of aircraft to be assigned the same flight profile and taxi time.  
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Figure 6-19: Performance Tab 

 

 

The taxi times can only be specified, when User-specified taxi times for each aircraft is selected as 
the taxi time modeling option on the Scenario Properties dialog (Figure 6-4). Since dispersion 
requires the use of sequence modeling for taxi times, user-edited taxi times can only be used for 
emissions inventories. 

The other four Times in Mode fields can either be Performance Based (SAE AIR 1845) or 
ICAO/USEPA Defaults depending on which option is selected under System Aircraft Times in 
Mode Basis (for Emissions Inventories) on the Scenario Properties dialog. When dispersion is 
enabled, only the performance-based method can be selected. 

Flight Profile 

Flight profiles based on the performance of the aircraft-engine combination are used to determine 
times in mode. 

Flight profiles are based on SAE AIR 1845. The user must select a takeoff weight and an approach 
weight for the aircraft, and an approach angle to be flown. The approach weight is the weight at 
10,000 feet as the aircraft makes its approach. Based on these three parameters and the mixing 
height specified in the Weather window, the Takeoff, Climb Out, Approach, and Landing Roll 
times are calculated by the performance module. Whenever the weights or approach angle are 
changed, the performance-based times-in-mode are recalculated and shown in the Times in Mode 
box. These times-in-mode are based on the annual average weather and are provided for user 
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information. A more detailed internal model of the flight profile is used to determine positions for 
dispersion calculations.  

Note: The displayed takeoff weight may not correctly correspond to the selected aircraft. This is 
especially true for lighter aircraft. Several aircraft share the same set of flight profiles, and 
therefore share the same set of takeoff weights.  

User-created aircraft times in mode can be based on a selected flight profile or the ICAO default 
times in mode based on the selected category. They may also be user-edited. However, as with all 
aircraft added to a study, user-edited taxi times can only be used for emissions inventories. 

Times in Mode 

When User-specified taxi times for each aircraft is selected as the taxi time modeling option on the 
Scenario Properties dialog (Figure 6-4), the user is expected to enter taxi times for each aircraft in 
the Taxi In and Taxi Out boxes. If sequence modeling is used, then the values in the Taxi In and 
Taxi Out boxes are ignored, and EDMS will dynamically determine the taxi in and out times based 
on the delays encountered, the taxipaths, and taxiway network. 

The other times-in-mode values are displayed to provide an estimate only, and are based on the 
airport's annual average weather. These values vary with the mixing height, regardless of which 
System Aircraft Times in Mode Basis is chosen. The actual times for arrival, takeoff, and climbout 
are determined when updating emissions, using user-provided actual weather, and therefore may 
differ from the estimated values displayed on this dialog. 

If Performance Based (SAE AIR 1845) modeling is selected, then the times in mode also change 
with changes to the weights and glide slope on this tab. The emissions inventory relies on these 
times and the Taxi In and Taxi Out times in its generation. User-created aircraft, when used in a 
scenario where performance-based modeling is selected, must have an appropriate flight profile 
assigned in the User-Created Aircraft dialog, in addition to the weights and approach angle to be 
followed. 

If dispersion is enabled, then the ICAO/USEPA Defaults option in the Scenario Properties is not 
available. Only performance-based times in mode will then be used in computing the emissions 
inventory. 

6.3.1.4 APU Assignment Tab 
Through this tab (Figure 6-20: ) the user can assign an auxiliary power unit (APU) for each 
aircraft. If the aircraft has a default APU, it is shown in bold in the drop down list of APUs. To 
change the APU assigned to the aircraft, simply select a different one from the drop down list. 
Only one APU may be assigned to each aircraft. Select None in the APU drop down menu if you do 
not want to assign an APU to an aircraft. 

The user can specify the number of minutes the APU will operate for both arrivals and departures. 
The defaults values are 13 minutes each.  
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Figure 6-20: APU Assignment Tab 

 

6.3.1.5 GSE & Gate Assignment Tab 
Through this tab (Figure 6-21) the user can assign ground support equipment (GSE) to one or more 
aircraft. More than one aircraft can be selected simultaneously to allow a group of aircraft to be 
assigned the same set of GSE. 

Gate Assignment 

This option is required only when performing a dispersion analysis. The dispersion of GSE and 
APUs takes place at the assigned gate. Only one gate may be assigned to each aircraft. To assign 
no gate, select None from the Gate Assignment drop-down menu. Note that if no gate is assigned, 
then neither the assigned APU nor any of the assigned GSE will contribute to the dispersion 
analysis. 

Assigning GSE 

The assigned GSE for the selected aircraft are indicated by a checked box (versus an empty box). 
The GSE assigned to the selected aircraft can be changed by checking and/or un-checking these 
check boxes. 

GSE emissions data are utilized in EDMS emissions and dispersion analyses. For emissions 
inventory purposes, default equipment assignments are made based on aircraft type with an 
operating time associated with each aircraft operation. For dispersion analyses, gate emissions are 
treated either as volume or area sources, depending on the user-specified gate dimensions. 
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Figure 6-21: GSE & Gate Assignment 

 

Editing GSE 

The default operating times (mins/operation type), horsepower (hp) and load factor (LF (%)) are 
provided for each piece of equipment. These values can be overridden by double clicking on the 
value to be edited and entering a new value. Alternatively, right-click on a GSE and select the Edit 
option to begin editing values. 

The year manufactured and age can also be edited in the same manner described. Editing one 
automatically updates the other, based on the study year being modeled. By default, both fields 
indicate Def. Avg which stands for default average. Neither field is applicable to user-created GSE, 
in which case both fields are blank. 

The default average year of manufacture and age will cause GSE to be modeled with national 
average GSE emission factors. 

If a specific year of manufacture or age is given for a GSE, NONROAD2005 emission factors will 
be applied. In which case, the fuel, the horsepower and the year of manufacture determine the zero-
hour emission factor and the age and GSE type determine the deterioration to be applied. 

To restore the age or year of manufacture to their default value, blank out either value while editing 
or enter an invalid value. 
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Display Emission Factors 

Right-click on a GSE to bring up its popup menu and select Emission Factors to display its 
emission factors (in grams per horsepower-hour). 

Reset Year / Age 

Right-click on a GSE to bring up its popup menu and select Reset Year / Age to restore the age and 
year of manufacture to their default values. 

Restore Default GSE Assignments 

Check the bold Use Default GSE Assignments check box to undo all user-editing to the GSE 
assignments and restore the original default assignments. 

Reference Models 

Reference models are typical models of GSE of the expanded type and fuel in use today. For 
example, for the type Cargo Loader and Diesel fuel there are two reference models: FMC 
Commander 15 and FMC Commander 30. Each reference model has a unique default horsepower. 
The FMC Commander 15 has a default horsepower of 80. The FMC Commander 30 has a default 
horsepower of 133. If the reference model (Ref. Model) field is blank, the GSE is a unique type-
fuel combination. For example, the "Aircraft Tractor" type and "Gasoline" fuel combination is 
unique. 

User Created GSE 

To Create a User-Created GSE Right-click on the checklist and select the Add New option. For 
more information on creating GSEs refer to (Section 6.7.3). 

6.3.1.6 Engine Emissions Tab 
The Engine Emissions Tab (Figure 6-22) allows the user to view engine fuel flow rates and 
emission indices for a selected aircraft. This provides a quick way for the user to check the values 
that are being used. The user is not able to modify these values. 

Fuel Sulfur Content and SOx Emission Index 

The Fuel Sulfur Content is the percentage by weight of sulfur in the fuel. It is tied to the SOx 
Emission Index by the assumption that all sulfur is converted to SO2 and to sulfate. The SOx 
emissions index is automatically updated whenever either of the fuel sulfur content or the sulfur-to-
sulfate conversion ratio (Figure 6-4) are modified. 

For U.S. airports (specifically, those airports whose country code is “US”), Fuel Sulfur Content 
and SOx Emission Index cannot be edited because the EPA-approved FOA 3.0A methodology 
mandates using a conservative fuel sulfur content of 0.068% for PM emissions modeling at all U.S. 
airports, which results to a Fuel Sulfur Content of 1.292 g/Kg. 
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Figure 6-22: Engine Emissions 

 

6.3.2 GSE Population  
The GSE Population dialog (Figure 6-23) allows the user to choose from a list of available GSE 
types to be included in the scenario-airport combination. This list includes both system and user-
created GSE. Once added, the user can specify the airport population, operating time and profiles, 
fuel used, power rating, load factor and gate assignments. Together, these fields allow for a high 
level of precision in specifying a GSE population for a given airport.  
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Figure 6-23: GSE Population 

 

Adding GSE 

To add a GSE population to a scenario-airport combination, a GSE type with an associated 
reference model and then a fuel must be selected from the Available tree. The tree is first divided 
by GSE types, each type being listed once for each reference model, which is shown after the GSE 
type in parentheses. Under each type the available fuels are listed. 

There are twenty-four (24) GSE types to choose from as listed below: 

• Air Conditioner 

• Air Start 

• Aircraft Tractor 

• Baggage Tractor 

• Belt Loader 

• Bobtail 

• Cabin Service Truck 

• Cargo Loader 

• Cargo Tractor 

• Cart 

• Catering Truck 

• Deicer 

• Fork Lift 

• Fuel Truck 

• Generator 

• Ground Power Unit 

• Hydrant Truck 

• Lavatory Truck 

• Lift 

• Other 

• Passenger Stand 

• Service Truck 

• Sweeper 

• Water Service 
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There are up to five (5) different fuels to choose from as listed below: 

• Diesel 

• Gasoline 

• CNG 

• LPG 

• Electric 
 

Reference Models 

Reference models are typical models of the GSE types in use today. For example, the GSE type 
Cargo Loader has two reference models: FMC Commander 15 and FMC Commander 30. The 
distinguishing feature between listed reference models is default horsepower and possibly default 
annual usage. Each reference model has a unique default horsepower. The FMC Commander 15 
has a default horsepower of 80. The FMC Commander 30 has a default horsepower of 133. 

Expand the node of the desired type to see the list of available fuels by pressing the + to the left 
(or use the right arrow key).  

Identification 

It is possible to enter the same GSE type more than once in a scenario-airport combination so that 
activity of the same type can be divided among different gates. To distinguish between different 
instances of the same GSE type, a unique identification for each instance of a type must be 
specified. When adding a GSE to a scenario-airport combination, the user must either accept the 
EDMS-generated identification, which is numerically based, or provide an alternative 
identification. 

Removing GSE 

To remove a previously added GSE, select the GSE in the In Study list and press Remove. 
Alternatively, right-click on a GSE in the In Study list to bring up its popup menu. The Remove 
option in the popup menu performs the same function. 

Renaming the Identification 

To rename the Identification for a GSE, press the Rename button or double-click on the 
Identification in the list. Alternatively, right-click on a GSE in the In Study list to bring up its 
popup menu. The Rename option in the popup menu performs the same function. 

Duplicating a GSE 

To add the exact same GSE again to the scenario-airport combination, select the GSE to copy 
and press the Duplicate button. More than one GSE may be selected at a time to duplicate a 
group of GSE. Alternatively, right-click on a GSE in the In Study list to bring up its popup menu. 
The Duplicate option in the popup menu performs the same function. 

Changing Fuels 

Right-click on a GSE in the In Study list to bring up its popup menu. More than one GSE may be 
selected at a time to change the fuel for a group of GSE. Select a fuel under the Change Fuel to 
sub-menu on the popup menu to change fuel. If the selected fuel is not available for a type of 
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selected GSE, EDMS will take no action on the particular GSE for which the fuel is not 
available, but a warning will be provided to the user. 

Display Emission Factors 

Right-click on a GSE in the In Study list to bring up its popup menu and select Emission Factors 
to display its emission factors (in grams per horsepower-hour). 

Population 

For population, enter the number of the selected GSE that are present at the airport. However, the 
average piece of equipment realistically does not run continuously, so the user should specify an 
operating time and operational profiles. 

Operating Time 

If the average annual usage of each piece of equipment is known, select Yearly and enter in the 
number hours of annual use. Otherwise, if the number of minutes an average piece of equipment 
is used during an hour of peak activity is known, select Peak Quarter Hour and enter the number 
of minutes per peak quarter hour. 

Operational Profiles 

Operational Profiles can be defined at the Quarter-hourly, Daily, or Monthly levels. These 
profiles are named and defined using the Operational Profiles dialog box under the Utilities 
menu (Section 6.7.1). The "DEFAULT" and all of the user-specified operational profiles appear 
in the appropriate drop-down list for selection. It is important to note that modifications to any 
one of the quarter-hourly, daily, or monthly default settings will affect the operational figures. 

Emission Parameters 

Rated Power &  Load Factor 

Enter the Rated Power in horsepower and the Load Factor as value between 0% and 100% in 
their respective edit boxes. Rated Power and Load Factor are multipliers for the emission 
factors. GSE emission factors are in units of grams-per-hour-per-horsepower. When the rated 
power and load factor are multiplied by the emission factors, the results are quantities of grams-
per-hour. Multiplying this by the population gets grams-per-hour of the entire population, if 
every piece of equipment in the population was running simultaneously and continuously over an 
entire hour. 

Use default age distribution vs. Specify a specific age  

Selecting Use default age distribution will cause GSE to be modeled with same national average 
GSE emission factors that were developed by the U.S. EPA from NONROAD2005. 

If Specify a specific age is selected, the NONROAD2005 emission factors will be applied. In 
which case, the fuel, the horsepower and the year of manufacture determine the zero-hour 
emission factor and the age and GSE type determine the deterioration to be applied. 

Analysis Year 

This field is for user-reference only and cannot be edited, except by returning to the study 
properties window. This is the year of activity being modeled in the EDMS scenario-airport 
combination. 
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Year of Manufacture & Age 

If Specify a specific age is selected, the user may edit the year of manufacture for the GSE 
population or the age. Editing one value automatically adjusts the other according to the study 
year. New equipment is modeled as being of age "0" years. The year of manufacture cannot be 
later than the study year, nor can the GSE be more than 100 years old. 

When Use System Emission Factors is selected, neither parameter is needed because the default 
system emission factors are based on a national population of average age. 

Gate Assignment 

All gates in the study appear in the gate assignment list. Double-click on the Percentage to 
specify what percentage of the population operates at the assigned gate. 

6.3.3 Parking Facilities 
The Parking Facilities window (Figure 6-24) allows the user to specify the parking facility 
information relevant to the scenario-airport combination. Parking facility data are used by EDMS 
in both emissions and dispersion analyses. For emissions purposes, calculations are based upon 
the Number of Vehicles in each facility, as well as the average Speed, Idle Time and Distance 
Traveled by each vehicle within the facility. For dispersion analyses, parking facility emissions 
are treated as area sources by EDMS. Parking facility emissions are located spatially within the 
airport using (x, y) coordinates. A polygon of up to 20 sides can be used to define the shape of 
the parking facility. Facilities with multiple parking levels are modeled using stacked area 
sources. 

Figure 6-24: Parking Facilities 
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Adding Parking Facility Information 

To add a parking facility, press the Add New button and enter a name for the new parking 
facility. Once added, parking facilities can remain in the current scenario-airport combination, or 
be moved to a list of Available facilities with the Remove button. To move a parking facility from 
the Available list to the In Study list, select the parking facility name and press Add. To 
permanently delete a parking facility from the Available list, select it and press Delete. To 
rename a parking facility, select it and press Rename. 

Double-clicking on a parking facility in the Available list will move it to the In Study list. 
Double-clicking on a parking facility in the In Study list allows the name of the parking facility to 
be edited. Right-clicking on a parking facility in either the Available or In Study list both selects 
that parking facility and pops up a menu that matches the buttons between the two lists, except 
that it has the additional option of Select All. 

Number of Vehicles 

The number of vehicles can be entered by the Yearly volume or by Peak Quarter Hour. If the 
number of vehicles per year is known, select the Yearly radio button and enter the value in the 
adjoining edit box. If the number of vehicles per peak quarter hour is known, select the Peak Qtr-
Hour radio button and enter the value in the adjoining edit box.  

Vehicle Emission Parameters 

Total emissions are a function of Speed, Idle Time, and Distance Traveled (as well as altitude, 
temperature, scenario year). Emissions are also a function of vehicle type or vehicle fleet mix, 
Fuel and Manufactured Year. 
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Vehicle Type  

Use the first drop down list to select either Default Fleet Mix or one of 16 vehicle types as listed 
below:  

• Light Duty Vehicles (Passenger Cars) 

• Light Duty Trucks 1 (0-6,000 lbs. GVWR, 0-3750 lbs. LVW) 

• Light Duty Trucks 2 (0-6,000 lbs. GVWR, 3751-5750 lbs. LVW) 

• Light Duty Trucks 3 (6,001-8500 lbs. GVWR, 0-3750 lbs. LVW) 

• Light Duty Trucks 4 (6,001-8500 lbs. GVWR, 3751-5750 lbs. LVW) 

• Class 2b Heavy Duty Vehicles (8501-10,000 lbs. GVWR) 

• Class 3 Heavy Duty Vehicles (10,001-14,000 lbs. GVWR) 

• Class 4 Heavy Duty Vehicles (14,001-16,000 lbs. GVWR) 

• Class 5 Heavy Duty Vehicles (16,001-19,500 lbs. GVWR) 

• Class 6 Heavy Duty Vehicles (19,501-26,000 lbs. GVWR) 

• Class 7 Heavy Duty Vehicles (26,001-33,000 lbs. GVWR) 

• Class 8a Heavy Duty Vehicles (33,001-60,000 lbs. GVWR) 

• Class 8b Heavy Duty Vehicles (>60,000 lbs. GVWR) 

• School Busses 

• Transit and Urban Busses 

• Motorcycles 

 

Fuel 

Select a fuel from the Fuel drop down list. EDMS will assume all vehicles using the selected 
parking facility only burn the selected fuel. This list is deactivated when Default Fleet Mix or 
Motorcycles has been selected. 

Manufactured Year 

The manufactured year cannot be later than the scenario year, nor can it be more than 100 years 
prior. EDMS will assume all vehicles in the parking facility to be manufactured in the same year. 
To model new vehicles, enter the scenario year as the manufactured year. This edit box is 
deactivated when a default vehicle fleet mix has been selected. 

Speed 

Specify the average speed for vehicles traveling in the parking facility by selecting from the 
Speed drop down list. 

Distance Traveled 

Specify the average distance a vehicle would be expected to travel in the facility. 

Idle Time 

Specify the average vehicle idle time in minutes. 
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Emission Factors (grams per vehicle) 

Use System Generated Values 

The system generated values can be restored by checking this checkbox. However, this will not 
happen until the Apply button is pressed, which will cause MOBILE 6.2 to run, and then the 
Emissions Factors will be updated. 

Emission Factors 

If the user edits a parameter in the window that affects the emission factors and Use System 
Generated Values is checked, EDMS automatically updates the emission factors by running 
MOBILE 6.2 and extracting and displaying the new values after the Apply button is pressed. 
MOBILE 6.2 does not produce results for years beyond 2025, so any modeling for later years 
will be adjusted back to 2025 before calculating emissions. 

The user may override the emissions factors for any parking facility by editing the values in the 
Emission Factors box. This will cause the Use System Generated Values checkbox to become 
unchecked, denoting to the user that the values have been edited. This allows the user to set more 
specific information for vehicle emissions characteristics rather than use the MOBILE 6.2 
generated values.  

Note: The speciated organic gas emission factor boxes, are available only when the Enable 
Speciated Organic Gas (OG) Emissions checkbox is enabled in the Study Properties window 
(Figure 6-2). 

Operational Profiles 

Operational Profiles can be defined at the Quarter-hourly, Daily, or Monthly levels. These 
profiles are named and defined using the Operational Profiles dialog box under the Utilities 
menu (Section 6.7.1). The "DEFAULT" and all of the user-specified operational profiles appear 
in the appropriate drop-down list for selection. It is important to note that modifications to any 
one of the quarter-hourly, daily, or monthly default settings will affect the operational figures. 

Dispersion Parameters 

Performing a dispersion analysis requires the analyst to specify the dimensions of the parking 
facility. 

First, select the Number of Points from the drop down list. Then, type in the (x, y) coordinates 
for each of the parking facility points as well as the parking facility release height. The (x, y) 
coordinates are used to specify a polygon of up to 20 sides and can be edited by double-clicking 
on a value. The coordinates must be entered in either clockwise or counter clockwise order. A 
Preview of the parking facility is provided to the right of the coordinates. The initial vertical 
dispersion parameter, sigma-z0, is hard-coded as 3 meters. 

Number of Levels 

Enter an integer from 1 to 20, inclusive. This represents the number of parking levels, and 
therefore the number of area sources, to be vertically stacked one on top of the other. 

Release Height / Top Release Height 

If there is only one parking level, Release Height will appear. When there is more than 1 level, 
Top Release Height will appear and the value entered will represent the highest height at which 
emissions will be released (e.g. from the exhaust of a vehicle) relative to the parking facility's 
elevation. 
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Level Spacing 

EDMS models multi-level parking facilities with polygons spaced vertically at regular intervals. 
EDMS starts at the release height of the top level and works its way down, placing one polygon 
at each level spacing. Level spacing is inactive for single-level parking facilities. 

Elevation 

Elevation is the ground-level elevation of the parking facility relative to sea-level. The default 
value for parking facility elevation is the airport elevation. 

Number of Points 

From the drop-down list, the user may choose from 3 to 20 points. 

Nudge 

These arrow controls can be used to nudge the selected points in the desired direction, or the 
entire facility as a whole if all or none of the points are selected. 

Graphical Display 

Parking facilities that are listed in the In Study list are displayed in the Airport View (Section 
6.6.3). Parking facilities in the Available list are not displayed because they are not currently in 
the study. 

The Preview box allows the user to view the shape of the facility before saving changes. 

6.3.4 Roadways 

The Roadways window (Figure 6-25) allows the user to specify the roadway information relevant 
to the scenario-airport combination. Roadway data is used by EDMS in both emissions and 
dispersion analyses. For emissions purposes, calculations are based upon the Traffic Volume, as 
well as the Average Speed and Roadway Length. For dispersion analyses, roadway emissions are 
treated as a series of rectangular area sources. Roadway emissions sources are located spatially 
within the airport using the (x, y) coordinates. 
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Figure 6-25: Roadways 

  
 

Adding Roadway Information 

To add a roadway, press the Add New button and enter a name for the new roadway. Once added, 
roadways can remain in the current study, or be moved to a list of Available roadways with the 
Remove button. To move a roadway from the Available list to the In Study list, select the 
roadway name and press Add. To permanently delete a roadway from the Available list, select it 
and press Delete. To rename a roadway, select it and press Rename. 

Double-clicking on a roadway in the Available list will move it to the In Study list. Double-
clicking on a roadway in the In Study list allows the name of the roadway to be edited. Right-
clicking on a roadway in either the Available or In Study list both selects that roadway and pops 
up a menu that matches the buttons between the two lists, except that it has the additional option 
of Select All. 

Traffic Volume 

Traffic Volume is a count of the number of times a vehicle has traversed the roadway. So, in 
order to model one vehicle driving to the terminal to drop a passenger and then returning on the 
same road, the traffic volume on that roadway would be two. 

The traffic volume can be entered by the Yearly volume or by Peak Quarter Hour. If the traffic 
volume for the year is known, select the Yearly radio button and enter the value in the adjoining 
edit box. If the number of vehicles per peak quarter hour is known, select the Peak Qtr-Hour 
radio button and enter the value in the adjoining edit box. 
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Vehicle Emission Parameters 

Total emissions are a function of Speed, Idle Time, and Distance Traveled (as well as altitude, 
temperature, scenario year). Emissions are also a function of vehicle type or vehicle fleet mix, 
Fuel and Manufactured Year. 

Vehicle Type  

Use the first drop down list to select either "Default Fleet Mix" or one of 16 vehicle types as 
listed below:  

• Light Duty Vehicles (Passenger Cars) 

• Light Duty Trucks 1 (0-6,000 lbs. GVWR, 0-3750 lbs. LVW) 

• Light Duty Trucks 2 (0-6,000 lbs. GVWR, 3751-5750 lbs. LVW) 

• Light Duty Trucks 3 (6,001-8500 lbs. GVWR, 0-3750 lbs. LVW) 

• Light Duty Trucks 4 (6,001-8500 lbs. GVWR, 3751-5750 lbs. LVW) 

• Class 2b Heavy Duty Vehicles (8501-10,000 lbs. GVWR) 

• Class 3 Heavy Duty Vehicles (10,001-14,000 lbs. GVWR) 

• Class 4 Heavy Duty Vehicles (14,001-16,000 lbs. GVWR) 

• Class 5 Heavy Duty Vehicles (16,001-19,500 lbs. GVWR) 

• Class 6 Heavy Duty Vehicles (19,501-26,000 lbs. GVWR) 

• Class 7 Heavy Duty Vehicles (26,001-33,000 lbs. GVWR) 

• Class 8a Heavy Duty Vehicles (33,001-60,000 lbs. GVWR) 

• Class 8b Heavy Duty Vehicles (>60,000 lbs. GVWR) 

• School Busses 

• Transit and Urban Busses 

• Motorcycles 

Fuel 

Select a fuel from the Fuel drop down list. EDMS will assume all vehicles using the selected 
parking facility only burn the selected fuel. This list is deactivated when Default Fleet Mix or 
Motorcycles has been selected. 

Manufactured Year 

The manufactured year cannot be later than the scenario year, nor can it be more than 100 years 
prior. EDMS will assume all vehicles in the parking facility to be manufactured in the same year. 
To model new vehicles, enter the scenario year as the manufactured year. This edit box is 
deactivated when a default vehicle fleet mix has been selected. 

Speed 

Specify the average speed for vehicles traveling in the parking facility by selecting from the 
Speed drop down list. 
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Roadway Length 

If not performing a dispersion analysis, specify the total length (in statute miles, regardless of the 
units set on the Study Properties window (Figure 6-2) of the selected roadway. 

For dispersion analyses, this edit box becomes read-only, and Roadway Length will be 
automatically computed as the length of the roadway as determined by the specified coordinates. 

Emission Factors (grams per vehicle) 

Use System Generated Values 

Selecting the Use System Generated Values checkbox allows the user to restore the system-
generated values. However, this will not happen until the Apply button is pressed, which will 
cause MOBILE 6.2 to run, and then the Emissions Factors will be updated. 

Emission Factors 

If the user edits a parameter in the window that affects the emission factors and Use System 
Generated Values is checked, EDMS automatically updates the emission factors by running 
MOBILE 6.2 and extracting and displaying the new values after the Apply button is pressed. 
MOBILE 6.2 does not produce results for years beyond 2025, so any modeling for later years 
will be adjusted back to 2025 before calculating emissions. 

The user may override the emissions factors for any parking facility by editing the values in the 
Emission Factors box. This will cause the Use System Generated Values checkbox to become 
unchecked, denoting to the user that the values have been edited. This allows the user to set more 
specific information for vehicle emissions characteristics rather than use the MOBILE 6.2 
generated values.  

Note: The speciated organic gas emission factor boxes, are available only when the Enable 
Speciated Organic Gas (OG) Emissions checkbox is enabled in the Study Properties window 
(Figure 6-2). 

Operational Profiles 

Operational Profiles can be defined at the Quarter-hourly, Daily, or Monthly levels. These 
profiles are named and defined using the Operational Profiles dialog box under the Utilities 
menu (Section 6.7.1). The DEFAULT and all of the user-specified operational profiles appear in 
the appropriate drop-down list for selection. It is important to note that modifications to any one 
of the quarter-hourly, daily, or monthly default settings will affect the operational figures. 

Coordinates 

This box and its controls are only available for dispersion analyses. Performing a dispersion 
analysis requires the user to specify (x, y) coordinates with associated elevations, Width and 
release Height. The roadway coordinates locate the roadway spatially in the airport configuration 
and provide information on roadway dimensions. 

The default width is 20 meters. The initial vertical dispersion parameter, sigma-z0, is hard-coded 
as 3 meters. 

Width 

Width determines both the thickness of the roadway's segments when they are displayed on the 
airport view screen and the width of the area sources used to model dispersion of the roadway. 
The default value is 20 meters (65.62 feet). 
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Number of Points 

A roadway is defined as a series of connected line segments, which are identified by their 
endpoints. The default for a new roadway is two endpoints, which is one segment. From the 
drop-down list, the user may choose from 2 to 20 points (1 to 19 segments). For dispersion a 
roadway will be modeled by area sources derived from the segments and the Width. The number 
of points in the coordinate list changes immediately when Number of Points is changed. If 
Number of Points is reduced, the values in the excess coordinates are lost. If Number of Points is 
increased, the default values for the new points are the values in the last pre-existing point. 

Height 

Height is the distance above the ground elevation at which emissions are released. 

List of Coordinates 

All coordinates in all menus must be relative to the same origin point (0, 0). It is best to establish 
the origin point via the Airport View before beginning to create the features at the airport. 

The number of points in the list is changed to match Number of Points whenever that is changed. 
If Number of Points is decreased, the values in the excess points are lost. When new points are 
added their X, Y and Elevation (relative to sea-level) default to the last values currently in the 
list. To edit a value in the list double-click on the field, then type in the desired value. The X and 
Y coordinates can also be changed with the Nudge buttons. 

Nudge 

These arrow controls can be used to nudge the selected points in the desired direction or the 
entire roadway as a whole if all or none of the points are selected.  

Graphical Display 

Roadways that are listed in the In Study list are displayed in the Airport View (Section 
6.6.3). Roadways in the Available list are not displayed because they are not currently in the 
study. 

The Preview box allows the user to view the shape of the facility before saving changes. 

6.3.5 Stationary Sources 
The Stationary Sources window (Figure 6-26) allows the user to specify the stationary source 
information relevant to the scenario-airport combination. Stationary source data is used by 
EDMS in both emissions and dispersion analyses. For emissions purposes, calculations are based 
upon the amount of material used or consumed, as well as several other parameters described 
below. For dispersion analyses, stationary source emissions are treated as a series of rectangular 
area sources. Stationary source emissions sources are located spatially within the airport using 
the (x, y) coordinates.  
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Figure 6-26: Stationary Sources 

 
 

Adding Stationary Source Information 

To add a training fire, press the Add New button and enter a name for the new fire in the Name 
edit box. Once added, stationary sources can remain as part of the current scenario-airport 
combination, or be moved to a list of Available stationary sources with the Remove button. To 
move a stationary source from the Available list to the In Study list, select the fire name and press 
Add. To permanently delete a stationary source from the Available list, select it and press Delete. 

Double-clicking on a stationary source in the Available list will move it to the In Study list. 
Double-clicking on a stationary source in the In Study list allows the name of the stationary 
source to be edited. Right-clicking on a stationary source in either the Available or In Study list 
both selects that stationary source and pops up a menu that matches the buttons between the two 
lists, except that it has the additional option of Select All. 

Category 

Category refers to the category of stationary source. The default category of a new stationary 
source is Boiler/Space Heater. This should be changed to a category that reflects the source 
being modeled. For unspecified source types, choose Other. There are ten (10) categories to 
choose from as listed below: 
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• Other 

• Boiler/Space Heater 

• Emergency Generator 

• Incinerator 

• Aircraft Engine Testing 

• Fuel Tank 

• Surface Coating/Painting 

• Deicing Area 

• Solvent Degreaser 

• Sand/Salt Pile 

 

Type 

Type refers to the particular stationary source type within a given category. Each category has a 
different set of types to choose from. The selected type will determine the default emission 
parameters and their default values. This should be set to a type that best reflects the source being 
modeled. If the Other category is chosen, the Type field becomes inactive, and the Units of 
Measure drop down list becomes active. 

Operational Profiles 

Operational Profiles can be defined at the Quarter-hourly, Daily, or Monthly levels. These profiles 
are named and defined using the Operational Profiles dialog box under the Utilities menu (Section 
6.7.1). The "DEFAULT" and all of the user-specified operational profiles appear in the appropriate 
drop-down list for selection. It is important to note that modifications to any one of the quarter-
hourly, daily, or monthly default settings will affect the operational figures. 

Units of Measure 

When the "Other" category is selected, choose from one of the following units. 

• Metric Tons -- for emissions based on the consumption of a solid fuel, e.g. coal 

• Kiloliters -- for emissions based on the consumption of a liquid 

• Thousands of Cubic Meters -- for emissions based on the consumption of a gas 

• Hours -- for time-based emissions 

• Test Cycles -- for event-based emissions, e.g. aircraft engine testing 

 

The selection here updates the above described units Used box with the appropriate text. This 
allows the user to specify a quantity that is appropriate for the source being modeled. 

Emission Parameters 

Edit a value in the list by double clicking on it. Checking the Use Default Values for Critical 
Emission Parameter checkbox restores all of the emission parameters in the list below to their 
original default values. However, some parameters are meant to be edited by the user (e.g., fuel 



 

 6-45

tank dimensions). For example, for category Other sources, all default values are zero and should 
be edited. Generally speaking, it is often appropriate to edit any parameter whose default value is 
zero so that a source is modeled correctly. 

Below is a list of the emission parameters that the user is expected to edit: 

• The emission indices of an "Other" category source 

• Pollution Control Factors -- to reduce the emissions of the specified pollutant by a given 
percentage 

• Horsepower -- for emergency generators 

• Time at 7%, 30%, 85% & 100% Power -- for aircraft engine testing 

• Fuel tank dimensions: Shell length, height and diameter, maximum and average liquid 
height, etc. 

• Percent of Solvent Disposed -- the amount of liquid recovered and properly disposed for 
solvent degreasers 

 

Dispersion Parameters 

Performing a dispersion analysis requires the analyst to specify the dimensions of the stationary 
source. 

First, select how AERMOD should model the stationary source: as a Point, Area or Volume. For 
area sources, select the Number of Points from the drop down list. Then, type in the (X, Y) 
coordinates for each of the stationary source points as well as the base elevation and release height. 
For area sources, the (X, Y) coordinates are used to specify a polygon of up to 20 sides and can be 
edited by double-clicking on a value. The coordinates must be entered in either clockwise or 
counter clockwise order. For points and volumes, only one (X, Y) coordinate pair is entered. For 
point sources, specify the Diameter, Gas Velocity and Temperature. For area and volume sources, 
enter the initial vertical dispersion parameter, Sigma-Z0. For volume sources, also enter the initial 
horizontal dispersion parameter, Sigma-Y0.  

Point / Area / Volume 

This selection determines how AERMOD will model the stationary source. Point models the 
source like a smokestack. Area models the source like a polygon. Volume models the source as a 
point in space. 

Number of Points 

From the drop-down list, the user may choose from 3 to 20 points. This is only activated when 
Area source is selected. For Volume and Point sources, there is only 1 point to enter. 

Elevation 

This is the elevation above mean sea level from which the release height is measured. For a Point 
source, this is the elevation of the base of the smoke stack. 

Rel. Height 

The relative height is the height above the base elevation at which emissions are released. For a 
Point source, this is the physical height of the smokestack. 
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Gas Velocity 

This only appears for Point sources. Gas Velocity refers to the velocity (in meters/second) at which 
emissions enter the atmosphere. 

Temperature 

This only appears for Point sources. Temperature in this context refers to the temperature of the 
source emissions at the time they enter the atmosphere. Check the Temperature is degrees above 
ambient checkbox, if the entered emissions Temperature, is relative to the ambient temperature at 
each hour of dispersion. 

Sigma-Z0 

This only appears for Area and Volume sources. Sigma-Z0 is the initial vertical dispersion 
parameter and therefore describes the vertical concentration distribution at the source. The initial 
distribution is a Gaussian "bell-curve" whose mean is the release height and whose standard 
deviation is equal to Sigma-Z0. In dispersion, this provides the model with an initial finite 
concentration of pollutant. 

Sigma-Y0 

This only appears for Volume sources. Sigma-Y0 is the initial horizontal dispersion parameter and 
therefore describes the horizontal concentration distribution at the source. The initial distribution is 
a Gaussian "bell-curve" whose mean is the center of the volume and whose standard deviation is 
equal to Sigma-Y0. In dispersion, this provides the model with an initial finite concentration of 
pollutant. 

Diameter 

This only appears for Point sources. Diameter refers to the diameter of the emissions source at the 
point the emissions enter the atmosphere. For a smokestack, this is the physical diameter of the 
opening at the top of the smokestack. 

Graphical Display 

Stationary sources that are listed in the In Study list are displayed in the Airport View (Section 
6.6.3). Stationary sources in the Available list are not displayed because they are not currently in 
the study. 

6.3.6 Training Fires 
The Training Fires window (Figure 6-27) allows the user to specify the training fire information 
relevant to the scenario-airport combination. Training fire data is used by EDMS in both emissions 
and dispersion analyses. For emissions purposes, calculations are based upon the amount of fuel 
burned, as well as other parameters described below. For dispersion analyses, training fire 
emissions are treated as point sources by EDMS. Training fire emissions are located spatially 
within the airport using the (x, y) coordinates, and take into account the Height, Temperature, 
Diameter, and Gas Velocity of each fire. 
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Figure 6-27: Training Fires 

 
 

Adding Training Fire Information 
To add a training fire, press the Add New button and enter a name for the new fire in the Name edit 
box. Once added, training fires can remain as part of the scenario-airport combination, or be moved 
to a list of Available training fires with the Remove button. To move a training fire from the 
Available list to the In Study list, select the fire name and press Add. To permanently delete a 
training fire from the Available list, select it and press Delete. 

Double-clicking on a training fire in the Available list will move it to the In Study list. Double-
clicking on a training fire in the In Study list allows the name of the training fire to be edited. 
Right-clicking on a training fire in either the Available or In Study list both selects that training fire 
and pops up a menu that matches the buttons between the two lists, except that it has the additional 
option of Select All. 

Emission Factors 

Fuel 

Select the fuel used in the training fire from the drop down list. There are five options: 

• JP-4 

• JP-5 

• JP-8 

• Propane 

• Tekflame 
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Use System Default Values 

The system-generated values can be restored by checking this checkbox.  

Emission Factors List 

The user may override the emissions factors for any fuel by editing the values in the Emission 
Factors box. This will cause the Use System Default Values checkbox to become unchecked, 
denoting to the user that the values have been edited. This allows the user to set more specific 
information for vehicle emissions characteristics rather than use the MOBILE generated values. 
Emission factors for fuels not included in EDMS may be entered here. 

Gallons of Fuel Used 

The amount of gallons of fuel used can be entered by the Yearly volume or by Peak Quarter Hour. 
If the number of gallons per year is known, select the Yearly radio button and enter the value in the 
adjoining edit box. If the number of gallons per peak quarter hour is known, select the Peak Qtr-
Hour radio button and enter the value in the adjoining edit box.  

Operational Profiles 

Operational Profiles can be defined at the Quarter-hourly, Daily, or Monthly levels. These profiles 
are named and defined using the Operational Profiles dialog box under the Utilities menu (Section 
6.7.1). The "DEFAULT" and all of the user-specified operational profiles appear in the appropriate 
drop-down list for selection. It is important to note that modifications to any one of the quarter-
hourly, daily, or monthly default settings will affect the operational figures. 

Coordinates 

The Coordinates box and its controls are only available for dispersion analyses. Performing a 
dispersion analysis requires the user to specify (X, Y) coordinates and the Elevation. The 
coordinates locate the training fire spatially in the airport layout. Elevation is the elevation of the 
fire relative to sea-level. The default value for fire elevation is the airport elevation. 

Dispersion Parameters 

All training fires are modeled as point sources (smokestacks or torches) in AERMOD. 

Release Height 

Release Height is the distance above the ground elevation at which emissions are released. Because 
training fires are modeled in AERMOD as point sources, this is equivalent to the height of a 
smokestack. 

Diameter 

Diameter refers to the diameter of the emissions source at the point the emissions enter the 
atmosphere. For a smokestack, this is the physical diameter of the opening at its top. In this 
application, the physical diameter of the training fire is appropriate. 

Gas Velocity 

Gas Velocity refers to the velocity (in meters/second) at which emissions enter the atmosphere. 

Temperature 

Temperature in this context refers to the temperature of the source emissions at the time they enter 
the atmosphere. 

Graphical Display 

Training fires that are listed in the In Study list are displayed in the Airport View (Section 6.6.3). 
Training fires in the Available list are not displayed because they are not currently in the study.  
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6.3.7 Update Emissions Inventory 
After all inputs have been made to EDMS, the emissions inventory should be generated by 
selecting Update Emissions Inventory. 

The generated inventory is a set of tables that list the total annual emissions of eight pollutants 
(CO, THC, NMHC, VOC, NOx, SOx, PM-10 and PM-2.5) for each emissions source, source 
category (aircraft, on-road vehicles, etc…) for the entire airport.  

The emissions are displayed in a window called the Emissions Inventory, which is accessed by 
selecting Emissions Inventory (Section 6.6.1) under the View menu. 

Important: Updating the emissions inventory also causes the study to be saved. 

6.4 The Airport Menu 
The Airport menu provides the user with access to dialog boxes used to specify airport data such as 
default taxi times and weather information. Information about gates, taxiways, runways, taxipaths 
and buildings can be entered here. The Airport Menu consists of the following options: 

• Default Taxi Times 

• Weather 

• Gates 

• Taxiways  

• Runways 

• Taxi Paths 

• Configurations 

• Buildings 

• Check Taxipaths 

6.4.1 Default Taxi Times 
The Default Taxi Times window (Figure 6-28) allows the user to set In and Out total taxi and 
Queue times in minutes. These taxi times are used only when the User-specified taxi times for each 
aircraft option is chosen on the Scenario Properties window (Figure 6-4). Default Taxi Times are 
associated to the particular airport-year combination, so this window is only active when the year is 
selected. 
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Figure 6-28: Default Taxi Times 

 

6.4.2 Weather 

6.4.2.1 Weather Data Requirements 
The Weather window (Figure 6-29) allows the user to specify weather information that is relevant 
to the selected scenario-airport combination. The Weather window has two options: Use Annual 
Averages, which can only be used for emissions inventories, and Use Hourly Meteorological Data, 
which is required for dispersion, but can also be used for an emissions inventory. Weather impacts 
aircraft performance and emissions, vehicle emissions, and the activation of airport configurations, 
as well as dispersion. 

Figure 6-29: Weather 
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Mixing Height 

Mixing Height for Emissions Inventory has a default value of 3,000 feet, but can be changed to 
anything from 1,000 to 10,000 feet. Mixing height is used as the upper bound for including 
modeled aircraft emissions. 

Use Annual Averages 

Checking the Use Annual Averages radio-button allows the user to specify the following average 
weather parameters: Temperature, Daily High Temperature, Daily Low Temperature, Pressure, Sea 
Level Pressure, Relative Humidity, Wind Speed, Wind Direction, Ceiling and Visibility. These 
default weather parameters are annual average values from the closest weather station to the 
specified airport that has annual average weather data. Exceptions are the Wind Direction (which 
defaults to north), and Ceiling and Visibility (which default to their respective maximum values). 
These values are all editable. The user can just double-click on the value to edit. 

When Use Annual Averages is selected, wind direction is effectively ignored when modeling 
aircraft as the wind is always assumed to be a headwind. However, when using configurations and 
use distribution percentages are not specified, wind direction is used to determine the active 
configuration to be in use for the entire year. When a use distribution is specified for 
configurations, all annual average weather parameters are effectively ignored in determining the 
active configuration. 

Use Hourly Meteorological Data 

Checking the Use Hourly Meteorological Data radio-button allows the user to run the AERMET 
Wizard. The AERMET Wizard is used to process surface and upper air weather data for AERMOD 
input. 

Users that choose to run AERMET outside of EDMS can press the buttons to the right of the text 
fields to browse for their AERMET Surface Observation File, AERMOD Surface File and 
AERMOD Profile File. Upon completing a file selection, the selected file is immediately copied to 
the appropriate airport folder under the study folder, which is why processed weather files are 
located in the corresponding Scenario and Airport folder under the study directory.  

The date ranges are updated when a new processed weather file is selected. The date ranges of all 
three files should always agree. Any discrepancy between the three date ranges can lead to 
unpredictable results. 

Whenever a particular value is missing from the selected AERMET Surface Observation File the 
corresponding annual average value is used to fill in the missing data. The same applies to files that 
are only cover a range of dates that are not a complete year. If a day falls outside of the range of 
dates in the file, then all of the annual average values are used to fill in the missing day’s data. 

Sometimes the data in the selected file corresponds to actual weather during a non-leap year when 
the user is modeling operations during a leap year (or vice versa). Weather data for February 29th is 
created by duplicating the data for February 28. When a non-leap year is being modeled with 
weather data from a leap year, data from February 29th is simply ignored. 

Base Elevation 

Base Elevation is the height above mean sea level of the base elevation of the potential temperature 
profile. This is usually the elevation of the weather station at which the upper air sounding was 
taken. Every upper air data file used to create the AERMOD Profile File should have an associated 
base elevation. 
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6.4.2.2 AERMET Wizard 
The AERMET Wizard is used to process surface and upper air weather data for AERMOD input. 
This process is divided into 3 steps: extracting surface data, extracting upper air data, merging and 
creating AERMOD weather files. 

The three steps do not need to be completed all at once. The user can skip any steps that are 
already complete, or that will be completed at a later time, by pressing the "skip" button. 

Step 1: Extract & QA NWS Surface Data (Figure 6-30) 
 

Surface Data File 

Location 

First, a surface weather data file must be selected. The user can either enter the full path name of 
the file in the Location text box or press the "..." button to browse for the file. Because the full path 
name cannot exceed 40 characters, EDMS automatically prompts the user to copy the file to a 
shorter temporary path in order to comply with this requirement. 

Format 

Next, the format of the file must be specified. The AERMET Wizard will automatically determine 
the format of the file selected. However, the user may change the format, if necessary. The allowed 
formats include: CD-144, HUSWO, SCRAM, SAMSON, TD-3280, and TD-3505.  

These data provide detailed observations of the surface conditions for a period of time and are used 
to determine the wind speed, wind direction and stability of the atmosphere. CD-144 and TD-3280 
data are available from: The National Climatic Data Center (www.ncdc.noaa.gov/). SCRAM is a 
reduced format of the CD-144 data and is available from EPA's Technology Transfer Network. 
(www.epa.gov/ttn/scram/). "NCDC has made available solar and meteorological data for the first 
order stations in the United States for the period 1961 - 1990 on a set of 3 CD-ROMs, collectively 
referred to as SAMSON data." (page 4-9, AERMET User's Guide). The EDMS web site includes 
information about obtaining weather data. 

Adjustment to Local Time 

The weather data from NCDC is normally supplied using Greenwich Mean Time (GMT). When 
the weather data is reported using GMT, the adjustment to local time will need to be used. 
However, if the weather data file has been converted to local time, then the time adjustment used 
should be 0.  

Date Range 

Choose the Start and End dates for the data to be extracted. This is usually one full calendar year 
of data. 

Surface Weather Station 

The AERMET Wizard automatically determines the weather station parameters. The user need not 
edit any information in this box unless there is a problem. 
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Figure 6-30: AERMET Wizard Step 1 

 
 

Once all of the required information has been input, press the Process button to extract & QA the 
surface data and generate the file SFQAFILE.met which will be ready for merging in step 3. 

Step 2: Extract and QA NWS Upper Air Data (Figure 6-31) 
 

Upper Air Data File 

Location 

First, an upper air weather data file must be selected. The user can either enter the full path name 
of the file in the Location text box or press the "..." button to browse for the file. Because the full 
path name cannot exceed 40 characters, EDMS automatically prompts the user to copy the file to a 
shorter temporary path in order to comply with this requirement. 
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Figure 6-31: AERMET Wizard Step 2 

 

 

Format 

Next, the format of the file must be specified. The AERMET Wizard will automatically determine 
the format of the file selected. However, the user may change the format if necessary. The allowed 
formats include: TD-6201 Variable-Length Blocks, TD-6201 Fixed-Length Blocks and Radiosonde 
Data of North America (FSL format). 

 The EDMS web site includes information about obtaining weather data. 

Adjustment to Local Time 

The adjustment to local time is needed when the upper air data are reported in GMT, as is usually 
the case. If the correction is needed, select the local time zone from the drop-down list. However, if 
the upper air data file has been converted to local time, then an adjustment of 0 should be used. 

Date Range 

Choose the Start and End dates for the data to be extracted. This is usually one full calendar year 
of data. 
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Surface Weather Station 

The AERMET Wizard automatically determines the weather station parameters. The user need not 
edit any information in this box unless there is a problem. 

Once all of the required information has been input, press the Process button to extract & QA the 
surface data and generate the file UAQAFILE.met which will be ready for merging in step 3. 

Step 3: Merge Data & Create AERMOD input files (Figure 6-32) 
This step generates a merged surface and upper air readings file ready to be processed by 
AERMET, followed by the generation of the weather files in the format for AERMOD use. 

Options 

Randomize NWS Wind Directions 

This instructs AERMET to vary the wind directions randomly between ± 5° of the reported wind 
value. This option is available because the surface data that is extracted by AERMET was 
previously rounded to the nearest 10° direction. 

Substitute Missing On-Site Data With NWS Data 

This will instruct AERMET to substitute missing on-site data with the NWS surface data from step 
1. On-site data can be merged in manually by running AERMET independently of EDMS. For 
more information, please see the AERMET User's Guide. Additionally, if upper-air data is missing 
for a given hour, this option allows AERMET to create a single profile level based on the surface 
observation. Checking this box is mandatory if only surface and profile data are used (without on-
site observations). 

Wind Height 

Wind height is the height above ground at which surface wind observations are made. This is also 
known as the anemometer height. 

Surface Roughness 

The surface roughness is related to the height of obstacles to the wind flow. In theory, this is the 
height where the mean horizontal wind speed is zero. Reasonable values range from 0.001 m over 
calm water to 1 m or more over a forest or urban area. 

Date Range 

Choose the Start and End dates for the data to be merged and generated for AERMOD, i.e. the 
interval for which dispersion will be run. This is usually one full calendar year of data. 

Note: The date range that is specified in this step is the range that will actually be used for 1) using 
hourly meteorological data, 2) running dispersion with AERMOD and generating the hourly 
emissions (HRE) file. The emissions inventory will use hourly weather data just for the range 
specified in this step, and will use the average annual values for the remainder of the year.  

Site Location 

Select the Time Zone of the airport from the drop down list, and enter the approximate Latitude 
and Longitude of the airport. 

Once all of the required information has been input, press the Process button to merge data and 
generate the AERMOD weather files. 
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Figure 6-32: AERMET Wizard Step 3 

 

6.4.3 Gates 
The Gates window (Figure 6-33) allows the user to specify the identification and location of each 
gate in the airport. In dispersion analyses, GSE, AGE, and APU emissions originate from the gate 
locations. Aircraft are assigned to specific gates in the Aircraft Operations and Assignments 
window under the Emissions menu. GSE in the GSE population are assigned to specific gates in 
the GSE Population window. Gates are needed for sequence modeling, which includes all 
dispersion analyses. 

Gates are modeled in AERMOD as either volume or area sources. If the user specifies only one 
point (a pair of coordinates (X, Y)), the gate will be modeled as a volume, otherwise as an area 
source. In either case, the initial vertical dispersion parameter, Sigma-Z, defaults to 3 meters 
(almost 10 feet). For volume sources, the initial lateral dispersion parameter, Sigma-Y, defaults to 
16 meters (over 52 feet). Sigma-Y is not specified for area sources. 
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Figure 6-33: Gates 

 
 

Adding Gate Information 

To add a gate, press the Add New button. A new gate will appear in the In Study list, already 
selected and ready for the default name to be replaced. Once added, gates can remain in the current 
study, or be moved to a list of Available gates with the Remove button. To move a gate from the 
Available list to the In Study list, select the gate name and press Add. To permanently delete a gate 
from the Available list, select it and press Delete. To create a copy of the gate already in the study 
select the gate and press the Duplicate button.  

Double-clicking on a gate in the Available list will move it to the In Study list. Double-clicking on 
a gate in the In Study list allows the name of the gate to be edited. Right-clicking on a gate in either 
the Available or In Study list both selects that gate and pops up a menu that matches the buttons 
between the two lists, except that it has the additional option of Select All. 

Number of Points 

From the drop-down list, the user may choose from 1 or 3 to 20 points. If 1 is chosen, the gate will 
be modeled as a volume source centered on the specified point. If from 3 to 20 points are chosen, 
the gate will be modeled as an area source. The Number of Points in the coordinate list changes 
immediately when Number of Points is changed. If Number of Points is reduced, the values in the 
excess coordinates are lost. 

Nudge 

These arrow controls can be used to nudge the selected points in the desired direction or the entire 
gate as a whole if all or none of the points are selected. 
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Elevation 

Elevation is the elevation of the gate relative to sea-level. The default value for gate elevation is the 
airport elevation. 

Release Height 

Release Height is the distance above the ground elevation at which emissions are released. If the 
gate is modeled in AERMOD as a volume source, this locates the height of the center of the 
volume source. If the gate is modeled as an area source, this is the height of the plane of the area 
source above the ground. 

Initial Sigma Z 

The initial vertical dispersion parameter, Sigma-Z describes the vertical concentration distribution 
at the source. The initial distribution is a Gaussian "bell-curve" whose mean is the release height 
and whose standard deviation is equal to the Initial Sigma-Z. In dispersion, this provides the model 
with an initial finite concentration of pollutant. Initial Sigma-Z defaults to 3 meters (9.84 feet). 

Initial Sigma Y 

This field is only active when the gate is being modeled as a volume source, i.e. when Number of 
Points is equal to 1. The initial lateral dispersion parameter, Sigma-Y describes the horizontal 
concentration distribution at the source. The initial distribution is a Gaussian "bell-curve" whose 
mean is the center of the volume and whose standard deviation is equal to the Initial Sigma-Y. In 
dispersion, this provides the model with an initial finite concentration of pollutant. Initial Sigma-Y 
defaults to 16 meters (52.49 feet). 

List of Coordinates 

All coordinates in all menus must be relative to the same origin point (0, 0). It is best to establish 
the origin point via the Airport View (Section 6.6.3) before beginning to create the features at the 
airport. 

The number of points in the list is changed to match Number of Points whenever that is changed. If 
Number of Points is decreased, the values in the excess points are lost. To edit a coordinate value, 
double-click on the field, then type in the desired value. Coordinates can also be changed with the 
Nudge buttons. 

Graphical Display 

Gates that are listed in the In Study list are displayed in the Airport View (Section 6.6.3). Gates in 
the Available list are not displayed because they are not currently in the study. 

For polygonal gates, the Preview box allows the user to view the shape of the gate before saving 
changes. 

6.4.4 Taxiways 
The Taxiways window (Figure 6-34) allows the user to specify the name and location of each 
taxiway at the airport. In dispersion analyses, aircraft taxi emissions originate from taxiway 
locations. Taxiways are used to construct taxipaths connecting gates and runways. Aircraft are 
assigned to taxipaths by the scheduling algorithm, depending on the weather and configuration 
definitions. Taxiways are needed for sequence modeling, which includes all dispersion analyses. 

Taxiways are modeled in AERMOD as a series of area sources. The initial vertical dispersion 
parameter, Sigma-Z0, and the release height depend on the particular aircraft type assigned to the 
taxiway. However both parameters are the same for all aircraft, 4.1 meters (over 13 feet) for 
Sigma-Z0 and 12 meters for the release height (over 39 feet). 
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Figure 6-34: Taxiways 

 
 

Adding Taxiway Information 

To add a taxiway, press the Add New button. A new taxiway will appear in the In Study list, 
already selected and ready for the default name to be replaced. Once added, taxiways can remain in 
the current study, or be moved to a list of Available taxiways with the Remove button. To move a 
taxiway from the Available list to the In Study list, select the taxiway name and press Add. To 
permanently delete a taxiway from the Available list, select it and press Delete. To make a copy of 
the taxiway already in the study, select the taxiway and press Duplicate button. 

These functions and more are also available on the popup menu that is displayed by right-clicking 
on a taxiway in either list. Double-clicking on a taxiway in the Available list will move it to the In 
Study list. Double-clicking on a taxiway in the In Study list allows the name of the taxiway to be 
edited. Right-clicking on a taxiway in either the Available or In Study list both selects that taxiway 
and pops up a menu that matches the buttons between the two lists, except that it has the additional 
option of Select All. 

Number of Points 

A taxiway is defined as a series of connected line segments, which are identified by their 
endpoints. The default for a new taxiway is two endpoints, which is one segment. From the drop-
down list, the user may choose from 2 to 20 points (1 to 19 segments). For dispersion, a taxiway 
will be modeled by area sources derived from the segments and the Width. The number of points in 
the coordinate list changes immediately when Number of Points is changed. If Number of Points is 
reduced, the values in the excess coordinates are lost. If Number of Points is increased, the default 
values for the new points are the values in the last pre-existing point. 
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Width 

Width determines both the thickness of the taxiway's segments when they are displayed on the 
airport view screen and the width of the area sources used to model the taxiway. The default value 
is 20 meters (65.62 feet). 

Nudge 

These arrow controls can be used to nudge the selected points in the desired direction or the entire 
taxiway as a whole if all or none of the points are selected.  

List of Coordinates 

All coordinates in all menus must be relative to the same origin point (0, 0). It is best to establish 
the origin point via the Airport View (Section 6.6.3) before beginning to create the features at the 
airport. 

The number of points in the list is changed to match Number of Points whenever that is changed. If 
Number of Points is decreased, the values in the excess points are lost. When new points are added 
their X, Y, Elevation and Speed default to the last values currently in the list. To edit a value in the 
list double-click on the field, then type in the desired value. The X and Y coordinates can also be 
changed with the Nudge buttons. 

Note: If a taxiway is supposed to connect to a gate or runway (or intersect with another taxiway), 
then the taxiway must be constructed such that it has some overlap with the connecting gate, 
runway, or taxiway. Use the Check Taxipaths menu item for EDMS to perform a check of whether 
the taxiways used in the taxipaths have proper linkages. 

Elevation 

Elevations of taxiway points are given relative to sea-level. The default value for the original 
taxiway points is the airport elevation. 

Speed 

Speed is the taxi speed of an unimpeded aircraft on that segment of the taxiway. The speed refers 
to the traversal between the location on the same line as the speed and the location on the next line 
down. 

Graphical Display 

Taxiways that are listed in the In Study list are displayed in the Airport View (Section 6.6.3). 
Taxiways in the Available list are not displayed because they are not currently in the study. 

The Preview box allows the user to view the layout of the taxiway before saving changes. 

6.4.5 Runways 
The Runways window (Figure 6-35) allows the user to specify the identification and location of 
each runway at the airport. In dispersion analyses, aircraft takeoff, approach and landing emissions 
originate from the runway locations. There are essentially two ways to assign aircraft operations to 
runways: 1) to assign a runway to each operation in the schedule and 2) by using airport 
configurations (assigned through the Configurations window (Figure 6-37). To assign aircraft 
operations to runways using configurations it is essentially necessary to define airport 
configurations and to provide a distribution of aircraft operations along runway based on aircraft 
weight class. Runways are needed for sequence modeling, which includes all dispersion analyses. 

Runways are modeled in AERMOD as a series of area sources. Runway area sources are 20 meters 
wide and 50 meters long. The initial vertical dispersion parameter, Sigma-Z0, and the release height 
depend on the particular aircraft type assigned to the runway. However both parameters are the 
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same for all aircraft, 4.1 meters (over 13 feet) for Sigma-Z0 and 12 meters for the release height 
(over 39 feet). 

Aircraft approach and the elevated portion of aircraft takeoff are modeled using a vertically stacked 
two-dimensional array of area sources before and along the runway, respectively. The width of 
these areas is 20 meters, but their length and Sigma-Z0 depend greatly on the flight profiles of the 
aircraft assigned to the runway. 
  

Figure 6-35: Runways 

 
 
 

Adding Runway Information 

To add a runway, press the Add New button and select the new runway identification from the 
Name drop down lists. Naming runway endpoints follows the naming convention currently 
employed world wide (e.g., 9-27). Runway names reference magnetic north, (e.g. 9 = about 90 
degrees clockwise from magnetic north). Once added, runways can remain in the current study, or 
be moved to a list of Available runways with the Remove button. To move a runway from the 
Available list to the In Study list, select the runway name and press Add. To permanently delete a 
runway from the Available list, select it and press Delete. To make a copy of the runway already 
included in the study, select the runway to be copied and press Duplicate button. 

These functions and more are also available in the popup menu which is displayed by right-clicking 
on a runway in either list. Double-clicking on a runway in the Available list will move it to the In 
Study list and vice-versa. Right-clicking on a taxiway in either the Available or In Study list both 
selects that runway and pops up a menu that matches the buttons between the two lists, except that 
it has the additional option of Select All. 

Coordinates 

All coordinates in all menus must be relative to the same origin point (0, 0). It is best to establish 
the origin point via the Airport View (Section 6.6.3) before beginning to create the features at the 
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airport. Performing a dispersion analysis requires the user to specify (X, Y) coordinates for the two 
ends of the runway as well as their elevations. The coordinates locate the runway spatially in the 
airport layout.  

Elevation 

Elevations of runway points are given relative to sea-level. The default value for the elevation of 
the runway points is the airport elevation. 

Glide Slope 

The glide slopes are used in aircraft performance modeling when Use Runway Glide Slope is 
selected on the Performance tab of the Aircraft Operations & Assignments (Section 6.3.1.3). 

Graphical Display 

Runways that are listed in the In Study list are displayed in the Airport View (Section 6.6.3). 
Runways in the Available list are not displayed because they are not currently in the study. 

The Preview box allows the user to view the orientation of the runway before saving changes. 

6.4.6 Taxipaths 
The Taxipaths window (Figure 6-36) allows the user to define taxipaths. A taxipath is a sequence 
of taxiways, possibly just one, that connects a gate to a runway or vice versa. Taxipaths are used to 
do the modeling of aircraft ground movement. They are needed for sequence modeling, which 
includes all dispersion analyses. Gates, taxiways and runways must be defined before taxipaths can 
be specified.  

Figure 6-36: Taxipaths 
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Adding Taxipath Information 

To add a taxipath click Add New. The Edit Taxipath dialog (Figure 6-37) will then open. Select a 
Gate and a Runway and whether this is to be an Outbound or Inbound taxipath. If it is Inbound the 
user must also choose a Runway Exit, which will be a taxiway that intersects the runway. For 
inbound aircraft, EDMS will choose from among the taxipaths based on aircraft performance 
information and the runway exits, and make its calculation of taxi-in time accordingly.. 

Figure 6-37: Edit Taxipath 

 

 

After the taxipath has been defined, add taxiways from the Available Taxiways list to the Taxiways 
In Taxipath list in the order that they will be traversed as the aircraft makes its way from the gate to 
the runway or from the runway to the gate, as appropriate. 

Right-clicking on a taxiway in either the Available Taxiways or Taxiways in Taxipath list both 
selects that taxiway and pops up a menu that matches the buttons between the two lists, except that 
it has the additional option of Select All. 

The Check Taxipaths menu option under Airport can be used to verify that all the taxipaths have 
been properly constructed, and that all the selected taxiways have a connection between each other 
(touch each other), and have a connection (touch) the gate and runway. 

6.4.7 Configurations 
The Configurations window (Figure 6-38) allows the user to specify weather conditions and times 
under which particular runways and assignments are made for aircraft. These conditions consist of 
ranges of wind direction, wind speed, hour of the day, ceiling, visibility and temperature. 
Specifying configurations allows the user to assign aircraft to runways based on weight category 
criteria that is similar to those employed in an actual airport operating environment. Wind direction 
is based on true north as opposed to magnetic north, upon which runways are named. 

EDMS uses configurations if and only if Sequence Modeling is selected on the Scenario Properties 
window. EDMS makes use of the configurations in the study by checking the configuration 
activation parameters against the surface weather data for each hour. If, in a given hour, the 
weather conditions match some configuration, EDMS will use the runway assignments specified 
for that configuration for all aircraft.  
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Figure 6-38: Configurations 

 
 
Adding Configuration Information 

To add a configuration, press the Add New button. A new configuration will appear in the In Study 
list, already selected and ready for the default name to be replaced. Once added, configurations can 
remain in the current study, or be moved to a list of Available configurations with the Remove 
button. To move a configuration from the Available list to the In Study list, select the configuration 
name and press Add. To permanently delete a configuration from the Available list, select it and 
press Delete. To reposition a configuration in the In Study list, select the configuration and press 
the Move Up or Move Down button as required. To make a copy of an in-study configuration press 
the Duplicate button. 

Double-clicking on a configuration in the Available list will move it to the In Study list. Double-
clicking on a configuration in the In Study list allows the name of the configuration to be edited. 
Right-clicking on a configuration in either the Available or In Study list both select that gate and 
pops up a menu that matches the buttons between the two lists, except that it has the additional 
option of Select All. 

In Study 

The In Study list for configurations is different from other In Study lists that appear in EDMS in 
one important respect; the order of the configurations matters. The activation conditions will first 
be checked for the first configuration (at the top) in the list. If those conditions are satisfied, that 
configuration will be used and no further tests made. If the activation conditions of the first 
configuration fail, the next will be checked, and so on. If all configurations in the list fail their 
activation tests, then EDMS will apply a closeness metric to find the configuration whose 
activation conditions came closest to being met. That configuration will then be used for that hour. 
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Specify Distribution Percentages 

If the Specify Distribution Percentages box is checked, a Time Used (%) column will appear in the 
In Study list. The user can then enter a percentage for each configuration. The percentages must 
total to 100%. If this is done, EDMS will force the allocation of configurations for the year to 
match the user specified values. EDMS will try to match the wind direction as closely as possible 
to the configuration limits while still meeting the distribution requirement. However, if the 
distribution percentage is specified, it is not necessary to specify Activation Parameters. 

Airport Capacity 

For each configuration, there is an associated Airport Capacity, which is displayed when that 
configuration is selected. 1 to 3 points can be entered that define the Pareto frontier of the capacity, 
that is, at those points there can no increase in Arrivals per Hour without a decrease in Departures 
per Hour and vice versa. 

Select a Number of Points and then double-click on the per-hour values to edit them. Checking 
View Graph will display the capacity Pareto frontier graphically, unchecking it will return the list 
of values. 

Activation Parameters 

For each of the six parameters (Wind Direction, Wind Speed, etc.) there is a From (lower bound) 
and To (upper bound) field. For Wind Direction and Hour of Day the From value can exceed the 
To value, because angles and hours wrap around. For the other parameters, if a From value is 
entered that is greater than the To value, the To value will be increased to the From value. 
Similarly, entering a lower To value will cause the From value to be decreased. If only one of the 
From-To pair is entered, that one will be checked and the other ignored. 

Runway Assignments 

For each configuration, each aircraft weight category (Aircraft Size) must have each of its 
operations (Arrivals, Departures, Touch & Gos) distributed by runway. The percentage total over 
the runways for each size-operation combination must equal 100%. 

6.4.8 Buildings 
The Buildings window (Figure 6-39) enables the user to specify the identification and location of 
each building at the airport. In dispersion analyses, buildings only affect the emitted point source 
plumes, and therefore can have a significant impact on concentrations. Thus, the option to enter 
buildings in the airport menu will not be enabled if Enable Dispersion Modeling option is not 
selected in the Study Properties window (Figure 6-2). Buildings have no affect on area and volume 
sources. 
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Figure 6-39: Buildings 

  

 
Adding Building Information 

To add a building, press the Add New button. The new building will appear in the In Study list, 
already selected and ready for the default name to be replaced. Once added, buildings can remain 
in the current study, or be moved to a list of Available buildings with the Remove button. To move 
a building from the Available list to the In Study list, select the building name and press Add. To 
permanently delete a building from the Available list, select it and press Delete. To make a copy of 
an existing in-study building, select the building in the In Study list and press Duplicate button. 

Double-clicking on a building in the Available list will move it to the In Study list. Double-clicking 
on a building in the In Study list allows the name of the building to be edited. Right-clicking on a 
building in either the Available or In Study list both selects that building and pops up a menu that 
matches the buttons between the two lists, except that it has the additional option of Select All. 

Elevation 

This is the elevation above mean sea level from which the building height is measured. 

Height 

Enter the height of the highest significant part of the building. 

Coordinates 

Select the Number of Points from the drop down list. Then, type in the (X, Y) coordinates for each 
of the points. The (X, Y) coordinates are used to specify a polygon of up to 20 sides and can be 



 

 6-67

edited by double-clicking on a value. The coordinates must be entered in either clockwise or 
counter clockwise order. 

Nudge 

These arrow controls can be used to nudge the selected points in the desired direction or the entire 
building as a whole if all or none of the points are selected. 

Graphical Display 

Buildings that are listed in the In Study list are displayed in the Airport View (Section 6.6.3). 
Buildings in the Available list are not displayed because they are not currently in the study. 

The Preview box allows the user to view the orientation of the building before saving changes.  

6.4.9 Check Taxipaths 
Check Taxipaths runs a test of all the taxipaths to ensure that they are properly connected, that is, 
for an outbound taxipath, the gate is connected to the first taxiway, the first taxiway is connected to 
the second, etc., and the final taxiway is connected to the runway. The test takes into account gates, 
taxiways and runways that are In study only. It pops up a window to announce the results, listing 
any specific problems it finds. 

6.5 The Dispersion Menu 
The Dispersion Menu provides the user with access to the AERMOD input file generation 
functions. These include: the ability to define receptor locations, to run AERMAP (the terrain pre-
processor for AERMOD), to generate AERMOD input files, and to run AERMOD. The menu 
items are shown below: 

• Receptors 

o Discrete Receptors 

� Cartesian Coordinates 

� Polar Coordinates 

o Receptor Networks 

� Cartesian Coordinates 

� Polar Coordinates 

• Process Terrain (AERMAP ) 

• Pollutants 

• Generate AERMOD Input Files 

o AERMOD Step 1 – Processing Control 

o AERMOD Step 2 – Sources & Receptors 

o AERMOD Step 3 – Meteorology 

o AERMOD Step 4 – Output Reporting 

• Run AERMOD 
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This menu is only activated for studies with dispersion analysis. Users are expected to step through 
the windows under the Dispersion menu to enter the data necessary to perform a dispersion 
analysis. 

What is dispersion? In the context of air quality, dispersion is the diffusion of a plume of air 
pollutants. A dispersion analysis calculates concentrations of pollutants at receptor locations given 
source emission rates and locations and meteorological and topographical variables. Receptor sites 
are required for dispersion analyses, as they are the locations at which the ambient air quality is 
estimated. 

Dispersion is modeled in EDMS with the AMS/EPA regulatory model, AERMOD, which requires 
historical meteorological data as input. Prior to running AERMOD, the input data must be 
preprocessed by AERMOD’s companion tools: 

• AERMET, the meteorological preprocessor, is required to validate and format weather data 
prior to inclusion in a dispersion analysis. AERMET must be run for dispersion results to 
be calculated. 

• AERMAP, the terrain preprocessor, is used to include terrain effects in a dispersion 
analysis. Usage of AERMAP is optional. 

Before AERMOD is run and concentrations are generated, an AERMOD input file must be 
generated. Execution of AERMOD is only possible after all of the dispersion input data is 
compiled and the AERMOD input files have been generated. AERMOD will output the pollutant 
concentration at the specified receptor positions. 

Steps in Dispersion Analysis 

1. Run AERMET to supply meteorological data to EDMS. This will impact the flight 
profiles, which will also determine where the emissions were released. 

2. Define all of the emission sources. This includes: 

• All items in the Emissions menu, except for Update Emissions Inventory. 

• All of the information concerning airport layout and operations, which is found under 
the Airport menu. 

3. Define Receptors. This can be done at any time up to this point. 

4. Select the pollutants to disperse. Although emissions for all pollutants are calculated 
below, the user is prompted to select only those pollutants to be dispersed to minimize the 
run time associated with generating the AERMOD hourly emissions (.HRE) files. 

5. If terrain data is available and its use desired, run AERMAP. This will adjust the 
elevations of the sources to the underlying terrain. Running AERMAP will supersede any 
user-entered elevations in the AERMOD sources file, but does not propagate those 
elevations to other parts of EDMS. 

6. Calculate the emissions by selecting Update Emissions Inventory. In a dispersion analysis, 
the emissions are attributed to particular sources and times, which takes longer to calculate 
than under a non-dispersion analysis. 

7. Generate the AERMOD input files. This collects the data created in the earlier step and 
formats it for use by AERMOD. 

8. Run AERMOD. This computes the time-tagged pollutant concentrations at each of the 
receptor sites. 
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The resulting concentrations may be displayed by selecting Concentrations under the View menu. 

6.5.1 Receptors 
The Receptors window (Figure 6-40) allows the user to specify the location and height for discrete, 
individual receptors at the airport, and the network name, location, area, height and density of a 
grid of receptors at the airport. In a dispersion analysis, the receptor locations specified in this 
module constitute theoretical measuring points for the dispersion of pollutants generated by the 
emissions sources specified in the study. The calculation of dispersion is based on a combination of 
receptor placement, pollutants generated, and factors such as source locations, temperature, wind 
speed, wind direction and upper-air readings. 

Note: There is a significant increase in dispersion run time as the number of receptors increases. 

AERMOD provides the user with a choice of four different ways to specify receptors: Discrete 
Cartesian Receptors, Discrete Polar Receptors, Cartesian Networks, and Polar Networks. To add a 
network of receptors, first select the type of coordinates for the network by choosing the 
appropriate tab. 

6.5.1.1 Discrete Receptors 
The Discrete Cartesian Receptors Tab (Figure 6-40) 
Use this tab to specify the name and location of discrete receptors using Cartesian coordinates 
relative to an emissions source. 

Adding Receptor Information 

To add a receptor, press the Add New button. A new receptor will appear in the Receptors In Study 
list, already selected and ready for the default name to be edited. Once added, receptors can remain 
in the current study, or be moved to a list of Unused Receptors with the Remove button. To move a 
receptor from the Unused Receptors list to the Receptors In Study list, select the receptor name and 
press Add. To permanently delete a receptor from the Unused Receptors list, select it and press 
Delete. 

These functions and more are also available in the popup menu which is displayed by right-clicking 
on a receptor in either list. Double-clicking on a receptor in the Unused Receptors list will move it 
to the Receptors In Study list and vice-versa. 

Graphical Display 

Receptors that are listed in the Receptors In Study list are displayed in the Airport View (Section 
6.6.3). Receptors in the Unused Receptors list are not displayed because they are not currently in 
the study. 
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Figure 6-40: Discrete Cartesian Receptors 

 

 

The Discrete Polar Receptors Tab (Figure 6-41) 
Use this tab to specify the name and location of discrete receptors using polar coordinates relative 
to an emissions source. 

Adding Receptor Information 

To add a receptor, press the Add New button. A new receptor will appear in the Receptors In Study 
list, already selected and ready for the default name to be edited. Once added, receptors can remain 
in the current study, or be moved to a list of Unused Receptors with the Remove button. To move a 
receptor from the Unused Receptors list to the Receptors In Study list, select the receptor name and 
press Add. To permanently delete a receptor from the Unused Receptors list, select it and press 
Delete. 

These functions and more are also available in the popup menu which is displayed by right-clicking 
on a receptor in either list. Double-clicking on a receptor in the Unused Receptors list will move it 
to the Receptors In Study list and vice-versa. 

Convert 

This function converts the selected discrete polar receptors into discrete Cartesian receptors. This 
allows users to work in Cartesian coordinates with a created receptor. 

Note: This process cannot be undone. 
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Figure 6-41: Discrete Polar Receptors 

 
 

Origin Source 

From the Type drop down list, select the type of source which is to serve as the origin for the 
receptor's polar coordinate system. After selecting a source type, the Name drop down list is 
populated with the names of all of the emission sources of the selected type that are in the study. 
Select the name of the source that is to serve as the origin for the receptor's polar coordinate 
system. 

Relative Position from Source 

Enter the Direction (in degrees measured clockwise from geographic North) and the Distance of 
the selected receptor(s) from the selected origin source. 

Height 

 Enter the Height, which is the distance above the ground elevation at which concentrations are 
modeled. 

Graphical Display 

Receptors that are listed in the Receptors In Study list are displayed in the Airport View (Section 
6.6.3). Receptors in the Unused Receptors list are not displayed because they are not currently in 
the study. 
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6.5.1.2 Receptor Networks  
The Cartesian Receptor Networks Tab (Figure 6-42) 
Use this tab to specify the name and location of receptors networks (gridded receptors) using 
Cartesian coordinates relative to an emissions source. 

Adding Network Information 

To add a network, press the Add New button. A new network will appear in the Networks In Study 
list, already selected and ready for the default name to be edited. Once added, networks can remain 
in the current study, or be moved to a list of Unused Networks with the Remove button. To move a 
network from the Unused Networks list to the Networks In Study list, select the network name and 
press Add. To permanently delete a network from the Unused Networks list, select it and press 
Delete. 

These functions and more are also available on the popup menu which is engaged by right-clicking 
on a network in either list. Double-clicking on a network in the Unused Networks list will move it 
to the Networks In Study list and vice-versa. 

Decompose 

This function decomposes the selected networks into discrete Cartesian receptors. This allows 
users to remove unwanted receptors from the study. 

Note: this process cannot be undone. 

Figure 6-42: Cartesian Receptor Networks 
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Specifications 
Enter the (X, Y) coordinates of the Origin. Enter the Spacing between receptors and the Count 
(number of receptors) in the x and the y directions. Spacing must be positive, so the origin point 
must represent the lower left or southwest corner of the network. Enter the Height above the 
ground elevation at which concentrations are to be modeled. 

Graphical Display 

Networks that are listed in the Networks In Study list are displayed in the Airport View (Section 
6.6.3). Networks in the Unused Networks list are not displayed because they are not currently in the 
study. 

The Polar Receptor Networks Tab (Figure 6-43) 
Use this tab to specify the name and location of receptor networks (gridded receptors) using polar 
coordinates relative to either an emissions source or a point denoted by Cartesian coordinates.  

Adding Network Information 

To add a network, press the Add New button. A new network will appear in the Networks In Study 
list, already selected and ready for the default name to be edited. Once added, networks can remain 
in the current study, or be moved to a list of Unused Networks with the Remove button. To move a 
network from the Unused Networks list to the Networks In Study list, select the network name and 
press Add. To permanently delete a network from the Unused Networks list, select it and press 
Delete. 

These functions and more are also available on the popup menu which is engaged by right-clicking 
on a network in either list. Double-clicking on a network in the Unused Networks list will move it 
to the Networks In Study list and vice-versa. 

Decompose 

This function decomposes the selected networks into discrete Cartesian receptors. This allows 
users to remove unwanted receptors from the study. 

Note: This process cannot be undone. 

Origin Source 

Select Origin Source to center the network on an emissions source in the study. From the Type 
drop down list, select the type of source which is to serve as the origin for the network's polar 
coordinate system. After selecting a source type, the Name drop down list is populated with the 
names of all of the emission sources of the selected type that are in the study. Select the name of 
the source that is to serve as the origin for the network's polar coordinate system. 

Origin Coordinates 

Select Origin Coordinates to center the network on an arbitrary point specified by Cartesian 
coordinates and enter the (X, Y) coordinates of the center point.  

Rings 

For Start, enter the distance of the first concentric ring of receptors from the center point. For 
Spacing, enter the distance between rings, and for Count, enter the number of concentric rings of 
receptors. 

Vectors 

For Start, enter the direction of the first radial vector of receptors from the center point. For 
Spacing, enter the angular distance between vectors, and for Count, enter the number of radial 
vectors of receptors. 
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Height 

 Height is the distance above the ground elevation at which concentrations are modeled. 

Figure 6-43: Polar Receptor Networks 

 
 

Graphical Display 

Networks that are listed in the Networks In Study list are displayed in the Airport View Networks in 
the Unused Networks list are not displayed because they are not currently in the study. 

6.5.2 Terrain & AERMAP  
AERMAP, (Figure 6-44) the terrain preprocessor of AERMOD creates source (.SRC) and receptor 
(.REC) files for inclusion in AERMOD dispersion analyses. Running AERMAP and generating 
these are optional; however without these files, AERMOD will assume a perfectly flat terrain at the 
elevation specified in the Airport Properties dialog. 



 

 6-75

Figure 6-44: Run AERMAP 

 
Input File(s) 

AERMAP accepts one or more USGS DEM Data Files of the same format as input. Press Add 
Files to browse for more files to add to the data file list. Press Remove Files to remove the selected 
files from the list. The selected data files must completely cover the geographic area of the domain. 
AERMAP will report an error for every corner point of the domain that falls outside of the data 
files' coverage.  

Data Format 

EDMS will automatically detect the appropriate Data Format. Adjust the file format only if 
necessary.  
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The 1-degree DEM data has the following characteristics (U.S. Dept. of Interior, 1993): 

• The unit of coverage is a 1-degree by 1-degree block. Elevation data on the integer degree 
lines (all four sides of the DEM file) correspond with the same profiles on the surrounding 
eight DEM blocks. 

• The data consist of a rectangular array of elevations referenced horizontally on the 
geographic (latitude/longitude) coordinate system. 

• Elevations are in meters relative to mean sea level. 

• The data is ordered from south to north in profiles that are ordered from west to east. 

• Spacing of the elevations along each profile is 3 arc-seconds. The first and the last data 
points are the integer degrees of latitude. A profile, therefore, contains 1201 elevations. 

• Spacing between profiles varies by latitude; however, the first and last data points are at 
the integer degrees of longitude. For the contiguous United States, the spacing is 3 arc-
seconds. Between 50 degrees N and 70 degrees N, the spacing is 6 arc-seconds. For the 
remainder of Alaska, north of 70 degrees N the spacing is 9 arc-seconds. 

 

A 7.5-minute DEM has the following characteristics: 

• The unit of coverage is a 7.5-minute quadrangle. 

• The data consist of a regular array of elevations referenced horizontally in the UTM 
coordinate system. 

• The data is ordered from south to north in profiles that are ordered from west to east. 

• The data is stored as profiles in which the horizontal spacing of the elevations along and 
between each profile is 30 m. 

• The profiles do not always have the same number of elevations (nodes) because of the 
variable angle between the quadrangle's true north and the grid north of the UTM 
coordinate system. 

• Elevations for the continental U.S. are either meters, feet, decimeters, or decifeet 
referenced to mean sea level. DEM's of low-relief terrain or generated from contour maps 
with intervals of 10 ft (3 m) or less are generally recorded in feet. DEM's of moderate to 
high-relief terrain or generated from maps with terrain contour intervals greater than 10 ft 
are generally recorded in meters. A rare few are in decifeet or decimeters. 

 

Processing Options 

Perform Setup Only. Do no processing. 

This checkbox instructs AERMAP to check all the input data for errors, but not generate any 
output. This can be useful for studies with large numbers of receptors and sources. 

Extract BOTH hill heights AND source & receptor elevations. 

This instructs AERMAP to use the terrain data to calculate the receptor hill heights and interpolate 
the ground elevations of all sources and receptors. Receptor hill heights are a gauge of the largest 
terrain feature that influences dispersion at the receptor location. For applications involving 
elevated terrain, AERMOD requires a height scale which is used to calculate the critical dividing 
streamline height for each receptor. The primary purpose of the AERMAP terrain preprocessor is 
to determine the height scale for each receptor, based on the following procedure: 

AERMAP determines the highest terrain elevation for each of the input DEM files.  
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It initializes the controlling hill as the receptor elevation and begins with the DEM file in which the 
receptor is located.  

It then reads each of the elevation values in the DEM file and (a) computes the distance to the 
DEM point from the receptor, (b) computes the relief height of the DEM point with respect to the 
elevation of the receptor, and (c) determines the slope. If the slope is less than 10%, then it will 
continue to the next DEM point. If the slope is 10% or greater, it compares the DEM elevation to 
the stored controlling hill height for the receptor. If it is higher, the controlling hill height is 
updated.  

AERMAP then determines the distance from the receptor to the nearest point of the next DEM file, 
and determines the slope as in Step 3. If the slope is 10% or greater, go to Step 3. Otherwise, repeat 
Step 4 for the next DEM file.  

Extract hill heights ONLY. 

This instructs AERMAP to use the terrain data only to calculate the hill heights of the receptors. 

Output 

Base Name 

Enter the base name for the generated source (.SRC) and receptor (.REC) files. This is the base 
name of the file without any extensions. For example, entering "airport elevations" will generate a 
file called "AIRPORT ELEVATIONS.SRC" and a file called "AIRPORT ELEVATIONS.REC". 

Title 

This is a required field, but is only for the user's reference. The entered title will appear in the 
generated source (.SRC) and receptor (.REC) files, and will be helpful in future reviews of these 
output files. 

Subtitle 

This is an optional field for the user's reference. The entered subtitle will appear in the generated 
source (.SRC) and receptor (.REC) files, and will be helpful in future reviews of these output files. 

Domain Limits 

Definitions 

The domain is the geographic region considered when generating elevations and receptor hill 
heights. It is only applicable to dispersion analyses that include terrain data. 

The origin is the geographic location that corresponds to point (0, 0) in user-entered coordinates. 
Technically, the origin can lie outside of the domain; however, all sources and receptors must fall 
within the boundaries of the domain. Origins are set on the Airport Properties dialog. 

Units 

This selects the measurement system to be used in the Domain box below. Latitude & Longitude 
allows the user to enter geographic points using latitude and longitude coordinates. UTMs lets the 
user to enter geographic points using Universal Transverse Mercator (UTM) coordinates. All 
coordinates need to be entered only once in either Latitude/Longitude or UTMs, not both. EDMS 
will automatically recalculate coordinate values for the measurement system that the user is not 
using. For example, if the user enters UTM coordinates, the Latitude/Longitude coordinates will 
automatically update to agree. 



 

 6-78

Domain Limits 

Enter the geographic coordinates for two points: the SW Corner and the NE Corner. The SW 
Corner is the southwest corner of the domain. The NE Corner is the northeast corner of the 
domain. 

6.5.3 Pollutants 
Select the pollutants to be dispersed from the checklist (Figure 6-45). 

An hourly emission (.HRE) file is required to run dispersion for a given pollutant. Although annual 
emission totals for all pollutants are calculated when the emissions inventory is updated, we 
recommend selecting only the pollutants to be dispersed to minimize the run time associated with 
generating the .HRE files. When the emissions inventory is updated, .HRE files for the pollutants 
selected here are also generated. Out-of-date .HRE files are deleted. When the emissions inventory 
is up-to-date so are the .HRE files. If the user revisits this screen and changes the selection, the 
emissions inventory must be rerun in order that the .HRE files are also generated and up-to-date. 

Note: If dispersion modeling is enabled and the user has not yet selected any pollutants for 
dispersion, this screen automatically appears when updating the emissions inventory. 

Figure 6-45: Select Pollutants for Dispersion 

 

 

The user cannot proceed to Generate AERMOD Input Files unless at least one .HRE file has been 
generated and is up-to-date. Only the pollutants selected here that also have up-to-date .HRE files 
are available to be chosen in the Generate AERMOD Input Files screen described below. 

6.5.4 Generate AERMOD Input File 
All dispersion calculations in EDMS are handled by EPA's AERMOD program. This process is 
divided into 4 steps: 



 

 6-79

1. Processing Control 
2. Sources and Receptors 
3. Meteorology 
4. Output Reporting 

 

All that is required for the dispersion run is the AERMOD input file and the previously processed 
weather data. For more information on weather data processing see Weather Data (Section 6.4.2). 

The AERMOD input file generated by EDMS can be edited in a text editor for advanced users who 
want to change specific AERMOD parameters not addressed by the EDMS interface. 

6.5.4.1 Step 1. Processing Control 
In the first step of AERMOD (Figure 6-46) the user is able to specify a title and subtitle for the 
study, select an averaging period, apply exponential decay, and set restart and other options.  

Figure 6-46: AERMOD: Step 1. Processing Control 

 

Title / Subtitle 

Specify a title and subtitle for the dispersion analysis. A title is required, but a subtitle is optional. 
The user can put anything within reason in these fields. These fields will be included in the 
AERMOD dispersion report; therefore, consider entering something meaningful and pertinent to 
the study. 

Pollutant 

Select the pollutant whose concentrations are to be modeled from the drop down list. Only the 
pollutants selected for dispersion that also have up-to-date .HRE files appear here. 

Do Multi-Year Processing 
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Enable this option to run multiple years of weather files for the selected pollutant. A Save File 
should be specified for the first year. Additionally, an Init File should be specified for subsequent 
years. 

If PM-10 is the selected pollutant, check this box to conduct the dispersion analysis according to 
the pre-1997 NAAQS. See the AERMOD user's guide, section 3.2.12, page 3-13. 

Stop AERMOD before Dispersion Processing 

Because of the great many options available in the AERMOD model, and the potential for wasted 
resources if a large run is performed with some incorrect input data, this option has been included 
to allow the user to specify whether to completely run AERMOD and perform all of the dispersion 
processing, or not run, but only process the input data and summarize the setup information. This 
allows the advanced user to review the main output (.OUT) file after running AERMOD in a 
diagnostic mode. AERMOD will provide a list of the inputs passed to the model without running 
dispersion. This step runs very quickly, and provides the opportunity to double-check the input 
before committing to running the dispersion. 

Averaging Periods 

Specify the averaging period(s) to be considered. The choices include: 1, 2, 3, 4, 6, 8, 12 and 24 
hour. Additionally, there are monthly averages. Users can also select yearly or period averages, but 
not both. AERMOD is capable of modeling multiple averaging periods simultaneously within a 
single run. 

Options 

Urban Effects 

Check this box to incorporate the effects of increased surface heating from an urban area on 
pollutant dispersion under stable atmospheric conditions. If this option is checked, specify the size 
of the urban population in the Population edit box. Specifying surface roughness is optional, but 
one meter is the default. 

Optimize Area Sources & Allow Use of SCIM 

When this option is checked, the area source integration routine is optimized to reduce model 
runtime. This is accomplished by incorporation of a three-tiered approach using the Romberg 
numerical integration, a 2-point Gaussian Quadrature routine for numerical integration, or a point 
source approximation based on the location of the receptor relative to the source. Normally, only 
Romberg numerical integration is utilized for all receptors. 

Additionally when this option is checked, the user may also use the Sampled Chronological Input 
Model (SCIM) option in step 3 to reduce model runtime. The SCIM option can only be used with 
annual averages, and is primarily applicable to multi-year model simulations. The approach used 
by the SCIM option is to sample the meteorological data at a user-specified regular interval to 
approximate the annual average impacts. Studies have shown that the uncertainty in modeled 
results introduced by use of the SCIM option is generally lower for area sources than for point 
sources. 

Suppress Warning Messages 

When this option is checked, the detailed listing of warning messages in the main output (.OUT) 
file is suppressed; however, the number of warning messages is still reported. 

Apply Exponential Decay 
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This option applies exponential decay to the pollutant being modeled. If selected, the decay can be 
entered in one of two ways, by either specifying the half-life (in seconds) or the decay coefficient. 
The reciprocal relationship between these parameters is Decay Coefficient = 0.693 / Half-Life. 

Restart Options 

AERMOD has the capability to store intermediate results into an unformatted file, so that the 
model run can be continued later in case of a power failure or a user interruption.  

Entering a Save File instructs AERMOD to save the intermediate results to the specified "save" 
file. If no file is specified, AERMOD will automatically save intermediate results to a file called 
"SAVE.FIL" in the study directory. Any previously saved results are overwritten. 

Entering an Init File instructs AERMOD to initialize the results arrays from a previously saved 
"save" file. For example, rename "SAVE.FIL" (the automatically saved "save" file) to "SAVE.INI" 
and select it as the init file. The Save File and Init File must be different. 

6.5.4.2 Step 2. Sources & Receptors  
Step 2 of AERMOD (Figure 6-47) allows users to group contributions from particular sources 
together, for example: "Aircraft", "Roadways", "Training Fires", etc. Several source groups may be 
included in a single run. Check the boxes corresponding to the source groups to be included in the 
dispersion analysis. At least one group must be selected. 

Figure 6-47: AERMOD: Step 2. Sources & Receptors 

 

 

Select the Use AERMAP generated elevations and hill heights checkbox to include the AERMAP 
generated files in the dispersion analysis. 
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6.5.4.3  Step 3. Meteorology  
 In this step (Figure 6-48), the user is able to select the meteorological data to be included in the 
dispersion analysis. 

Figure 6-48: AERMOD: Step 3. Meteorology 

 
 

Suspend Date Checking in Meteorological Files 

This instructs AERMOD to suspend the date checking, an option that is typically used for non-
sequential meteorological data files. 

Wind Correction 

Enter the number of degrees to subtract from the wind direction measurements. This allows the 
user to correct the input meteorological data for wind direction alignment problems. Since the 
model results at particular receptor locations are often quite sensitive to the transport wind 
direction, this should be used only with extreme caution and with clear justification. It may be done 
to correct for known (and documented) calibration errors, or to adjust for the alignment of a valley 
if the meteorological station is located in a valley with a different alignment than the source 
location. 

Sampled Chronological Input Model (SCIM) 

This option is only available if, in step 1, Optimize Area Sources & Allow Use of SCIM is selected 
and only the Annual averaging period is selected. SCIM works exclusively with annual averages. 

The Sampling Interval determines the number of hours to skip between samples. For example, 
entering "25" skips over 24 hours of weather before using another hour of weather data. The 
Sampling Interval must be greater than 1; moreover, it could be based on the formula (24n +1), 
where "n" is the number of days to skip between samples, in order to ensure a regular diurnal cycle 
to the sampled hours (e.g., 25 or 49). 
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The 1st Hour is the first hour for which weather data is taken. It must be between 1 and 24, 
inclusive -- some hour during the first day of weather data. 

Optionally, specify the Extracted Surface File and Extracted Profile File by clicking on the "..." 
button. This saves the sampled hours of weather data to files in the same format as the AERMET 
generated files. 

6.5.4.4 Step 4. Output Reporting  
Figure 6-49 shows the fourth and final stage of the AERMOD input file generation process. 

Figure 6-49: AERMOD: Step 4. Output Reporting 

 
 

Nth Highest Value at each Receptor 

This option instructs AERMOD to include high value summary tables by receptor in the main 
output (.out) file. For example, if the 2nd checkbox is checked for the 3 Hour averages, then 
AERMOD will report the second highest 3-hour averages modeled at every receptor. Only the 
checkboxes for selected averaging periods are activated. Toggling a checkbox in the All Periods 
row toggles all checkboxes below it for the selected averaging periods. 

Compute the 8th Highest 24-hour Averages at Each Receptor 

In addition to the above, use this checkbox to include high-eighth-high value summary tables by 
receptor in the main output (.out) file. This option is only available for PM-2.5 when 24-hour 
averaging is selected. 

Maximum Values 
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This option instructs AERMOD to include a summary table of the top n overall (including all 
receptors and hours) values in the main output (.out) file, where n is the number of values entered 
in the edit box (from 1 to 100, inclusive). For example, if "10" is entered for the 24 Hour averages, 
then AERMOD will report the top ten 24-hour averages modeled over the entire dispersion 
analysis. Only the edit boxes for selected averaging periods are activated. Editing a value in the All 
Periods row, sets all of the values below it for selected averaging periods.  

All Values 

This option instructs AERMOD to include a table of all of the modeled values in the main output 
(.out) file. This option is not recommended because of the very large output files it can produce. 
Toggling a checkbox in the All Periods row, toggles all checkboxes below it for selected averaging 
periods.  

Generate Additional Files 

Tabulated File of All Concurrent Concentrations (.con) 

This option is required to view concentrations in the Concentrations View and is a much better 
alternative to using the All Values option (described above) in that it yields the same information 
but in a far more organized manner. This checkbox instructs AERMOD to output a concentration 
(.con) file which contains all of the modeled values for the entire dispersion analysis.  

Annual average concentrations are output to a separate concentration file for each source group. 
For example, if the base file name was "my study", then all of the non-annual concentrations are 
written to "my study.con" and the annual concentrations for the ROADWAYS source group are 
written to "my study_ROADWAYS_ANNUAL.con", etc. 

Automatically Run AERMOD 

Use this checkbox to run AERMOD immediately after the files have been generated by EDMS. 
This is akin to batch processing a single AERMOD run. It is useful because generating the 
AERMOD input files can often be a lengthy process in itself, and the user may wish to begin the 
AERMOD run as soon as possible. 

6.5.5 Run AERMOD 
Running AERMOD is the final step in a Dispersion analysis. Select Run AERMOD under the 
Dispersion menu only to manually run AERMOD. If the Automatically Run AERMOD... option 
was selected in step 4 of the AERMOD Wizard, this window is probably an unnecessary step 
because AERMOD has either already processed the file or is still in the process of running. 
Choosing the Run AERMOD menu item will pop up the Run AERMOD confirmation screen 
(Figure 6-50) which lists the pollutants for which AERMOD will be run. Selecting yes will run 
AERMOD for all Scenarios, Airports, and Pollutants. 

Figure 6-50: Run AERMOD Confirmation Screen 
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After AERMOD is run, a file with the .out extension will be created in the study directory. This 
file contains both the list of inputs to AERMOD along with the concentrations. These results can 
be viewed and printed in any text editor. Concentration (.CON) files can be viewed in the 
Concentrations View. 

6.6 The View Menu 
The View Menu provides access to the emissions inventory results, the airport graphical display, 
concentrations, the system tables, the General Conformity Rule, the National Ambient Air Quality 
Standards and the EDMS Homepage. The menu items available under the View menu are listed 
below. 

• Emissions Inventory 

o Summary Button 

o Aircraft by Mode Button 

o Aircraft /APU Button 

o GSE Population Button 

o Vehicle Button 

o Stationary Button 

• Emissions Reduction Report 

• Airport 

• Zoom In 

• Zoom Out 

• Zoom Home 

• Edit Wallpaper 

• Show Wallpaper 

• Concentrations 

• All Model Inputs 

• System Tables 

• General Conformity Rule 

• Standards (NAAQS) 

• EDMS Homepage 

6.6.1 Emissions Inventory 
Use this window (Figure 6-51) to view the emissions inventory results. When this window is open 
and the emissions inventory changes in model inputs, then this window will immediately update 
accordingly. 
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When the emissions inventory window is initially opened, summary information on all categories 
of emissions sources for the lexically first scenario-airport-year combination is displayed. 

Choose to view emissions by Aircraft by Mode, Aircraft/APU, GSE Population, Vehicular sources 
or Stationary sources, by pressing the buttons at the top of the screen corresponding to these 
categories. For example, the summary screen displays total emissions for all vehicular sources in 
the study, but clicking on the Vehicular button will display emissions for each roadway in the 
study. To return to the summary information screen, press the Summary button. 

The reporting units are listed in the window's status bar. 

Figure 6-51: Emissions Inventory 

 

Export 

Pressing the Export button will export the displayed emissions inventory results into a semi-colon 
delimited text file, in the selected units, for analytical use in spreadsheet programs.  

Sorting 

Sort any list by clicking on a column header. Subsequent column header clicks reverses the 
previous sort order. 

Formatting 

Rearrange columns by clicking and dragging on the column headers. 

Resize columns by clicking and dragging on the right-hand edges of the column headers. Double-
click on the right-hand edge of a column header to automatically resize it such that the column is 
just wide enough to view all entries without abbreviation. A trailing ellipsis ("...") at the end of an 
entry means that the entry has been abbreviated due to the column's limited width. To view an 
abbreviated entry in its entirety, expand the column's width until the entry is fully visible. 

Printing a Report 

Print a report using the Print option in the File menu. The report can be formatted by adjusting the 
columns in the view. Resize and rearrange columns by clicking and dragging on the edges of the 
column headers. 

6.6.2 Emissions Reduction Report 
Emissions Reduction Reports are part of a phased approach for developing new EDMS capabilities 
to support Voluntary Airport Low Emissions (VALE) program requirements and early emission 
reductions by participating airports. The Emissions Reduction Reports show net change in 
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emissions between the baseline and a selected “VALE” scenario for a selected airport and one or 
more selected years. The user can also select which pollutants to include in a report. 

Selecting Emissions Reduction Report from the View menu brings up the Emissions Reduction 
Report Settings window (Figure 6-52) which allows the user to select the VALE Scenario, Airport, 
Analysis Years and Pollutants to compare in the report. The user can also select the appropriate 
title for the report: “Emission Reduction Report for Cost Effectiveness” or “Emission Reduction 
Report for AERCs.” Please refer to the VALE Technical Report for further instruction. 

Figure 6-52: Emissions Reduction Report Settings 

 

 

In order to set a baseline scenario for the reports, right-click on the name of the scenario in the 
study tree in the upper-left pane of the main EDMS window, and select Set as Baseline on the 
popup menu. The name of the baseline scenario is shown in bold in the study tree. By default, the 
first scenario created is the baseline scenario. 

When all selections are complete, click OK to produce the report. You can preview how it is going 
look when printed, Print or Close the report by pressing the appropriate buttons on the top. 

Examples of the two reports are depicted in Figure 6-53 and Figure 6-54. 
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Figure 6-53: Example Emissions Reduction Report for Cost Effectiveness 

 

Figure 6-54: Example Emissions Reduction Report for AERCs 
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6.6.3 Airport 
The airport layout (Figure 6-55) can be viewed graphically at any time by selecting Airport from 
the View menu. The airport layout is rendered in Cartesian (x, y) coordinates such that the y-axis 
runs north and south and the x-axis runs east and west. The coordinates of the cursor's current 
position are displayed in the status bar at the bottom of the window. The legend, showing the 
airport name and scale, is displayed in the top left corner of the window. Initially, EDMS 
automatically selects the best scale to fit the entire airport layout within the window.  

Note: Cross hairs indicate the (0,0) point. This helps in selecting the anchor point in step 2 of the 
wallpaper wizard (Figure 6-57). 

Figure 6-55: Airport Graphical Display 

 
 

Toolbar 
By default, the toolbar appears on the left hand side of the window. By clicking and dragging it, it 
can be undocked and left as a floating window or re-docked to another location along the edge of 
the Airport View window. As a floating window, it can also be resized. If it is closed, bring it back 
with the Toolbar option in the Window menu. The functionality of the toolbar is detailed below. 
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Zoom In, Out & Home 

The scale of the airport view can be changed with the three zoom buttons in the toolbar -- the ones 
that look like magnifying lenses. Alternatively, the Zoom functions under the View menu can also 
be used to obtain the desired perspective. Zoom In increases the scale, while Zoom Out reduces it. 
Use Zoom Home to reset the scale, at any time, to the initial condition, which depends upon the 
window's current size. 

Edit Wallpaper 

Click this button to activate the Wallpaper Wizard. Alternatively, select Edit Wallpaper under the 
View menu. 

Show Wallpaper 

Click this button to toggle the wallpaper on and off. Alternatively, select View Wallpaper under the 
View menu.  

Toggle Labels 

Click this button to toggle the labels of the sources, receptors and buildings on and off. 

Add New Parking Facility, Roadway, Stationary Source, Training Fire, Gate, Taxiway, Runway, 
Building & Receptor 

Click on one of these nine (9) buttons to begin adding a new item to the study. Click anywhere in 
the window to place the item's first point in the airport layout. If the item only consists of one 
point, then placement is complete. For items consisting of more than one point (parking facilities, 
roadways, taxiways, runways and buildings), release the left mouse button at the location of the 
second point. After placement is complete, the item's respective edit window will open for name 
identification and refinement. For roadways and taxiways, only 2 points, and hence, only 1 link can 
be specified in this manner. Similarly, when adding parking facilities and buildings graphically, 
only rectangular shapes can be defined. 

By default, all stationary sources and gates initially consist of only one point. As for receptors, 
only discrete Cartesian receptors can be added in this manner. 

Remove any source from the study by selecting it and pressing the keyboard's Delete key. 

Moving & Reshaping Items 
Sources, receptors and buildings can be moved by clicking on an edge or inside of an object and 
dragging with the mouse. Click on an item or its name to select it. Alternatively, click and drag 
where there isn't a source to use selection rectangle and make a multiple selection. Use Ctrl-A on 
the keyboard to select all sources. Clicking and dragging on selected sources and/or single-point 
components of sources moves them. The scale may have to be sufficiently large for this to work 
well. 

Objects can be resized or reshaped by clicking directly on a corner of the object, and dragging the 
mouse. (Do not first click on the edge of the object to select it, since doing so will only enable 
moving of the object.) 

Domain 
The domain boundary is marked by a thick gray line. Because the domain must completely contain 
all of a study's sources, receptors and buildings, when any item is placed outside of the domain, the 
domain is automatically expanded to include the item and a significant margin. 

Wallpaper Wizard 
Use the wallpaper wizard to select a wallpaper. 

Step 1 (Figure 6-56) 
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Type the location of the image file to be used as a wallpaper. Alternatively, click Browse and 
locate the file. By pressing Open, the selected image will be loaded on the Preview box. The Color 
button is also activated, which allows one to change the color of the image. Press Next to go to Step 
2. 

Figure 6-56: Wallpaper Wizard - Step 1 

 
 

Step 2 (Figure 6-57) 

In this context, the origin is the selected image's pixel to be placed at the position of (0, 0) in the 
Airport View. The x and y values can either be captured with the mouse or entered into the 
appropriate boxes. 

To capture the origin, press Capture and click the desired point of origin on the image in the 
Preview box. Use the little arrow controls to make fine adjustments. Monitor the fine adjustments 
in the zoom box in the upper right hand corner of the window. 
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Figure 6-57: Wallpaper Wizard - Step 2 

 

Step 3 (Figure 6-58) 

The scaling of the selected image's pixels into real-world coordinates requires knowledge of a real-
world distance between two points represented in the image. Entering a known runway length is 
recommended for scaling. On maps of U.S. airports, runways typically have their lengths (in feet) 
printed along them. If this is the case, the user should select English for the Unit System from the 
Study Properties window. The known real-world length should be entered in the Real-World 
Distance box. 

To capture the length between two pixels in the bitmap, press the Capture button. Proceed by 
clicking and dragging with the mouse on the image in the Preview box. The values in the Image 
Length and Scale boxes will automatically update. The locations of the selected endpoints will 
appear as crosshairs on the two "zoomed-in" views in the upper right hand corner of the window. If 
the endpoints require adjustment, adjust the captured length using the little arrow controls. 
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Figure 6-58: Wallpaper Wizard - Step 3 

 

 

6.6.4 Concentrations 
The Concentrations window (Figure 6-59) displays the concentrations generated by AERMOD. 
Select from or type in the File Name drop down list a concentration (.CON) file name. The 
window's status bar displays the selected file's size, number of records and date of last 
modification. Press Query to read the file's contents and populate the view's list of concentrations. 
To filter the query, select an averaging period from the Averaging Period and/or a source group 
from the Group drop down lists. Press Query again to update the view. Filtering the data can 
greatly accelerate the query process. 
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Figure 6-59: Concentrations 

 

 

Sorting 

Sort any list by clicking on a column header. Subsequent column header clicks reverses the 
previous sort order. 

Formatting 

Rearrange columns by clicking and dragging on the column headers. 

Resize columns by clicking and dragging on the right-hand edges of the column headers. Double-
click on the right-hand edge of a column header to automatically resize it such that the column is 
just wide enough to view all entries without abbreviation. A trailing ellipsis ("...") at the end of an 
entry means that the entry has been abbreviated due to the column's limited width. To view an 
abbreviated entry in its entirety, expand the column's width until the entry is fully visible. 

6.6.5 All Model Inputs 
The All Model Inputs window (Figure 6-60) displays all of the study’s inputted user specifications 
in an HTML report which can be printed, saved, and/or copied from. The All Model Inputs report is 
submitted to FAA for study approval. It contains all of the input data for all scenarios, airports, 
weather, operational profiles, aircraft, etc. This report can be saved or printed by clicking on the 
corresponding buttons on the toolbar. Use the mouse and keyboard to highlight and copy text as 
needed. 
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Figure 6-60: All Model Inputs 

 

6.6.6 System Tables 
The View System Tables window (Figure 6-61) allows the analyst to retrieve emission factor or 
aircraft-engine combination data for emission sources in the following categories: 

• Airports 

• Airport Taxi Times 

• Aircraft 

• Aircraft Categories & ICAO Times in Mode 

• Aircraft Engines Emissions Data 

• APU Emissions Data 

• GSE Default Aircraft Assignments 

• GSE Types & Default Values 

• GSE Default (NONROAD2005) Emissions Data 

• GSE Nonroad (NONROAD2005) Emissions Data 

• Stationary Source Parameters 
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• Fuels Emissions Data 

• Weather Stations 

Aircraft engine emission factors are expressed as emission indices (grams of pollutant emitted per 
kilogram of fuel burned). When these are multiplied by the fuel flow rates (Kg/s), emission factors 
in grams-per-second are produced.  

Viewing System Tables 

To view emission factor data for a category, select the category to view using the drop-down list. 
Once the category has been selected, (highlighted) a list of equipment/source types will appear 
along with emission factor data for some criteria pollutants. Use the scroll bars if necessary to view 
the entire list of equipment/source types, emission factors and source of emissions data.  

Printing System Tables 

The user can print the emission factor data for the category by selecting File�Print from the pull 
down menu. 
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Figure 6-61: System Tables 

 

6.6.7 The General Conformity Rule 
The General Conformity Rule simply displays the threshold level for Non-Attainment Areas 
(NAAs), and the threshold level for Maintenance Areas (MAs). 

Threshold Levels for Non-Attainment Areas (NAAs) 

Criteria Pollutant Non-Attainment Status Tons/Year 

Ozone (VOC & NOx) Serious NAAs 50 

Severe NAAs 25 

Extreme NAAs 10 

Other ozone NAAs outside an ozone transport 
region (OTR) 

100 

Marginal and Moderate VOC 50 
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NAAs inside an OTR NOx 100 

CO All NAAs 100 

SO2 All NAAs 100 

NO2 All NAAs 100 

PM-10 Moderate NAAs 100 

Serious NAAs 70 

Lead (Pb) All NAAs 25 

Threshold Levels for Maintenance Areas (MAs) 

Criteria Pollutant Non-Attainment Status Tons/Year 

Ozone (VOC) MAs inside an ozone transport region (OTR) 50 

MAs outside an OTR 100 

Ozone (NOx) All MAs 100 

CO All MAs 100 

SO2 All MAs 100 

NOx All MAs 100 

PM-10 All MAs 100 

Lead (Pb) All MAs 25 

Source: General Conformity Rule (40 CFR Part 93, Subpart B), effective January 31, 1994 

6.6.8 Standards (NAAQS) 
The National Ambient Air Quality Standards (NAAQS) are composed of primary and secondary 
standards, and short term and long-term standards. The EPA Office of Air Quality Planning and 
Standards (OAQPS) may be contacted to obtain further information on any of the standards. With 
the exception of the standards for Ozone and Lead and the 3-hour Sulfur Dioxide secondary 
standard, EDMS will generate concentrations that can be compared against the NAAQS. 

Primary standards set limits to protect public health, including the health of "sensitive" 
populations such as asthmatics, children, and the elderly. 

Secondary standards set limits to protect public welfare, including protection against decreased 
visibility, damage to animals, crops, vegetation, and buildings. 

Short and Long Term Standards are designed to provide for the fact that humans can tolerate brief 
exposures to higher levels of pollutant concentrations, but can suffer adverse health impacts from 
prolonged exposure to lower concentrations of pollutants. 

Short Term Standards set limits for concentrations over one-hour, 8-hour, and 24-hour periods. 
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Long Term Standards set limits for concentrations based on the annual arithmetic mean (AAM). 

The EPA Office of Air Quality Planning and Standards (OAQPS) has set National Ambient Air 
Quality Standards for six principal pollutants, which are called "criteria" pollutants. The criteria 
pollutants are listed below in the table below. Units of measure for the standards are parts per 
million (ppm) by volume, milligrams per cubic meter of air (mg/m3) and micrograms per cubic 
meter of air (µg/m3). 

National Ambient Air Quality Standards. 

Pollutant  Primary Standards  Averaging Period  Secondary Standards 

Carbon Monoxide 9 ppm (10 mg/m3) 8-hour1 None 

35 ppm (40 mg/m3) 1-hour1 None 

Lead 0.15 µg/m3 Rolling 3-month Average2 Same as Primary 

1.5 µg/m3 Quarterly Average Same as Primary 

Nitrogen Dioxide 0.053 ppm (100 
µg/m3) 

Annual Arithmetic Mean Same as Primary 

Particulate Matter  

(PM10) 

50 µg/m3 Annual2 Arithmetic Mean Same as Primary 

150 µg/m3 24-hour3   

Particulate Matter  

(PM2.5) 

15 µg/m3 Annual4 Arithmetic Mean Same as Primary 

35 µg/m3 24-hour5   

Ozone 0.075 ppm (2008 std) 8-hour6 Same as Primary 

0.08 ppm (1997 std) 8-hour7 Same as Primary 

0.12 ppm 1-hour8 Same as Primary 

Sulfur Oxides 0.03 ppm Annual Arithmetic Mean ------- 

0.14 ppm 24-hour1 ------- 

------- 3-hour1 0.5 ppm (1300 µg/m3) 

1 Not to be exceeded more than once per year. 
2 Final rule signed October 15, 2008. 
3 Not to be exceeded more than once per year on average over 3 years. 
4 To attain this standard, the 3-year average of the annual arithmetic mean PM2.5 concentrations 
from single or multiple community-oriented monitors must not exceed 15 µg/m3.  Note: The 
Annual Standard for PM10 is no longer used and has been removed from the NAAQS table. 
5 To attain this standard, the 3-year average of the 98th percentile of 24-hour concentrations at each 
population-oriented monitor within an area must not exceed 35 µg/m3. (effective Dec. 17, 2006) 
6 To attain this standard, the 3-year average of the fourth-highest daily maximum 8-hour average 
ozone concentrations measured at each monitor within an area over each year must not exceed 
0.075 ppm.  (Effective May 27, 2008).  
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7 (a) To attain this standard, the 3-year average of the fourth-highest daily maximum 8-hour 
average ozone concentrations measured at each monitor within an area over each year must not 
exceed 0.08 ppm.(b) The 1997 standard –and the implementation rules for this standard – will 
remain in place for the implementation purposes as EPA undertakes rulemaking to address the 
transition from the 1997 ozone standard to the 2008 ozone standard. 

 
8 (a) The standard is attained when the expected number of days per calendar year with maximum 
hourly average concentrations above 0.12 ppm is <=1.  (b) As of June 15, 2005 EPA has revoked 
the 1-hour ozone standard in all areas except the fourteen 8-hour ozone nonattainment Early Action 
Compact (EAC) Areas.  For one of the 14 EAC areas (Denver, CO), the 1-hour standard was 
revoked on November 20, 2008.  For the other 13 EAC areas, the 1-hour standard was revoked on 
April 15, 2009. 

6.7 The Utilities Menu 
The Utilities Menu allows the user to define operational profiles, or create custom aircraft, APU 
and GSE. The items under the Utilities menu are listed below. 

• Operational Profiles 

• User-Created Aircraft 

• User-Created GSE 

• User-Created APU 

6.7.1 Operational Profiles 
The Operational Profiles window (Figure 6-62) allows the user to set Quarter-Hourly, Daily and 
Monthly operational profiles, which are critical to the dispersion analysis. 

Figure 6-62: Operational Profiles 

 
 

Source Strength Variation 
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EDMS calculates dispersion for quarter hour periods. However all source types can be expected to 
vary in their activity or strength. For example, a certain roadway may experience a high volume of 
traffic during the afternoon hours on a busy weekday. In contrast, the same roadway may 
experience little or no traffic for the early morning hours of a weekend. Therefore, operational 
profiles are used to profile the activity or strength of any source over the course of an entire year 
(35,040 quarter hours, 35,136 if a leap year) on a quarter-hourly basis in a manner that delivers 
accuracy, yet eliminates a tedious brute force approach of providing the actual activity or strength 
for every quarter hour of the year. 

Entering Data 

Data is entered in the same manner on each of the three operational profile types. To create a new 
profile, select the appropriate radio-button and press Add New. A new, unnamed profile will 
appear. Adjust the factor values as appropriate for the study, and press Apply to save the new 
profile. 

Existing profiles can be modified by selecting them, changing their values, and pressing Apply. 
The pre-existing DEFAULT profile can also be adjusted and is used when no other profile is 
specified, or when a specified profile is deleted. 

The Delete button will permanently delete the profile from the study. Profiles used in the study 
should not be deleted. The DEFAULT profile may not be deleted. The Delete button deactivates if 
DEFAULT is selected. 

In every operational profile, at least one value must remain set to 1 to represent the peak. All 
entered values must lie between 0 and 1, inclusive. 

The Duplicate button will create an exact copy of the selected profile. This allows for rapidly 
generating a series of similar profiles. If multiple profiles are selected simultaneously, any changes 
being made will be applied to all selected. 

Methodology 

Operational profiles are based on the concept of peak activity. A peak quarter hour, day or month is 
defined as the quarter hour, day, or month at which the most or maximum activity occurs. There 
can be one or more such peaks among the 96 quarter hours in a day, among the seven days in a 
week, and among the twelve months in a year. Peak activity (regardless of how high or low it is in 
absolute terms) is always represented by a 1 (signifying maximum activity) and anything other than 
a peak is represented as a fraction of that activity as a value between 0 and 1, inclusive. 

Dispersion Calculation 

For each quarter hour, the source activity or strength is adjusted by multiplying by the three 
corresponding factors for a particular quarter hour of the year. Dispersion is then calculated based 
on this modified source activity or strength. 

Si = (S) (QFi) (DFi) (MFi) 

where  

Si is the source strength at quarter hour i, 

S is the absolute source strength at a peak quarter hour, 

QFi is the factor for the quarter hour of the day (00:00-00:14 through 23:45-23:59) at 
which the quarter hour i occurs, 

DFi is the factor for the day of the week (Monday through Sunday) on which the quarter 
hour i falls and 
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MFi is the factor for the month of the year (January through December) in which the 
quarter hour i falls. 

Example 

Consider a source emitting 100 kg/hr at peak quarter hour. Quarter hour number 181 corresponds 
to the 85th quarter hour on January 2nd (a Friday in 2004). Suppose that the factor in the selected 
quarter-hourly profile for the 85th quarter hour is 0.7, the factor in the selected daily profile for 
Friday is 0.9, and factor in the selected monthly profile for January is 0.6. Then the source strength 
at quarter hour number 181 is given by  

S181 = (100 kg/hr) (0.7) (0.9) (0.6) = 37.8 kg/hr. 

Note that EDMS uses the correct day of the week according to the calendar for the study year. If 
the study year is 2004, then the 181st quarter hour falls on a Friday. If the study year is 1990, then 
the 181st quarter hour falls on a Tuesday, etc. 

Peak Quarter Hour Activity & Annual Activity 

For each source, the user is required to specify either a peak quarter hour activity or an annual 
activity and the operational profile in each of the three categories (quarter-hourly, daily, monthly). 

If a peak quarter hour activity is specified, then the annual activity is calculated based on the 
following formula: 

Annual Activity = (Peak Quarter Hour Activity) (35,040*) (quarter-hour factor avg) (day factor 
avg) (month factor avg). 

Note: Use 35,136 instead of 35,040 if the study year is a leap year. 

If annual activity is specified then the peak quarter hour activity is modified based on the following 
formula: 

Peak Quarter Hour Activity = (Annual Activity) / (35,040*) / (quarter-hour factor avg) / (day factor 
avg) / (month factor avg). 

Note: Use 35,136 instead of 35,040 if the study year is a leap year. 

The factor averages are the mean values of all of the factor values in the selected profile. The 
above approach ensures that the peak activity and the annual activity are always reflective of each 
other based on the specified operational profiles.  

Quarter-Hourly Operational Profiles 

The Quarter-Hourly Operational Profiles radio-button allows the user to specify the fractions of the 
peak quarter-hour operations that take place for each of the 96 quarter hours in a given day. This 
fraction is expressed as a real number between 0 and 1, inclusive, such that 0 is equal to 0% and 1 
is equal to 100%. 

Daily Operational Profiles 

The Daily Operational Profiles radio-button allows the user to specify the fraction of the peak hour 
operations that take place in each of the 7 days of a given week. This fraction is expressed as a real 
number between 0 and 1, inclusive, such that 0 is equal to 0% and 1 is equal to 100%. 

Monthly Operational Profiles 

The Monthly Operational Profiles radio-button allows the user to specify the fraction of the peak 
hour operations that take place in each of the 12 months of a given year. This fraction is expressed 
as a real number between 0 and 1, inclusive, such that 0 is equal to 0% and 1 is equal to 100%. 
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6.7.2 User-Created Aircraft 
The User-Created Aircraft window (Figure 6-63) allows the user to create custom aircraft types 
(known as "user-created aircraft") to supplement the conventional types supplied in the system data 
tables of the EDMS database. In creating a user-created aircraft, the user will need to specify 
certain characteristics of the aircraft type for use in emissions and dispersion analyses. These 
characteristics include the Number of Engines, Category, Flight Profile, Times In Mode and 
Engine Emission Indices and Fuel Flow rates. 

This window makes it easy to create an aircraft based on airframes and engines contained in the 
EDMS system database. For example, to model an aircraft with only 2 engines that usually has 3 
engines, one has only to specify an EDMS aircraft and engine and set the number of engines to 2.  

Figure 6-63: User-Created Aircraft 

 
 

Adding User-Created Aircraft information 

To add a new aircraft to the User-Created Aircraft list for use in the study, press the Add New 
button. A new aircraft will appear in the User-Created Aircraft list, already selected and ready for 
the default name to be edited. To remove an aircraft from the list press the Delete button. If an 
aircraft is deleted, it cannot be restored. Care must be taken that the deleted aircraft will not be 
needed to run EDMS studies in the future. Press the Duplicate button to duplicate selected 
aircraft. To rename an existing aircraft that is in the list, either double-click on it, or press the 
Rename button. Enter the desired number of engines in the Number of Engines field. 

Jet Engine Parameters 
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The user must enter values for the Bypass Ratio, the Rated Thrust per Engine and check the Mixed 
Turbofan checkbox if the jet engine is of that type. These values are applied only for jet engines, 
and are used to calculate the main engine startup emissions and the aircraft PM emissions using 
FOA 3 / 3A methodology. Checking Use System Emission Indices and Fuel Flow Rates 
automatically updates the Jet Engine Parameter values. 

Engine Emissions Data Source 

The user may specify emission indices (in grams per kilogram or pound per thousand pounds) and 
fuel flow rates (in kilograms per second) for one typical engine of the selected aircraft in the 
Aircraft and Engine pull-down menus, respectively. Checking Use System Emission Indices and 
Fuel Flow Rates automatically updates the display table at the bottom of the screen.  

The user may edit any of the values in the display table by double clicking the value. If a change is 
made the Use System Emission Indices and Fuel Flow Rates check-box will get unchecked. 

Flight Profile 

An appropriate flight profile must be selected for dispersion analysis. In the Flight Profile box, 
select a system aircraft-engine combination from the two drop down lists. The selected user-created 
aircraft will follow the same flight profile as the selected aircraft-engine combination, which also 
determines the times in mode in a dispersion analysis. 

Category 

Select an appropriate category for the new aircraft using the 4 drop down subcategory lists in the 
Category box. In the data tables, the category is abbreviated with a 4-character string (e.g., 
"HCJP"). Aircraft subcategories and their abbreviations are explained in the table below. Size is 
defined by Maximum Takeoff Weight (MTOW). 

Note: Aircraft categories were assigned based on the latest revision to aircraft weight class 
definitions. Weight classes are based on definitions in Appendix A of FAA’s Air Traffic Control, 
FAA-7110.65N. Aircraft category assignments were verified using two references: The 
International Directory of Civil Aircraft (Frawley, Gerard and Jim Thorn. Weston Creek: 
Aerospace Publications Pty Ltd., 2001) and The International Directory of Military Aircraft 
(Frawley, Gerard and Jim Thorn. Weston Creek: Aerospace Publications Pty Ltd., 2000). 
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Aircraft Categories. 

Subcategories  Options  Abbreviation 

Size  

Heavy (MTOW over 255,000 lbs) H 

Large (MTOW 41,001 to 255,000 lbs) L 

Small (MTOW 41,000 lbs or less) S 

Designation  

Civil C 

Military M 

General Aviation G 

Engine Type 

Jet J 

Turboprop/Turboshaft T 

Piston P 

Usage 

Passenger or VIP Transport P 

Cargo or General Transport C 

Business  B 

Helicopter  H 

Combat or Attack  A 

Other O 

European 

Category 

Light Helicopter H1 

Heavy Helicopter H2 

Business Jet JB 

Large Jet JL 

Medium Jet JM 

Regional Jet JR 

Small Jet JS 

Propeller PP 

Supersonic SS 

Turboprop TP 
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6.7.3 User-Created GSE 
The User-Created GSE window (Figure 6-64) allows the use to define ground support equipment 
(GSE) that do not exist in the EDMS system database. In addition to specifying emission factors, 
the user should enter a default operating time per departure, arrival, annual usage, power and load 
factor to assist in the adding of new GSE to a study. 

Figure 6-64: User-Created GSE 

  
 

Adding User-Created GSE information 
To add a new GSE to the User-Created GSE list for use in the study, press the Add New button. A 
new GSE will appear in the User-Created GSE list, already selected and ready for the default name 
to be edited. To remove a GSE from the list press the Delete button. Before deleting a GSE, care 
must be taken that the deleted GSE will not be needed to run EDMS studies in the future, since 
once the GSE is deleted, it cannot be restored.. Press the Duplicate button to duplicate selected 
GSE. To rename an existing GSE that is in the list, either double-click on it, or press the Rename 
button. Enter the desired number of engines in the Number of Engines field. 

Default Values 

Please enter appropriate values in the edit boxes for Op Time Arrival, Op Time Departure, Annual 
Operating Time, Power Rating and Load Factor. These default values are the initial values applied 
to the GSE whenever it is added to a study. After a GSE is added to a study, its default values can 
always be overridden. 

Emission Factors 

The user can specify emission factors (in grams per horsepower-hour) for one or more of the fuels 
in the Emission Factors box, at the bottom of the screen. Only emission factors for CO, Total HC, 
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NOx, SOx and PM-10 need to be specified. Emission values for NMHC, TOG and VOC are 
derived from Total HC, and PM-2.5 is derived from PM-10. However, these values can be obtained 
from a system GSE. In the Emission Factor Data Source box, select System Tables and the values 
in the Emission Factors box will automatically update to reflect the chosen data source. Choose the 
System GSE Type and Manufacture Year whose emissions data is desired from the drop down lists. 

6.7.4 User-Created APU 
The User-Created APU (Figure 6-65) window allows the user to define an auxiliary power unit 
(APU) that does not exist in the EDMS database. The user must provide the model with a default 
operating time, and CO, NOx, PM-10, Total HC, and SOx emission factors.  

Figure 6-65: User-Created APU 

 

 
Adding User-Created APU information 

To add a new APU to the User-Created APU list for use in the study, press the Add New button. A 
new APU will appear in the User-Created APU list, already selected and ready for the default 
name to be edited. To remove an APU from the list press the Delete button. If an APU is deleted, it 
cannot be restored. Care must be taken that the deleted APU will not be needed to run EDMS 
studies in the future. Press the Duplicate button to duplicate selected APU. To rename an existing 
APU that is in the list, either double-click on it, or press the Rename button. Enter the desired 
number of engines in the Number of Engines field. 

Default Operating Times 

Enter appropriate operating time values in the edit boxes for On Arrival and On Departure. These 
default values are the initial operating times applied to the APU whenever it is added to a study. 
After an APU is added to a study, these default values can always be overridden. 

Emission Factors 

The user can specify emission factors (in kilograms per hour) in the Emission Factors box, at the 
bottom of the screen. Emission factors for CO, Total HC, NOx, SOx and PM-10/2.5 need to be 
specified. Emission values for NMHC, TOG and VOC are derived from Total HC, and PM-2.5 and 
PM-10 are equal. However, these values can be obtained from a system APU. In the Emission 
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Factor Data Source box, select System Tables and the values in the Emission Factors box will 
automatically update to reflect the chosen data source. Choose a system APU whose emissions data 
is desired from the drop down list. 

6.8 The Window Menu 
The Window Menu is a standard Microsoft Windows menu item. It contains the following options: 

• Cascade 

• Tile 

• Toolbar 

• Status Bar 

• [Open Windows List] 

The Cascade command resizes and layers an open group of windows so that each title bar is 
visible. The Tile command resizes and arranges an open group of windows side by side. The user 
has the option to display or hide the Toolbar and the Status Bar, can choose what size the icons will 
appear, and is able to Arrange or Line up the various icons. Finally, if there is more than one 
window open, they will appear at the bottom of this menu, giving the user the opportunity to easily 
switch among the open windows. 

6.9 The Help Menu 
The Help menu provides access to the EDMS online help. The Help menu contains the following 
options: 

• Online Help 

• About EDMS 

Selecting Online Help calls up the EDMS online help. The About EDMS option displays the 
version of EDMS that is being used, the release date, and technical support contact information. 


